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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Uvod T

Trajanje
Na ovome tecaju polaznik se upoznaje s osnovnim mogucnostima poglavlja:
programa za obradu vektorske grafike Inkscape i programom za obradu
rasterske grafike GIMP, koje ¢e mu omoguciti da izraduje jedinstvena 10 min
grafi¢ka rieSenja. Oba programa su otvorenog kbda i besplatni za
koristenje.

Tecaj je namijenjen pocetnicima ili onima koji su se malo sluZili
programima za obradu vektorske i rasterske grafike, odnosno onima koji
zele dodatno utvrditi svoje znanje.

Polaznik ¢e na te€aju nauciti:

izradivati crteze i obradivati postojece crteze

rabiti boje i gradijente u crtezima

- precrtavati crteze

- dodavati tekst slikama i uredivati ga

- retuSirati slike

- koristiti se filtrima za poboljSanje slika

- izvesti slike u vektorski ili rasterski format.

Tecaj je namijenjen edukaciji svih zainteresiranih polaznika u podrucju
rasterske i vektorske grafike tj. izradi i koristenju grafickih elemenata u
besplathom programu za stvaranje i obradu vektorske grafike Inkscape i
besplathnom programu za stvaranje i obradu rasterske grafike, GIMP.

Nakon tec€aja polaznici ¢e steCi osnovnu razinu znanja u grafickim
programima Inkscape i GIMP, te ¢e moci stvarati jedinstvena graficka
rieSenja. Naucit ¢e izradivati crteZe ili obradivati postoje¢e pomocu
osnovnih grafi¢kih objekata ili prostoru¢nim crtanjem, koristenjem
Bézierovih krivulja. Savladat ¢e stavljanje boje na crteZe u bilo kojem
obliku (heksadecimalnom, RGB, HSL, CMYK ili slobodnim odabirom),
stvaranje gradijenata, precrtavanje slika, dodavanje i uredivanje teksta,
izvoz slika u vektorski ili rasterski format. Naucit ¢e koristiti osnovne
alate za obradu slika, retuSiranje slika, izmijeniti rezoluciju slike, koristiti
se raznim filtrima za pobolj$anje slika, umetnuti i prilagoditi tekst,
spremiti sliku ovisno o kasnijoj upotrebi (tisak ili web) i drugo.

Za oznacavanje vaznijih pojmova, naziva naredbi i elemenata sucelja te
naziva drugih elemenata koji se nalaze na ekranu, koriste se
podebljana slova. Pravo ime alata u prirucniku je navedeno u zagradi
jer se do toga imena dolazi dvostrukim klikom lijeve tipke miSa na ikonu
alata u Toolboxu tako da nije odmah vidljivo, a opis alata koji se
pojavljuje prelaskom misa preko ikone alata u Toolboxu je podebljan.
Prije ili poslije opisa i naziva alata nalazi se i prikaz ikone toga alata u
Toolboxu kao $to je navedeno u sljedeéem primjeru: Zoom in or out

(Zoom) Q\ .

Put do naredbe pisan je kurzivom, a sama naredba podebljano,
primjerice Tools - Selection Tools > Rectangle Select.
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1. Upoznavanje radnoga prostora e

programa Inkscape Trajanje
poglavlja

Po zavrSetku ovoga poglavija moci cete:
: e : 45 min
o instalirati i pokrenuti program Inkscape
e prepoznati dijelove sucelja programa
e podesiti parametre pri stvaranju novoga dokumenta

e otvoriti postojecu datoteku te pregledati i objasniti njezina
svojstva

e zumirati, koristiti ravnalo, mrezu i pomicne linije

e jzvestii spremiti gotov uradak.

1.1. Pokretanje i upoznavanje radnoga prostora
Inkscapea

1.1.1. Instalacija Inkscapea i sustavi na kojima je dostupan

Instalacijsku datoteku potrebno je preuzeti sa stranice
https://inkscape.org/en/download. Odabere se poveznica, ovisno o vrsti
sustava, te se nakon toga preuzme instalacijska datoteka.

Na dolje prikazanoj slici prikazane su poveznice preko kojih je moguce
preuzeti instalacijsku datoteku za operacijski sustav Windows, 32 ili 64
bitne verzije sustava. Najlaksi nacin je preuzimanje datoteke installer
(msi) oznacene crvenim okvirom na dolje prikazanoj slici.

Windows 10S App Store 64-bit 32-bit
ﬁ Windows Store ...' 64-bit architecture _5_;_3 32-bit architecture

Nakon preuzimanja potrebno je pokrenuti datoteku i slijediti korake koji
se uglavnom sastoje od toga da se odabire dugme Next te na kraju
instalacije dugme Finish.

Inkscape je dostupan za korisnike operacijskih sustava Windows, Mac i
GNU/Linux $to se moze i vidjeti pri preuzimanju instalacijske datoteke na
gore spomenutoj poveznici.

S obzirom na to da se radi o programu otvorenoga kéda, osim verzije
programa koje su namijenjene obi&nim korisnicima, moguce je preuzeti i
verziju programa za korisnike koji su voljni razvijati program i koji imaju
odgovarajuéu vrstu znanja.

@ srce ’
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1.1.2. Pokretanje Inkscapea

Za pokretanje programa u sustavu Windows, odabere se dugme Start >
Sve aplikacije - Inkscape. Prilikom prvoga pokretanja odabiremo
osnovne postavke te pritisnemo na dugme Save te nakon toga odabrati
New Document, a prije toga isljuciti opciju (maknuti kvacgicu) Show this
every time. Program ce se sporije otvarati jer podeSava razne opcije, ali
ve¢ drugi i svaki sljedeéi put pokretanje ¢e biti puno brze.

Za pokretanje Inkscapea na Linux sustavima, klikne se na Applications
- Graphics - Inkscape.

Za pokretanje na sustavima Mac, potrebno je odabrati mapu
Applications te potom Inkscape.

Kako bi uskladili jednako sucelje kod svih potrebno je promijeniti jezik i
temu. Postavke programa moguce je prilagoditi preko izbornika Edit >
Preferences (hrv. Uredi > Postavke) . Otvara se skoCni prozor

Preferences u kojemu korisnik moze promijeniti gotovo sve postavke.

Za promjenu jezika programa potrebno je odabrati izbornik Interface
(hrv. Sucelje) i kliknuti na padajuéi izbornik pokraj moguénosti Language
(hrv. Jezik) te odabrati engleski jezik. Kako bi se promijenio jezik treba
zatvoriti program i ponovno ga pokrenuti kao §to je i navedeno u samoj
opCiji.

Za promjenu teme unutar izbornika Interface potrebno je odabrati
podizbornik Theming te pod opcijom Change GTK theme odabrati temu
Mainwaita-Inkscape. Nakon toga potrebno je odabrati temu ikona, pod
opcijom Change icon theme odabire se hicolor i isklju€uju kvadice s
opcije Use symbolic icons.

1.1.3. Upoznavanje sa suceljem programa

Kada se otvori Inkscape prikazuje se jedan veliki prozor koji sadrzi
nekoliko manijih podrudja, razne ikone i padajuce izbornike.

Izgled samoga sucelja i polozaj dijaloSkih okvira moguce je promijeniti u
izborniku View, odabirom opcije Wide, u kojem je naredbena traka
smjestena na desnoj strani.

Dodatni dijaloski okviri mogu se sakriti i prikazati pomoc¢u naredbe View
- Show/Hide Dialogs.

Klju€ni dijelovi koje mozemo vidjeti na sucelju programa su naredbe,
snapping dugme, dugme s padajuéim izbornikom s kontrolom ,ljepljenja“
elemenata, naredbene trake, alati i drugo.

* @ srce
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Toolbox ili kutija s alatom — sadrZi alate za oznaCavanje, crtanje
ili izmjenu objekata. Klikom na ikonu alata odabire se zeljeni

alat, dok se dvostrukim klikom otvara dijaloski okvir toga alata.
Oblik pokaziva¢a miSa mijenja se ovisno o odabranome alatu.

Menu Bar ili glavni izbornik — sadrzi glavne padajuce
podizbornike preko kojih je moguée doci do svih funkcija u
programu.

Commands Bar — sadrzi pre€ace na mnoge naredbe koje se
nalaze u izbornicima, sluzi za brzi i lak8i rad u programu.

Tool Controls Bar — sadrzi dodatne opcije odabranoga alata.
Na primjer, ako se u Tool Boxu odabere alat Povecéalo, u ovom
izborniku pojavit ¢e se sve dodatne opcije toga alata kao Sto su:
Uvecaj, Umaniji, Omjer 1:1, Prilagodi uvecanje odabira veli¢ini
prozora, Prilagodi uvecanje stranice veli¢ini prozora te mnoge
druge korisne opcije toga alata.

Dialogs — dijaloski okviri koji se mogu ukljuiti ili isklju€iti, ovisno
o potrebi, a sluze za laksi rad s elementima u programu.
Jednostavan pregled i pristup dijaloSkim okvirima kao i nekim od
ostalih postavki moguc je odabirom gumba ~ koji se nalazi
desno od imena dijaloSkog okvira.

Snapping — gumbom Snapping " ukljuduje se i iskljuGuje

opcija ,lieplienja“ elemanata a gumbom ¢ otvara se dodatni

izbornik koji sadrzi ikone za kontroliranje ,ljepljenja“ elemenata
prilikom pozicioniranja i transformiranja.

Palette — sadrzi paletu boja. Boja se moze povudi iz palete i
direktno klikom primijeniti na neki oznaceni element. Ako se
prilikom povlagenja ili odabira boje drzi tipka [Shift], boja ¢e se
primijeniti na obrub elementa. Desno od palete boja nalaze alati
strelica pomodu kojih se mogu vidjeti i odabrati sve ponudene
boje.

@ srce ;
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8. Canvas — podrucje za crtanje, tj. platno na kojemu se crta u

ruba stranice $to znaci da nije ograni¢eno samo na obrubljeni
dio koji je vidljiv. Pritom rub predstavlja stranicu koja se ispisuje
ili izvozi, a sve $to je izvan njega se ne vidi na ispisu ili na slici.

1.2. Prilagodba programa

Postavke programa moguce je prilagoditi preko izbornika Edit >
Preferences. Otvara se skocni prozor Preferences u kojemu korisnik
moze promijeniti gotovo sve postavke.

@ Preferences - New document 1 X

¥ Preferences v
Q Interface

b Toals l Language: English (en) vl O I
Work-around color sliders not drawing

b Behavior

b Input/Qutput

Maximum documents in Open Recent: 36 -+ Clear list

System Zoom correction factor (in %)

Imparted Images Adjust the slider u
dispiay object:

ength of the ruler on your screen matches its real length. This information is used when zooming to 11, 1:2, etc, to

true sizes
Rendering

Spelicheck 100.0¢

100,00 — +

0 100

| | | | | | | | | | | | | | | | mm ¥
| Show zoom percentage corrected by factor
) Origin always on current page
! Origin at upper left with y-axis pointing down ()
 Lock canvas rotation by default
/| Show selection in ruler

User Interface
Handle size

& Use narrow number entry boxes
Status bar

! Show current style

4 Show layer selector

+ Show mouse coardinates

| Show canvas rotation
Mouse cursors

| Enable scaling

) Show drop shadow

Prvi izbornik Tools sadrzi dodatne opcije alata kojima mozemo pristupiti
i ako dvostrukim klikom pritisnemo na bilo koji alat u Toolboxu.

U izborniku Interface moguce je promijeniti sve postavke vezane za
prikaz u programu. Tako je moguce odabrati Zeljeni jezik na kojemu ¢e
biti program, veli¢inu ikona u raznim izbornicima, maksimalni broj
zapamcenih dokumenata u izborniku Open Recent te mnoge druge
mogucnosti.

Ako se Zeli saznati pre€ac do neke naredbe ili ako se Zeli postaviti neka
nova kombinacija tipki za neku odredenu naredbu, to je moguce izvesti
preko izbornika Keyboard. Promjena kombinacije tipki za neku naredbu
radi se tako da se dvostrukim klikom odabere Zeljena naredba u stupcu
Shortcut i nakon toga pritisne Zeljena kombinacija tipki za tu naredbu.
Popis naredbi sortiran je po abecedi.

Tijekom izrade crteza potrebno je mnogo puta pomicati element. Cesto
je taj korak kod pomicanja elementa velik pa ga je potrebno postaviti da
bude maniji, a to se radi u izborniku Behavior > Steps. U njemu je
moguce odabrati za koliko piksela ¢e se element pomaknuti kada

‘ @ srce



Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

pritisnemo strelicu za pomicanje na tipkovnici ili za koliko ¢e se piksela
povecati ili smanijiti neki element. Takoder se moze odabrati i za koliko
stupnjeva ¢e se rotirati neki element te neke druge korisne opcije.

1.3. lzrada novoga dokumenta i njegove opcije

Stvaranje novoga dokumenta obi¢no je prvi korak u izradi nekoga crteza
u Inkscapeu. U pravilu se uvijek zapocinje crtati na praznome
dokumentu iako se moze poceti crtati i na nekome ve¢ postojeéem
dokumentu. Prazna stranica koristi se kada se zeli crtati, bojati, izradivati
objekte od pocetka, a poletnicima je korisna za istrazivanje novih alata i
svih moguénosti koje nudi program.

1.3.1. lzrada novoga dokumenta

Prilikom otvaranja Inkscapea otvara se i stranica dokumenta koja je
spremljena u profilu korisnika i koja se moze u svakome trenutku
promijeniti. Osim standardne stranice, mogu se izabrati i mnoge druge
predefinirane stranice, ovisno o potrebama korisnika.

Ako se Zeli otvoriti nov prazan dokument standardnih postavki, odabere
se izbornik File > New ili tipkovni pre¢ac [Ctrl] + N, nakon Cega se
otvara novi dokument u drugome prozoru. Novi dokument moze se
izraditi i preko Command Bara tako da se odabere dugme za izradu
novoga dokumenta naziva Create new document from the default
template. Dugme za izradu novoga dokumenta prikazano je na donjoj
slici.

@ New document 5 - Inkscape

File Edit View Layer Object Path Text Filters Extensions Help
D‘lh & ® 16 T % @ @
New

| 0,00

Create new docurmnent from the default termnplate (Ctrl+ M)

1.3.2. Opcije dokumenta

Izmjena svojstava dokumenta kao Sto su veli€ina stranice (promjena
veli¢ine prema standardno ponudenim dimenzijama ili nekom
proizvoljnom veli¢inom), zadana jedinica, orijentacija, prikaz rubova ili
neka druga opcija vezana za stranicu mijenja se u izborniku File -
Document Properties.
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Display  Guides  Grids  Celor  Scripting  Metadata  License

Front page Display
Formaty A4 mrn Display units: mm ¥
Width: | 210,000 -+ -
Height: | 297,000 —[|*
Orientation: & D 7
Resize to content: Oal]
Scale: | 1,000000 - !
MM per user unit -

Page Border Desk
¥ Viewbox

Checkerboard
58 0,000 -+ " Border
Y: 0,000 -+ ' Always on top

' Show shadow
Width: | 210,000 -+ )

8 Show big page labels

Height: | 297,000 -+ Render

& Use antialiasing
Clip te page

U ovome izborniku moZe se odabrati veli¢ina stranice koja je na gore
prikazanome primjeru 210 x 297 mm (milimetra). Veli¢ina se moze
upisati ru¢no ili odabirom neke ponudene opcije koja se nudi klikom na
veliinu stranice u podru¢ju Format, oznacene crvenim okvirom na gore
prikazanoj slici. Ako se veli€ina upisuje ru¢no, potrebno je upisati
posebno Sirinu i posebno visinu ili se moze odabrati Zeljena veli€ina
pomocu dugmeta “-“ i “+“. Pod opcijom Orientation moguce je na brz
nacin promijeniti usmjerenje dokumenta u okomito (Portrait) ili

vodoravno (Landscape).
Postavke dokumenta i neke dodatne mogucnosti mogu se urediti i

pomocu alata Bl Pages Tool koji se nalazi u Toolboxu. Odabirom
navedenog alata unutar Tool Controls Bara moguce je kreirati dodatne,
nove stranice unutar postoje¢eg dokumenta, podesiti veliine
stranicama, unutarnje margine (Margins), napuste (Page Bleed),
razmjestaj stranica, brisati stranice i drugo.

Osim veli¢ine dokumenta i orijentacije, pritiskom na padajucéi izbornik
opcije Units odabire se i jedinica koja se zeli koristiti, a koja ovisi 0
namjeni crteza na kojemu se radi. Tako se mogu odabrati pikseli ako se
izraduje neka grafika za web, ili in€i, milimetri, centimetri, ako se radi
neka grafika za tisak, ili neke druge od ponudenih jedinica kao $to je i
oznaceno crvenim okvirom na dolje prikazanoj slici.
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9 Document Properties - New document 1 cm
[ Document Properties in
Display  Guides Grids Color  Scripting  Met] pt cense

Front page Display pc
Format: | Ad mm v Display units: mm
Width: | 210,000 -+ " | px
Height: 297,000 -
Orientation: (® D D
Resize to content: DI:‘M
Scale: | 1,000000 -+ f—
men pes user uni [
Page Border Desk

Kada se zavrsi s osnovnim podeSavanjima dokumenta, moguce je
odabrati i napredne opcije stranice. Primjerice, stranica se moze
automatski podesiti po sadrzaju koji je nacrtan u programu tako da se
klikne dugme Resize to content.

Q Document Properties - New document 1
[{! Document Properties *

Dsplay:  Guides  Grds  Color  Scripting  Metadata  License
Front page Display

Format: | A4 mm ¥ Display units: mm ¥
Width: | 210,000 - 4 "

Height: | 247,000 — 4"

Orientation: (e D D

Resize to content: @4

Scale: | 1,000000 - 4 —

S ]
Page Border Desk

Na kraju, pod opcijom Display = Border moguce je jo$ ukljugiti ili
iskljuciti prikaz ruba stranice

1.4. Uporaba zumiranja, ravnala, pomicéne linije i
mreze

U ovome poglavlju obrazlozit ¢e se €¢emu sluzi i kako se koristi zumiranje
u programu, kako se koristi te ¢e se navesti tipkovni precaci koji se
pritom mogu koristiti. Pojasnit ¢e se i uporaba ravnala i pomicne linije
koje se koriste za to€no poravnavanje elemenata po dokumentu, kao i
mreza koja takoder moze olak$ati poravnavanje elemenata u programu.
Prije nego se krene u opisivanje spomenutih naredaba, potrebno je znati
kako se moZe kretati, tj. micati po platnu. Jedan od nacina jest da se
pritisne i drzi tipka [Space] te se mi€e mi$ u Zeljenome smjeru na platnu.
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Ako se Zeli pomicati po platnu samo gore ili dolje okre¢e se na isti nacin

kotaci¢ mida. Ako se Zeli pomicati po platnu samo lijevo ili desno pritisne
se tipka [Shift] i okre¢e se kota€i¢ miSa prema gore za pomicanje u lijevu
stranu ili prema dolje za pomicanje u desnu stranu.

1.4.1. Zumiranje

Postoji nekoliko nacina zumiranja u programu Inkscape, a najcesce
koriSteni opisani su u nastavku.

Zumiranju se moze pristupiti preko izbornika View > Zoom gdje se
otvara podizbornik sa svim moguénostima zumiranja, kao $to je
oznaceno crvenim okvirom na donjoj slici.

Naredba Zoom in (skracenica na tipkovnici [+]) sluzi za priblizavanje,
dok naredba Zoom out (skraéenica na tipkovnici [-]) sluzi za
udaljavanje.

Zoom to 1:1 prikazuje crtez u realnoj veli€ini u pikselima, a do ovoga
nacina prikaza moze se dodi i pritiskom na tipku [1] na tipkovnici. Zoom
to 1:2 prikazuje crtez u dvostruko manjoj dimenziji od realne (skracenica
na tipkovnici [2]), a Zoom to 2:1 prikazuje crtez u dvostruko veéoj
dimenziji od realne.

Naredba Zoom Selection (skracenica na tipkovnici [3]) zumira
selektirane elemente preko cijeloga prozora, dok naredba Zoom
Drawing (skraéenica na tipkovnici [4]) zumira sve postojeée elemente u
programu tako da su svi vidljivi odjednom. Naredba Zoom Page
(skracenica na tipkovnici [5]) daje kompletan pregled cjelokupne
stranice, bez obzira na orijentaciju, a naredba Zoom Page Width
(skracenica na tipkovnici [6]) postavlja prikaz stranice na Sirinu stranice.

Naredba Center Page (skracenica na tipkovnici [Ctrl + 4]) pri trenutnoj
vrijednosti zumiranja centrira prikaz dokumenta na sredinu stranice.

Naredbe Zoom Previous i Zoom Next koriste se kao povijest zumiranja
pa se pomocu njih mozZe vraéati na prethodna zumiranja i odabrati
sljedeca.

View Layer Object Path Text Filters Extensions Help
Zoomin +
Orientation 14 Zoom out
Display Mode 1 4 Zoomto 1:1
Split Mode 4 Zoomto 1:2 2
D Gray Scale Alt+5 Zoomto 2:1
D Color Management Zoom Selection
D Page Grid Shift+# Zoom Drawing 4
[E Guides Shift+ Zoom Page
Show,/Hide ] Zoom Page Width
Show/Hide Dialogs F12 Center Page Ctrl+4
Cornmand Palette ? Zoom Previous
Swatches... Shift+Ctrl+W Zoom Next ~
—
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Osim preko izbornika View, koristan nacin zumiranja slike je
pozicioniranje miSa na platnu, nakon ¢ega se pritisne i drzi tipka [Ctrl] te
se kotacCicem misa priblizava ili udaljava slika. Ovaj nacin je najbrzi i
najefikasniji jer se gotovo istovremeno moze zumirati elemente i koristiti
neki drugi alat.

Zumiranje se moze izvesti i preko Toolboxa pomocu alata Zoom Tool

Q ili skraéenicom [F3] na tipkovnici. Nakon odabira alata Zoom Tool i
pritiskom na lijevu tipku misa priblizavaju se elementi na platnu, a
pritiskom na desnu tipku miSa moze se udaljavati od elemenata na
platnu. Na dolje prikazanoj slici prikazane su dodatne opcije toga alata u
Tool Controls Baru koje se prikazuju nakon odabira alata Zoom Tool.
Tu su navedene iste moguénosti kao i u izborniku View - Zoom, samo
Sto je preko ovih ikona moguée na brzi nacin pristupiti odredenoj
naredbi.

R Q@@
k@:s
&Y

Qaaall aa
NN Y

U donjemu desnom kutu programa, desno od oznake ,Z“ nalazi se broj
u postocima koji ozna¢ava na kojoj je razini zumiranja dokument. U taj
se okvir moze upisati zeljeni postotak zumiranja te potvrditi naredbu
tipkom [Enter].

1.4.2. Ravnala

Ravnala su smjeStena na gornjoj i na lijevoj strani dokumenta, tako da
imamo vodoravno i okomito ravnalo kao Sto je i prikazano crvenim
okvirom na donjoj slici.

@ "New document 1 - Inkscape
File Edit View Layer Object Path Text Filters Extensions Help

OE &= BOGE o mXd Q@
e aea @ae@aal aaa
k?- | |45 , | 50 , | 55 | |I

[

.

cor

o
iy
|

@ e
|
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Ravnala su korisna za odredivanje toCne lokacije misa, a samim time i
elemenata na slici. Kada se mi$ nalazi na stranici, dva crna trokuti¢a
pojavljuju se na vodoravnoj i okomitoj osi ravnala koja ozna¢avaju XiY
koordinate koje imaju polaziSne tocke na donjemu lijevom rubu stranice.
Prikazane su pokraj prikaza razine zumiranja u donjemu desnom kutu
programa.

Mjerne jedinice (,mm®, ,cm®, ,px“...) prikazane u ravnalu mogu se
promijeniti u izborniku File > Document Properties > Display -
Display units.

Ravnala se mogu prikazati ili sakriti na izborniku View - Show/Hide -
Rulers ili pomocu tipkovnoga precaca [Ctri]+[R].

1.4.3. Pomiéne linije

Pomic¢ne linije (engl. Guides) su linije koje mogu biti smjeStene u
dokument pod bilo kojim kutom, a korisne su za to¢no poravnavanje
elemenata na dokumentu.

Pomicne linije mogu biti brzo izradene tako da se klikne i drzi lijeva tipka
misa na okomito ili vodoravno ravnalo te se povuce do Zeljene pozicije u
dokumentu i tamo se ispusti. Ako se pomi¢na linija povuce iz blizine kuta
gdje se spajaju dva ravnala, okomito i vodoravno, dobije se nakoSena
pomiéna linija.

Na dolje prikazanoj slici nalaze se tri pomicne linije, okomita, vodoravna
i nakoSena. Po standardnim postavkama programa, pomi¢ne linije su
plave boje, a kada se prijede miSem iznad njih ili ih se oznaci postanu
crvene boje, kao $to je i oznageno crvenim okvirom na dolje prikazanoj
slici. Oznacenu pomicnu liniju moze se obrisati tako da se pritisne tipka
[Delete] na tipkovnici.

Ako se Zeli rotirati pomic¢na linija potrebno je do¢i miSem iznad Zeljene
pomiéne linije te pritisnuti i drzati tipku [Shift] na tipkovnici. Pokaziva¢
misa ¢e se promijeniti iz obi¢noga u rotirajuci oblik. Rotiranje se izvodi
tako da se klikne i drzi lijeva tipka miSa te se pomi¢na linija slobodno
okrece u Zeljenome smjeru. Pomiéna linija se moze rotirati i po 15
stupnjeva, a to se radi tako da se pritisne i drzi tipka [Ctrl] na tipkovnici
te se lijevom tipkom miSa okrece ograni¢eno, tj. po 15 stupnjeva u
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Zeljenu stranu. Tockica koja se nalazi na pomicnim linijama oznacava os
oko koje ¢e se okretati odabrana pomiéna linija.

Ako se dvostrukim klikom lijeve tipke misa klikne na neku pomicnu liniju,
otvara se dijaloski okvir Guideline, s dodatnim opcijama pomicnih linija,
koji je prikazan na donjoj slici. U Inkscapea-u moguce je u dodatnome
izborniku promijeniti i boju pomic€nih linija. Da bi se to ucinilo, potrebno je
kliknuti na dugme s bojom, nakon ¢ega se otvara jo$ jedan dijaloski okvir
Pick a Color. U spomenutom dijaloSkom okviru moze se odabrati zeljena
boja odabirom ponudenih boja ili direktnim upisivanjem
heksadecimalnog kéda boje ili podeSavanje vertikalnog kliza¢a
prethodnim odabirom dugmeta ,+“ pod opcijom Custom. Nakon odabira
boje na bilo koji nacin, pritisne se na dugme Select i nakon toga na
dugme OK.

Osim boje, u dijaloSkome izborniku Guideline moguce je postaviti i
oznaku tj. ime na pomic¢nu liniju. Potrebno je samo upisati u polje Label
ime koje se zeli zadati za tu pomi¢nu liniju. Na dolje prikazanoj slici
stavljeno je ime ,Gornja margina®“.

4 Guideline X

Guideline ID: guided

Current: horizental, at 16.19 px

Label: Gornja margina |

X 18359800 — 4+ px ¥
s 917,99000 — +
Angle: 0,00000 — 4| © -
Relative change
Locked
oK Duplicate Delete Cancel

Mogucée je i pomicati pomi¢nu liniju na to¢no odredeni dio dokumenta po
Xili Y osi, tako da se upiSe konkretna vrijednost u pikselima u polje X: ili
Y:, ovisno o orijentaciji pomicne linije. Linija se moze postaviti i na to¢no
odredeni kut kojeg se upisuje ili odabire pomocu okretnoga dugmeta u
polju Angle.

Ako se oznacli moguénost Relative change, X i Y osi postavljaju se na
vrijednost 0 te se pozicioniranje pomi¢ne linije, tj. daljnji upis vrijednosti,
racuna od trenutne pozicije. Na primjer ako se odabere vodoravna
pomic¢na linija, uklju€i opcija Relative change i upiSe 100 px u polje Y,
pomic¢na linija ¢e se pomaknuti za 100 px od trenutaéne pozicije, za
razliku od situacije u kojoj bi bila uklju¢ena mogucnost Relative change
— tada bi se pomicna linija pomaknula na 100 px dokumenta.

Na kraju se moze birati izmedu Cetiri dugmeta, OK za potvrdu,
Duplicate za izradu kopije originalne pomic¢ne linije, Delete za brisanje
pomicne linije ili Cancel za odustajanje.
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1.4.4. Mreza

Umijesto da se koristi mnogo pomicnih linija, moze se ukljugiti korisna
opcija Grids (mreza). UkljuCuje se preko izbornika View - Page Grid ili
preko tipkovnoga precaca [Shift] + [3].

Postoje dvije vrste mreza, pravokutna (rectangular) i aksonometrijska
(axonometric). Za odabir zeljene mreze potrebno je otvoriti dijaloSki okvir
File > Document Properties > Grids koji je prikazan na donjoj slici.
NajCesSce koriStena mreza ima pravokutni oblik te je stvorena od
okomitih i vodoravnih linija. Aksonometrijska mreza omogucuje
korisnicima definirati mrezu pod bilo kojim kutom Sto moze biti korisno
za tehnicka ili arhitektonska crtanja.

4 Document Properties - New document 1 e

[R Document Properties v

Display  Guides Grids  Color  Scripting  Metadata  License

Creation

Rectangular Grid hd MNew
Defined grids
BE grid9
Rectangular Grid
¥ Enabled Grid units: px ¥
v Visible
¥/ Snap to visible grid lines only Origin X: 0,00000 -+
Show dots instead of lines Origin ¥: 0,00000 — 4+
Align to page:
? ped Spacing X: 1,00000 -+
L
& o & Spacing ¥: 1,00000 -+
& o 4 Minaer grid line color: .
Major grid line color: .
Major grid line every: | 5 -+

Remove

Na samome vrhu, pod opcijom Creation, moguée je u padaju¢emu
izborniku odabrati vrstu mreze te ju potvrditi klikom na dugme New.
Moguce je stvoriti viSe mreza koje ¢e biti istovremeno vidljive, a od kojih
¢e svaka biti u zasebnoj kartici i kao takvu moguce ju je u€initi vidljivom
ili nevidljivom, uklju€ivanjem ili iskljuivanjem opcije Visible. Takoder je
moguce i onemoguciti neku od mreza odabirom opcije Enabled.

Uklju€ivanjem opcije Show dots instead of lines prikazuju se tockice
umijesto linija $to se moze i zakljuciti iz imena naredbe.

Umijesto piksela moguce je odabrati i neku drugu jedinicu ovisno o
potrebi, odabirom na opciju Grid units. Origin X i Origin Y sluze za
poravnhavanje mreze na neku pocCetnu to¢ku, dok se poravnanje mreze
po odredenom mjestu na stranici mozZe postaviti odabirom zelene tocke
pod opcijom Align to page:. Opcija Spacing X i Spacing Y sluzi za
postavljanje razmaka izmedu linija. Boja linije mreze moze se odabrati

“ @ srce



Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

pod opcijom Minor grid line color i Major grid line color kao i opcija
nakon koliko linija ¢e se pojaviti malo deblja linija, Major grid line every.

Na kraju je moguce obrisati kompletnu karticu odabrane mreze pritiskom
dugmeta Remove.

1.5. Otvaranje i spremanje slika

Ako se zeli spremiti crtez, tj. dokument u izvorni format programa
Inkscape, otvoriti dokument u izvornome formatu, uvesti ili izvesti slika u
nekom drugom formatu, potrebno se pridrzavati nekih pravila koja su
odredena u programu.

1.5.1. Spremanje crteza ili dokumenta

Postoji nekoliko metoda pomocu kojih se moze spremiti dokument, a do
svih dolazimo preko izbornika File.

Naredba Save sprema postojeci dokument uzimajudéi isto ime datoteke.
Ako je dokument novi, tj. joS do sada nije nikad bio spremljen, otvorit Ce
se dijaloski okvir u kojemu ¢&e biti potrebno upisati ime dokumenta i
lokaciju na koju se Zeli spremiti. Do ove naredbe moguce je doéi preko
izbornika File > Save, tipkovnim pre¢acem [Ctrl] + [S] ili pritiskom na
dugme, tj. ikonicu Save document u Commands Baru.

Naredba Save as sprema novu kopiju dokumenta pod drugim imenom,
a taj novi spremljeni dokument automatski postaje radni dokument, tako
da Ce svaka buduca promjena ili spremanje biti primijenjeni na doticni
dokument. Ova je opcija korisna za spremanje dokumenta po verzijama,
a do naredbe se dolazi preko izbornika File - Save as ili kombinacijom
tipki [Ctrl] + [Shift] + [S] na tipkovnici.

Naredba Save a Copy sprema identi¢nu kopiju trenutnoga dokumenta,
ali pod drugim imenom na lokaciji koja se odabere. Ovako spremljena
kopija odvojena je od trenuthoga dokumenta na kojemu se radi, $to
znadi da se nastavlja raditi na starome dokumentu. Ovu opciju je takoder
dobro koristiti ako se Zele spremati meduverzije nekoga dokumenta. Do
naredbe se dolazi preko izbornika File > Save a Copy ili tipkovnim
preCacem [Ctrl] + [Shift] + [Alt] + [S].

Ako se radi na novome dokumentu, odabirom bilo koje od gore
navedenih naredaba, otvara se dijaloski okvir Select file to save to,
prikazan na donjoj slici.
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@ Select file to save to *

Savein:‘ Ogledne slike v| @ x M-

g

Quick access

Desktop

Primjer.svg

"
Libraries

L

This PC

w

Network

File name: |drawing| e | | Save I

Save as type: Inkscape SVG ("sva) ~ Cancel

Title:: | |

U tome dijaloSkom okviru potrebno je upisati ime datoteke i odabrati
format u koji se zeli spremiti crtez. Nakon odabira pritisne se dugme
Save (Spremi).

1.5.2. Formati

SVG je kratica engleskoga naziva Scalable Vector Graphics. SVG je
zamisljen kao otvoreni standard, a baza mu je XML (eXtensible Markup
Language) koji jest takoder otvoreni standard. Najvaznija karakteristika
SVG formata je njegova skalabilnost, $to znaci da je moguce proizvoljno
smanjivati ili povecCavati dokument bez gubitka kvalitete. XML osnova
donosi i nekoliko znacajnih prednosti SVG-u kao $to su moguénost
pretraZzivanja, komprimiranja, animacije i relativho jednostavnoga
uredivanja.

File name: | Primjer_1 - | I Save
Save as type: Inkscape SVG (".sva) w Cancel
Title: Plain SVG (*svg)

Compressed Inkscape SVG (".svgz)

Compressed plain SVG (" .svgz)

Portable Document Format (" pdf)

Optimized SVG (" svg)

Compressed Inkscape SVG with media (" zip)
Layers as Separate SVG (" tar)

Desktop Cutting Plotter (AutoCAD DXF R12) (" .dxf)
Desktop Cutting Plotter (AutoCAD DXF R14) (" .dxf)
Encapsulated PostScript (" eps)

Enhanced Metafile (*.emf)

U nastavku ¢e se opisati najceSce koristeni formati koji su prikazani na
gornjoj slici, na padaju¢emu izborniku koji sluzi za odabir formata u
kojemu se zeli spremiti dokument.

Inkscape SVG je izvorni oblik datoteke koji se koristi u programu
Inkscape. Sadrzi neke dodatne opcije za razliku od obi¢noga SVG
formata. Preporuéa se koristiti ovaj format kada se izraduju crtezi u
Inkscape programu.

Plain SVG je standardna SVG-datoteka, ali bez nekih specificnih
obiljeZja koje ima Inkscape SVG. Plain SVG se koristi ako se Zeli postici
najbolja moguc¢a kompatibilnost s nekim drugim aplikacijama u kojima c¢e
se otvarati ta datoteka.
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SVGZ je komprimirana SVG-datoteka. Ova je vrsta datoteke daleko
manja, $to omogucuje znatno brZze preuzimanije ili prijenos putem
Interneta. Inkscape moze spremiti u svgz-dokument u oba formata,
Compressed Inkscape svg i Compressed Plain svg.

PDF format je izradila tvrtka Adobe kao format za razmjenu datoteka.
PDF dokumenti mogu sadrzavati bilo kakvu mjeSavinu teksta, fontova,
slika i vektora, a prikazom pomocu razli€itih programa, na razli€itim
operacijskim sustavima i hardverskim platformama zadrzati ¢e jednako
oblikovanje, prikaz i svojstva.

PNG je otvoreni graficki format namijenjen pohrani ili streamingu Zanimljivosti i napomene

nepokretnih slika bez gubitaka, podrzava prozirnost, a nastao je kao DPI je skracenica od dots

zamjena za GIF. PNG format je zamisljen kao grafi¢ki format za per inch (engl.), j. broj

razmjenu preko Interneta, tako da ne koristi neke druge sustave boja toCaka po incu.

kao §to je CMYK. PNG datoteke u pravilu uvijek imaju ekstenziju PNG ili Preporucena rezolucija slika

png. k.orlst.enlh u prlpreml za
tisak je 300 ppi za

fotografije i 600 ppi za

U PNG se moze izvesti i preko izbornika File > Export, nakon ¢ega se ) L ;
jednobojne ilustracije.

otvori dijaloski okvir Export, prikazan na donjoj slici.

= [ Eport v
Single File  Batch Export . . .
e — Zanimljivosti i napomene

Document Page Selection Custom

Image Size

Batch export je korisna
[ 20 —+ oo e -+ opcija koja odvaja
el 720 -+ selektirane elemente u
zasebne slike. Na primjer,
ako su oznacena Cetiri
elementa i ako je uklju¢ena
ova opcija, izvest ¢e se
Cetiri zasebne PNG slike.

09@
° @ Export Selected only

Background color

Ezivanja_tehnn\ngija‘pn@ Portable Network Graphic (*.png) v | %

Export

U njemu je moguce odabrati razne opcije o tome kako ée se izvesti slika.
Pritiskom na jedno od prva Cetiri dugmeta na kartici Single File,
Document, Page, Selection i Custom, odabire se $to se Zeli izvesti —
cijeli dokument (crtez), cijela stranica, odabrani dio (selekcija) ili nesto
proizvoljno. Takoder se moZe izvesti slika proizvoljne kvalitete pod
opcijom Image size, na nacin da se upiSe koliko Ce slika imati dpi-a
(engl. dots per inch). Mjesto spremanja odabire se pritiskom dugmeta s
ikonicom Mape (oznaceno crvenim pravokutnikom na slici povise) te
desno od tog dugmeta, iz padajuéeg izbornika odabere se Zeljeni format,
u nadem slu€aju png. Na kraju se odabere dugme Export za izradu
konacne slike u PNG-formatu.
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1.5.3. Otvaranje slika

Cesto je potrebno otvoriti veé¢ spremljeni SVG-dokument radi izmjene,
uzimanja nekih dijelova dokumenta, kopiranja u neki drugi dokument,
izvoza dokumenta u neki drugi format ili neCega drugog.

Postoji nekoliko nacina za otvaranje ve¢ postojecega dokumenta, a
svima se pristupa preko izbornika File. Naredba Open otvara datoteku u
potpuno novome prozoru gdje se potom moze izmjenjivati i raditi na njoj
neovisno o trenutno otvorenome dokumentu. Moguce je otvoriti datoteku
i preko tipkovnoga precaca [Ctrl] + [O] ili preko ikone Open File
Dialogue u Commands Baru.

Kada se odabere naredba Open na bilo koji od opisanih nacina, otvorit
Ce se dijaloski okvir Select file to open, prikazan na donjo;j slici. U
njemu se odabere mapa u kojoj je smjestena datoteka ili slika koja se
Zeli otvoriti, odabere se Zeljena datoteka i pritisne se dugme Open. BrZi
nacin bi bio da se Zeljenu datoteku odabere dvostrukim klikom, nakon
Cega se ona otvori u novome prozoru.

4@ Select file to open b
P

Look in: ‘ Ogledne slike V‘ @ : M d EI‘ E

*

Quick access :
-
[ | v

Desktop

drawing Hortenzija jellyfish Koala

jellyfish

118kB
" 1380px x 920px

Libraries
X -
This PC . 4 \‘ - -
Al g WA

Lﬂ* Krizantema Pingvini Primjer Primjer_1
MNetwork

File name: jellyfish ~ | I Open

Files of type Al Inkscape Files - Cancel

Osim otvaranja dokumenta pomocu naredbe Open, sliku ili dokument
moguce je uvesti i naredbom Import. Na ovaj nacin moguce je uvesti
neku sliku ili SVG-dokument u trenutno aktivni dokument, tj. u dokument
na kojemu se radi. Uvezene datoteke postaju elementi u veé
otvorenome dokumentu te se dalje s njima mozZe manipulirati.

Slika se moze uvesti preko izbornika File = Import, tipkovnim preacem
[Ctrl] + [1] ili klikom na ikonu Import na Commands Baru. Nakon odabira
naredbe otvara se dijalo3ki okvir Select file to import preko kojega se
slika ubacuje na jednak nacin kao i kod otvaranja slike preko izbornika
Select file to open.
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1.6. Vjezba: Upoznavanje radnoga prostora

1.

Izradite praznu stranicu dimenzije 272 x 385 mm (D3),
vodoravnoga usmijerenja.

Postavite prvu vodoravnu pomicnu liniju, zelene boje na
koordinate X = 0 px, Y = 480 px, kuta 0 stupnjeva naziva
"Gornja zelena".

Postavite drugu pomicnu liniju, crvene boje, relativho
odmaknutu od prve za -100 px po Y osi, kuta 0
stupnjeva.

Treéu pomicnu liniju postavite na koordinate X =0pxiY
= 380 px pod kutom od 4, 1 stupanj.

Stvorite kvadratnu mrezu, razmaka 2 cm po X osii 3 cm
po Y osi te ukljucite opciju da se prikazuju to¢ke umjesto
linija.

Zumirajte dokument na Sirinu stranice.

Spremite crtez u Inkscape SVG (*.svg) naziva
Podesene_linije.
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2. Osnovni grafi€ki objekti i njihove
opcije

Po zavrSetku ovoga poglavija moci cete:

izraditi osnovne graficke objekte

koristiti alate za prostorucno crtanje

grupirati i oznacavati objekte

izabrati odredenu boju i njome se koristiti.

Program Inkscape nudi mnogo alata za crtanje geometrijskih oblika
poput kvadrata, pravokutnika, elipsa, poligona, zvijezda i spirala. Osim
tih standardnih oblika moguce je crtati i prostoru¢ne putanje pomocu
alata kao $to je olovka, kist ili pomoc¢u Bezierovih krivulja.

2.1. Stvaranje osnovnih grafi¢kih objekata

Stil svakoga objekta ukljuCuje svojstva koja odreduju kako ce taj objekt
izgledati, tj. koje boje ispune (engl. fill) i kakve boje ili debljine ¢e biti
obrub (engl. stroke). Stilovi mogu uklju€ivati i neka specifi¢na svojstva
poput broja to€aka u zvijezdi, zaobljenost, veli€inu ili drugo.

Novi objekti crtaju se predefiniranim stilom, a kada se nacrtaju mogu se
mijenjati u dijaloSkome okviru Fill and Stroke (Object - Fill and
Stroke).

2.1.1. Pravokutnici i kvadrati

L]

Crtanje pravokutnika ili kvadrata omogucuje alat Rectangle Tool ,
koji se nalazi u Toolboxu, a moZe se odabrati i preko tipkovnice,
pritiskom na tipku [F4] ili [R].

Za crtanje pravokutnoga oblika potrebno je odabrati alat Rectangle

Tool L] , pomaknuti mi$ do Zeljenoga mjesta na platnu gdje se Zeli
izraditi na primjer pravokutnik te drzati lijevu tipku misa i povlaciti mis u
Zeljenome smjeru. Kada su veli€ina i oblik zadovoljavajuci, pusti se lijeva
tipka miSa te se dobije pravokutnik sli€an onome na dolje prikazanoj
slici.
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Na prethodnoj slici prikazano je:

1. Kvadrati¢ za podeSavanje veli€ine.
2. Krug za podeSavanje radijusa.

Uz drzanje tipke [Ctrl] na tipkovnici prilikom crtanja pomocu ovoga alata
moguce je izraditi kvadrat ili nacrtati objekt koji je u zlathome rezu, a
drzanje tipke [Shift] omogucéuje crtanje objekta oko poCetne tocke, sto
znaci da ¢e se pravokutni oblik crtati oko toCke na koju se prvo kliknulo u
programu.

Ako se zeli promijeniti radijus objekta, tj. napraviti zaobljene rubove,
potrebno je kliknuti i drzati lijevu tipku mi$a na krug (koji je oznacen
brojem 2 na prethodno;j slici) te se kretati u Zellenome smjeru. Drugi
nacin je takoder preko Controls Bara upisati broj¢anu vrijednost radijusa
u polje Rx ili Ry.

Ako se Zeli nacrtanome objektu promijeniti veli€¢ina, moguce je to izvesti
na dva nacina. Prvi je da se miSem dode do objekta (alat moramo imati
u ruci) te pritisne i drzi lijevom tipkom mi$a na kvadrati¢ (oznacen brojem
1 na prethodnoj slici), kvadrati¢ promijeni boju, nakon &ega se moguce
kretati u Zeljenome smjeru, odnosno povecavati ili smanjivati objekt.
Kada se zavrsi, samo se pusti lijeva tipka misa.

Drugi nacin je da se veli¢ina izmijeni u Controls Baru, oznacenim
crvenim okvirom na dolje prikazanoj slici. To se radi tako da se upiSu
Zeljene broj¢ane vrijednosti u polje W (engl. Width), Sto oznacava Sirinu
objekta, i polje H (engl. Height), $to oznaCava visinu objekta.

W 27 - ; — ' e
ChangeW: 270,000 + | H:| 140,000 +IF‘.><. 0,000 + | Ry:| 0,000 + x> T e ot ©

Kada se Zeli rotirati ili iskositi neki objekt, to se moZze izvesti na dva
nacina, preko alata Selector Tool ili izbornika Transform. Prvi nacin je
da se odabere alat Selector Tool s kojim se svaki objekt u programu
moze oko objekta pojaviti rotirajuce strelice (klikom dva puta na Zeljeni
element), kao $to je prikazano na donjoj slici.

2 @ srce



Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Na gornjoj slici prikazano je:

1. Rotirajuca strelica koja se nalazi u svakome kutu objekta,
a sluzi za rotiranje toga objekta.

2. Strelica koja sluzi za vodoravno iskrivljenje objekta, nalazi
se na dva mjesta, na gornjoj strani objekta i na donjoj
strani objekta i jednakoga je oblika.

3. Krizi¢ koji oznagava centar rotacije i oko njega ¢e se
objekt rotirati.

4. Strelica koja sluzi za okomito iskrivljenje objekta, takoder
se nalazi na lijevoj i desnoj strani objekta.

Za slobodno rotiranje objekta potrebno je doéi miSem na bilo koji kut
objekta na rotirajuce strelice, pritisnuti i drzati lijevu tipku miSa te objekt
okrenuti u Zeljenome smjeru. Za rotaciju objekta samo po 15 stupnjeva,
potrebno je ponoviti gore navedeni postupak uz drzanje tipke [Ctrl]. Ako
se drzi tipka [Shift], objekt ¢e se rotirati oko suprotnoga kuta.

Za promjenu osi rotacije potrebno je doci do krizica koji se po
standardnim postavkama nalazi uvijek u sredini objekta (oznacen s
brojem 3 na gornjoj slici) te pritisnuti i drzati lijevu tipku mi$a i pomaknuti
krizi¢ na Zeljenu poziciju. Kada je kriZi¢ na Zeljenoj poziciji potrebno je
pustiti lijevu tipku miSa. Nakon toga, objekt ¢e se rotirati oko novo
postavljene osi rotacije, tj. oko trenutno postavljenoga krizi¢a. Za
vracanje krizi¢a, tj. osi rotacije, natrag na centar objekta potrebno je
pritisnuti i drzati tipku [Shift] na tipkovnici i kliknuti lijevom tipkom miSa na
krizi¢, nakon €¢ega se kriZi¢ automatski vraca u sredinu objekta.

Za vodoravno iskrivljenje objekta, potrebno je doc¢i do bilo koje strelice
za vodoravno iskrivljenje, pritisnuti i drzati lijevu tipku miSa i micati mis u
lijevu ili desnu stranu. Kada je oblik zadovoljavajuci, pusti se lijeva tipka
misa. Za okomito iskrivljenje objekta potrebno je doci do bilo koje strelice
za okomito iskrivijenje, pritisnuti i drzati lijevu tipku miSa i micati miS gore
ili dolje. Kada je iskrivljenje zadovoljavajuce, pusti se lijeva tipka misa.

Drugi nacin je preko izbornika Object - Transform, prikazanoga na
donjoj slici, do kojega se moze doci i preko tipkovne kratice [Shift] +
[Ctrl] + [M].

@ Transform - New document 1

3 e v

Move Scale Rotate Skew  Matrix

& sngler 25000 — 40w

a4 L

Apply to each object separately

Apply (e

Za rotiranje objekta potrebno je prvo oznaciti objekt kojega se Zeli rotirati
te u izborniku Object > Transform - Rotate upisati pod opcijom Angle
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kut pod kojim se zeli rotirati objekt. 1z padajuéeg izbornika moguce je i
odabrati u kojim jedinicama se Zeli primijeniti okretanje, a u nastavku je
moguce odabrati i smjer vrtnje, u smjeru kazaljke na satu ili suprotno od
smjera kazaljke na satu. Nakon upisane vrijednosti, moguce je pritisnuti
na dugme Apply Cime se primjenjuju zadane postavke. Nakon toga,
moguce je resetirati postojece vrijednosti kao predefinirane odabirom
dugmeta Reset the values on the current tab to defaults koji se nalazi
desno od dugmeta Apply.

Za iskrivljenje objekta potrebno je odabrati karticu Skew u istome
izborniku Transform. Na toj kartici moguce je upisati Zeljenu vrijednost
iskrivljenja ovisno o orijentaciji, Horizontal (vodoravno) ili Vertical
(okomito). Kada se upiSe Zeljena vrijednost, odabere se dugme Apply
za primjenu unesSenih vrijednosti. Isto kao i kod rotacije, moguce je
resetirati postojece vrijednosti kao predefinirane odabirom dugmeta
Reset the values on the current tab to defaults.

Svi objekti se rotiraju na isti nacin tako da nije potrebno posebno
opisivati rotaciju za svaki pojedini objekt.

2.1.2. Elipse, krugovi i lukovi

Pomocu alata Elipse/Arc Tool O kojega se moze odabrati u
Toolboxu moguce je crtati elipse, krugove i lukove. Do njega se moze
doci i preko tipkovnoga precaca [F5] ili [E].

Za crtanje bilo kakvoga kruznog oblika ili lukova u njima, potrebno je

odabrati alat Elipse/Arc Tool O te doc¢i miSem na podrucje gdje se
zeli izraditi kruzni oblik, pritisnuti i drzati lijevu tipku misa te povlaciti u
Zelienome smjeru. Pojavljivat ¢e se kruzni oblik u kvadratnoj isprekidanoj
kutiji koja oznagava pocetnu i zavr$nu toCku povlaéenja. Kada je oblik
zadovoljavajuce dimenzije i oblika, pusti se lijeva tipka misa.

Drzanjem tipke [Ctrl] na tipkovnici prilikom crtanja ovim alatom moguce
je izraditi kruzni oblik jednakih proporcija, tj. da su mu visina i Sirina
jednake, a drzanjem tipke [Shift] omogucuje se crtanje objekta oko
poletne toCke Sto znadi da ¢e se kruzni oblik crtati oko to¢ke na koju se
prvo kliknulo na platnu.
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Na donjoj slici prikazani su krug i elipsa, a oznake oznacavaju:

1. Kvadrati¢ za podeSavanje veli€ine.
2. Krug za stvaranje luka.

3. Kvadratna isprekidana kutija koja ozna¢ava poCetnu i zavrSnu
to¢ku povlacenja.

Osim crtanja krugova i elipsa moguce je od ve¢ nacrtanih takvih
objekata izraditi i lukove. Za crtanje zatvorenoga luka, tj. ako se zeli da
graf izgled kruga izgleda kao ,pita“, potrebno je pritisnuti lijevom tipkom
miSa na krug za izradu luka (oznacen brojem 2 na gornjoj slici) i povlaciti
mi$ izvan toga objekta u Zeljenome smjeru. Kada je objekt
zadovoljavajucega oblika pusti se lijeva tipka miSa. Ako je potrebno
doraditi objekt, ponovi se opisani postupak. Na kraju se moZe dobiti
izgled poput prikazanoga na donjoj slici.

A ako se miSem povlaci unutar objekta prema gore opisanome
postupku, isti objekt koji je prikazan na gornjoj slici, izgledat ée kao na
dolje prikazanoj slici.

Pomocu tipke [Ctrl] moguce je pomicati radijus, tj. kut po 15 stupnjeva. U
Controls Baru moguce je odrediti kakav luk se zeli izraditi, tzv. zatvoreni
ili otvoreni ili se moze resetirati stanje na pocetno $to je i oznaceno
crvenim okvirom na dolje prikazanoj slici.

Change: Rx:| 26,296 — + | Ry 2629 — 4+ mmw Stat| 0000 — 4| End:| 224269 — + & ® @

e

Stroke Unsat
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2.1.3. Pravilni mnogokut i zvijezde

Pomocu alata Star/Polygon Tool & , Koji se nalazi u izborniku
Toolbox, moguce je izraditi pravilne mnogokute ili zvijezde. Alat se moze
odabrati i tipkovnim pre¢acem [Shift] + [F9] ili [*].

Za crtanje mnogokuta, nakon odabira naredbe Star/Polygon Tool ,
potrebno je odabrati na Controls Baru opciju Regular polygon,
oznaceno brojem 1 na donjoj slici.

Change: () }%? Corners: | 3 — 4+ Rounded: 0,000 — 4 Randomized: 0,000 — 4 [ x} e

Stoke Unset

Na gornjoj slici prikazane su opcije:

1. Regular polygon za crtanje mnogokuta.
2. Star instead of a regular polygon za crtanje zvijezda.

Nakon odabira, u istoj traci moguce je odabrati koliko kutova ¢e imati
mnogokut, pod opcijom Corners. Za crtanje mnogokuta potrebno je
pritisnuti lijevu tipku miSa na mjestu gdje se zeli stvoriti mnogokut te
povlaciti mi§ u Zeljenome smjeru. Nakon dobivanja zadovoljavaju¢ega
oblika, pusti se lijeva tipka misa.

Za crtanje zvijezde, ponovi se isti postupak kao $to je opisan za izradu
mnogokuta, samo se odabere opcija Star instead of a regular
polygon, ozna¢ena brojem 2 na gornjoj slici. Na svakome od tih
objekata moguce je naknadno mijenjati oblik, veli¢inu, boju, itd.

Na dolje prikazanoj slici moze se vidjeti kako je moguc¢e mnogokut
pretvoriti u zvijezdu i obrnuto, koriste¢i samo kvadrati¢ za promjenu
radijusa koji je opisan kod svih prethodnih elemenata, a jednaku funkciju
ima i kod ovih objekata.
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2.2. Prostoruéno crtanje i koriStenje Bézierovih
krivulja

Linije koje su izradene u programu Inkscape su zapravo zaobljeni
objekti. Linije mogu biti otvorene (znaci da imaju dva kraja) ili zatvorene
(nemaiju kraj). Mogu jo$ biti i kombinirane (sastavljene od odvojenih
otvorenih i zatvorenih linija). Kombinirane linije stvaraju se tako da se
oznaci vise odvojenih linija i odabere naredba Combine na izborniku
Path ili preko tipkovnoga pre€aca [Ctrl] + [K]. Linije se prije ovoga
kombiniranja moraju pretvoriti u putanje (Path > Object to Path). Ako
se kombinirana linija Zeli pretvoriti opet u zasebne linije, oznaci se
kombinirana linija i odabere naredba Break Apart iz izbornika Path. Na
donjoj slici prikazana je s lijeve strane otvorena linija, u sredini je prikaz
zatvorene linije i na krajnjoj desnoj strani je prikazana kombinirana linija.

TN /\/

2.2.1. Bézierove krivulje

Bézierove krivulje koriste se za crtanje nepravilnih oblika kao i za
manipulaciju nad crtezima jer mogu mijenjati svoj oblik po nekim
predodredenim matematickim principima. Bézierove krivulje definirane
su Cetirima to¢kama, dvije od njih su zavrSne to¢ke (oznacene brojem 1
na dolje prikazanoj slici) dok su preostale dvije kontrolne tocke
(oznacene brojem 2 na dolje prikazanoj slici). Kontrolne toCke korisne su
za naknadno prepravljanje krivulja kao i prepravljanje krivulja prilikom
njihove izrade. 9

Na gornjoj slici prikazana je krivulja s dvije kontrolne tocke:

1. Zavrsne tocke krivulje ili E&vorovi (Nodes).
2. Kontrolne tocCke krivulje.

Linije mogu biti izradene pomocu alata Pencil Tool — prostoru¢no

crtanje, E’ Pen Tool — crtanje Bézierovih krivulja i l—g Calligraphy
Tool — za pisanje kaligrafskom tehnikom.
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Putanje, tj. linije se mogu izraditi i pretvorbom nekog regularnoga oblika
poput kvadrata, pravokutnika, kruga, tekstnoga objekta u linije, itd.
Putanje su u pravilu obi¢ne Bézierove krivulje bez nekih dodatnih opcija
kao Sto ih imaju objekti ili neki slozeniji elementi.

Pomocu Bézierove krivulje (alat Pen Tool) mogu se puno izravnije
kontrolirati parametri neke linije. Za crtanje Bézierovih krivulja prvo je

potrebno odabrati alat Pen Tool i? , koji se moze odabrati preko
izbornika Toolbox ili preko tipkovne kratice odabirom [Shift] + [F6] ili
samo slova [B].

Kada je alat odabran, klikne se i drZi lijeva tipka mi$a na podrucju gdje
se zeli izraditi neka linija. To¢ka na koju se prvo kliknulo postaje
pocetnom tockom krivulje. Kako se pomice kursor tako se moze vidjeti
plava linija izmedu pocetne tocke i kursora mida — to je tangenta krivulje,
prikazana na donjoj slici.

Otpustanjem lijeve tipke misa uspostavlja se prva kontrolna tocka.
Kursor mida potrebno je pomicati na sljedeCu poziciju Bézierove krivulje,
na tzv. zavrdnu tocku. Prilikom pomicanja misa, pojavit e se crvena
linija koja oznacCava oblik krivulje, prikazane na donjoj slici.

a

Kada se dode do mjesta gdje se Zeli postaviti druga tocka, klikne se i
drzi lijeva tipka miSa ako se Zeli odmah i prepraviti krivulja, a ako je
krivulja zadovoljavaju¢ega oblika samo se klikne na Zeljeno mjesto na
kojemu Ce se stvoriti druga tocka krivulje. Kada se Zeli stvoriti krivulja
pritisne se tipka [Enter] ili desna tipka miSa. Na dolje prikazanoj slici
nalazi se krivulja stvorena s dvije kontrolne tocke.

Krivulja se moze i naknadno uredivati, mijenjati oblik, pomicati, stvarati

F-EI
dodatne kontrolne tocke pomoc¢u alata Node Tool , koji se nalazi u
Toolboxu.
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2.2.2. Prostoruéno crtanje

Pomocu alata Pencil Tool moguce je na najlaksi nacin crtati proizvoljne,

slobodne linije. Alat Pencil Tool 2@
skraéenice na tipkovnici [F6] ili [P] te se postavi lijeva tipka miSa na
Zeljeno podrucje. Kako se klikne i pomi¢e mi$ po platnu tako se i
iscrtava linija. Sve dok se drzi pritisnuta lijeva tipka miSa i mi§ se mice
po prostoru, alat ostavlja liniju, a za prestanak crtanja otpusti se lijeva

tipka

misa.

odabere se u Toolboxu ili pomocu

Za brisanje pogresne ili nedovrdene linije moze se pritisnuti kombinacija

tipki [Ctrl] + [Z] na tipkovnici ili se vratiti korak natrag preko izbornika Edit

- Undo.

Oblici koji su nacrtani ovim alatom sastavljeni su od mnogo Bézierovih
krivulja. Svaki od tih oblika moZe se i pojednostaviti, $to znaci da ¢e
imati manje ¢vorova i da Ce biti gladega oblika. Oblik se moze ugladiti

tako da ga se oznadci i nakon toga odabere naredba Simplify u izborniku

Path ili preko tipkovne kratice [Ctrl] + [L]. Na donjoj slici, s lijeva na
desno, prikazan je isti oblik,ali sve viSe pojednostavljen. Tako krajnje
lijevi oblik nije pojednostavljen, srednji je jedan put, a desni vide puta.

Kada je odabran ovaj alat, u izborniku Tools Controls, prikazanome dolje

na slici, nudi se jo$ nekoliko korisnih opcija. Prva se odnosi na nacin
crtanja krivulja, druga na koli¢inu zagladenosti linije, a tre¢a na vrstu

kista.
Mode:f‘!n Qv F & Smoothing: | 25,00 ‘— + | - Shape: | None 1 w | Scale: | 1,00 :t':ksﬁl
Na gornjoj slici prikazan je izbornik Tool Controls alata Pencil Tool:
1. Nacin crtanja krivulje — moguce je birati izmedu regularne Bézier
krivulje (odabrana na gornjoj slici) i Spiro putanje koja se ne
koristi Cesto jer je puno bolje koristiti alat Pen umjesto te opcije.
2. Zagladenje — moguce je odabrati prije crtanja neke linije
zagladenje u rasponu od 1 do 100, gdje je 1 minimalno, a 100
maksimalno zagladenje.
29
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3. Nekoliko opcija pomoc¢u kojih se moze primijeniti razli¢iti oblik na
linije. Potrebno je prvo odabrati neki od oblika te nakon toga
nacrtati oblik.

Ako se Zeli nacrtati samo to¢ka pomocu ovoga alata potrebno je
pritisnuti i drzati tipku [Ctrl] + lijeva tipka miSa. Za duplo ve¢u tocku
pritisne se [Ctrl] + [Shift] + lijeva tipka miSa, a za tocke nasumicne
veli¢ine pritisne se [Ctrl] + [Alt] + lijeva tipka miSa.

2.3. Ozna€avanje, poravnanje i grupiranje
elemenata

Kada se Zeli s nekim odredenim elementom nesto raditi potrebno ga je
prvo oznaditi, ali ako se na platnu nalazi velik broj elemenata, nije uvijek
lako odabrati to€no one elemente kojima se Zeli manipulirati. Stoga
postoje razne tehnike oznaCavanja elemenata. Kada su elementi jednom
oznaceni moze ih se zajednicki povecéavati, smanjivati, rotirati,
poravnavati ili ih se moze staviti u istu grupu da se ponas$aju kao jedan
element, $to moze uvelike olak3ati rad.

2.3.1. Oznacavanje elemenata
Za oznacCavanje elemenata miSem, potrebno je odabrati alat Selector

Tool k u izborniku Toolbox te lijevom tipkom miSa oznaciti zeljeni
element tako da se klikne na njega. Ako se Zeli oznaciti viSe elementa,
potrebno je pritisnuti tipku [Shift] na tipkovnici te pritisnuti lijevom tipkom
misa na svaki zeljeni element. Oni elementi koji su ve¢ oznaceni bit ¢e
pritom odznaceni, a elementi koji joS nisu oznaceni ¢e se oznaditi.

Ako se zeli oznaditi vise elemenata odjednom, to se izvodi tako da se
pritisne i drzi lijeva tipka miSa u praznome prostoru pokraj elementa te
se povlaci mi§ do svih Zeljenih elemenata koji ¢e se postupno
oznacCavati. Prilikom takvoga oznacavanja pojavit ¢e se pravokutan oblik
te ¢e svi elementi koji se nalaze unutar toga oblika biti oznaceni. Kada
su jednom elementi oznaceni, s njima se mozZe manipulirati kao da se
radi o jednome elementu.

Kada se pritisne i drZi tipka [Alt] i lijeva tipka miSa, moZze se vidjeti
crvena linija prilikom pomicanja miSa kojom se prelazi preko onih
elemenata koje se Zeli oznaciti, Sto je prikazano na donjo;j slici.

...
e @
..

Svi elementi koji su dotaknuti linijom se oznace te se njima moze dalje
manipulirati, kao $to je prikazano na donjoj slici.
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To je korisno kada se na platnu nalazi mnogo elemenata, a zele se
oznaciti samo neki odredeni. Pomocu tipke [Alt] moguce je joS i oznaditi
elemente ako su u ukupnome poretku zadnji na istome mjestu. To se
odnosi na situaciju u kojoj se viSe elemenata nalazi na istoj poziciji, a
vidljiv je samo onaj element koji je najviSe rangiran po Z poretku (viSe
informacija o Z poretku moze se naci u poglavlju 2.3.3. Poravnavanje
elemenata). Potrebno je oznadciti najviSe pozicionirani element, drzi se
tipka [Alt] te se samo klika lijevom tipkom misa po prvome elementu koji
se moze oznaciti, nakon toga se elementi oznacavaju po razinama (od
najviSe prema najnizoj).

Oznacditi elemente moguce je i preko tipkovnice tipkom [Tab], a ako se
zeli vratiti na prethodno oznaceni element potrebno je odabrati
kombinaciju tipki [Shift] + [Tab]. Sve elemente odjednom moguce je
oznadciti kombinacijom tipki [Ctrl] + [A], $to ¢e oznaCiti sve elemente
samo u trenutnome sloju (Sto su slojevi i €emu oni sluze objasnjeno je u
poglavlju 3.2. Uporaba slojeva), a ako se Zele oznaciti svi elementi u
svim slojevima potrebno je odabrati kombinaciju tipki [Ctrl] + [Alt] + [A].

Tipkom [Esc] uklanja se oznaCavanje sa svih trenutacno oznacenih
elemenata.

2.3.2. Kopiranje, lijepljenje, dupliciranje i brisanje elemenata

Program Inkscape nudi naredbe za kopiranje, lijepljenje, dupliciranje i
brisanje elemenata na tri mjesta. Naredbama se moze pristupiti preko
glavnoga izbornika Edit, u Command Baru (nedostaje samo ikona za
dupliciranje) i preko brzoga izbornika do kojeg se dolazi kad se pritisne
desnom tipkom miSa na neki element.

Najbrzi nacin za kopiranje nekoga elementa jest preko tipkovnice,
kombinacijom tipki [Ctrl] + [C]. Istu naredbu moguce je odabrati i preko
izbornika Edit > Copy ili desnim klikom miSa na element te u brzome
izborniku naredbom Copy.

Kopirani i izrezani element nalazi se spremljen u meduspremniku, a
moze se zalijepiti preko izbornika Edit - Paste ili pomocu tipkovnoga
pre€aca [Ctrl] + [V]. Element ¢e se zalijepiti na mjesto gdje se nalazi
pokaziva€ misa. Ako se Zeli zalijepiti element na isto mjesto s kojega je
bio kopiran, koristi se kombinacija tipki [Ctrl] + [Alt] + [V] ili preko
izbornika Edit > Paste - In Place. Moguce je i zalijepiti samo stil
nekoga elementa (kao $to je debljina ruba, boja ili font, boja, stil, veli€ina
za tekst) tako da se odabere naredba Paste - Style u izborniku Edit ili
preko tipkovnoga precaca [Shift] + [Ctrl] + [V].
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Element se moze izrezati s platna, ali i dalje zadrzati u meduspremniku
pomocu naredbe Cut koju je moguce odabrati preko izbornika Edit ili
kombinacijom tipki na tipkovnici [Ctrl] + [X].

Elementi se mogu i duplicirati tako da se kopiraju i postave na vrh
postoje¢ega elementa, na isto mjesto. Potrebno je oznaciti element i
odabrati naredbu Edit > Duplicate ili odabrati kombinaciju tipki [Ctrl] +
[D] na tipkovnici.

Ako se jedan ili vise elemenata zeli obrisati, potrebno ih je oznaditi, te
pritisnuti tipku [Delete] ili [Backspace] na tipkovnici ili odabrati Edit >
Delete.

2.3.3. Poravnavanje elemenata

Poredak po Z osi

Elemente je mogucée poravnavati, poredati i promijeniti poredak na vise
nacina.

U matematici postoje X, Y i Z osi po kojima se moZe odrediti toCna
lokacija nekoga elementa. U raCunalnim se programima X os odnosi na
vodoravno poravnavanje elemenata, Y os sluzi za okomito
poravnavanje, dok se Z os koristi za poravnavanje objekata po dubini.
Poravnavanje po dubini naj¢esée se koristi kod 3D alata, ali i u grafi¢kim
2D programima potrebno je poravnati elemente po dubini to se naziva
Z poredak. Za promjenu poretka nekoga elementa, potrebno je oznaditi
element kojemu se Zeli promijeniti poredak te preko izbornika Object
odabrati jednu od Cetiri naredbe za tzv. Z poredak:

Object > Raise pomite oznaceni element prema gore za jednu razinu,
a naredbu je moguce ukljuciti i preko tipkovne kratice [Page Up].

Object > Lower pomiCe oznaceni element prema dolje za jednu razinu,
a naredbu je moguce ukljuciti i preko tipkovne kratice [Page Down].

Object > Raise to Top pomite oznaceni element na vrh, a naredbu je
moguce ukljugiti i preko tipkovne kratice [Home].

Object > Lower to Bottom pomi¢e oznaceni element na dno, a
naredbu je moguce uklju€iti i preko tipkovne kratice [End].

Iste naredbe nalaze se i na alatnoj traci Tools Control Bar.

Na dolje prikazanoj slici moZe se vidjeti da je na lijevoj strani crveni krug
na vrhu slike po Z poretku dok je na desnoj strani crveni krug na dnu
slike po Z poretku. To se postiglo tako da se oznacio crveni krug s lijeve
strane i primijenila naredba Object > Lower to Bottom.
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Raspored elemenata

Za poravnavanje elemenata koristi se naredba Object - Align and
Distribute pomocu kratice na tipkovnici [Shift] + [Ctrl] + [A], nakon ¢ega
se otvara istoimeni dijaloSki okvir prikazan na sljedecoj slici.

[  |= Align and Distribute X v

[Er Align B Grid &3 Circular

.....

.....

@ Move/align selection as group

Relative to: | Selection Area * T .
@U E E ﬂ D%] ﬁ Zanimljivosti i napomene
KoriStenjem kartice Circular
DB” TDE’ *B% L&H D[au >a moguce je elemente
Distribute rasporediti po kruznici,
Eﬁh ﬁm Iﬂa d‘H‘n F_;}, elipsi ili luku.
EEEFE=R
Rearrange
M & 0% a]
Remove overlaps

Ho —+wo —+ ﬁ:”]

Ovaj dijaloski okvir omogucuje pozicioniranje elemenata u odnosu na
druge elemente ili selekcije, crteze ili u odnosu na stranicu. Dvije vrste
pozicioniranja su moguce preko ovoga izbornika — Align, gdje su centar
ili rubovi elemenata poravnati jedni s drugima i Distribute, gdje su
elementi rasporedeni u nekome smjeru prema njihovim centrima ili
rubovima.

U podrucju opcije Align moguce je elemente poravnavati okomito ili
vodoravno, na ikoni je prikazana crvena linija koja ozna¢ava na $to se
odnosi poravnanje. Kada se pomice kursor misa preko ikona za
poravnavanje, pojavi se kratak opis $to ozna€ava koja ikona, na primjer
prva ikona od okomitih znaci da ¢e se elementi poravnati po desnome
rubu, druga da se elementi poravnavaju po lijevome rubu itd.

Prije poravnanja elemenata potrebno je odabrati u odnosu na $to Ce se ti
elementi poravnati. U sekciji Align nalazi se padajuéi izbornik naredbe
Relative to u kojemu se mogu odabrati opcije po kojima ¢e se elementi
poravnavati. Tako se elementi mogu poravnati prema trenutnoj selekciji
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(Selection Area), crtezu (Drawing), stranici (Page), najmanjemu
elementu u selekciji (Smallest object), najveéemu elementu u selekciji
(Biggest object), prvome selektiranom elementu (First selected) ili
zadnjemu selektiranom elementu (Last selected).

Na dolje prikazanoj slici nalaze se krugovi koji su ,razbacani*, tj. nisu
vodoravno poravnati.

Ako ih se Zeli vodoravno poravnati, potrebno je odabrati opciju Relative
to: Selection Area, iako bi u ovome slu€aju bilo koja od opcija bila
zadovoljavajuéa jer su svi krugovi jednakih dimenzija, samo se razlikuju
po boji. Nakon toga se oznace svi elementi te se odabere opcija Center
on horizontal axis (drugi red, tre¢a ikona pod sekcijom Align).
Konacan rezultat ove opcije prikazan je na donjoj slici.

Kao §to je i vidljivo na gornjoj slici, elementi su poravnati vodoravno, al
razmak izmedu njih nije jednak. Ako se Zeli postaviti jednak razmak
izmedu svih elemenata potrebno se posluziti opcijama iz podruéja
Distribute. Oznace se svi elementi u kojima je potrebno primijeniti
jednak razmak i odabere se jedna od opcija za rasporedivanje
elemenata, na primjer Even horizontal centers $to znaci da ¢e se
elementi rasporediti tako da imaju jednak razmak od sredine jednoga
elementa do sredine svakoga slijedec¢eg elementa po vodoravnoj osi. Na
dolje prikazanoj slici moZze se vidjeti jednak razmak izmedu elemenata
nakon koriStenja spomenute opcije.

Ova opcija postavlja razmak izmedu elemenata tako da uzima
udaljenost od prvoga do posljednjeg elementa, a razmak izmedu njih
podijeli na ostale elemente. To znaci da pomocu ove opcije nije moguée
precizno odrediti razmak izmedu elemenata ve¢ se on odreduje
pravilnom raspodjelom.
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Poravnavanje po X i Y osi

Za dodavanje to¢no odredenoga razmaka izmedu elemenata ili za
svrstavanje elemenata u redove ili stupce Koristi se naredba Object >
Align and Distribute te se odabere dijaloski okvir Grid, prikazan na
donjoj slici.

E= Align and Distribute v

[Es Align 8 Grid

4% CGircular

Rows: Columns:
2 - 2 -+
Equal height Equal width
Alignment:
L
¢ o ¢
é o 9
Fit inte selection box  (®) Set spacing:
00 % 1500000 —+ px w
S v o000 — +
Arrange

U ovome dijaloSkom okviru moguce je odabrati na koliko redova ili
stupaca ce se raspodijeliti oznaceni elementi, je li potrebno imati
jednaku visinu i irinu tih stupaca i redova ili nije, pa sve do XiY
razmaka izmedu elemenata.

Ako se Zele postaviti Cetiri kruga, koja su trenutno u jednome redu, u dva
reda i dva stupca s jednakim X i Y razmakom, potrebno je u podrucje
Rows upisati ili okretnim dugmetom odabrati broj 2, Sto oznaCava dva
reda, i u podrucje Columns takoder upisati broj 2, $to oznacava broj
stupaca koiji ¢e biti izradeni. U podrucje X i Y potrebno je upisati razmak
izmedu elemenata koji je u pikselima, u ovome slu€aju stavit ¢e se na 15
px razmaka izmedu elemenata po X osi i 15 px razmaka izmedu
elemenata po Y osi. Nakon $to se podese sve Zeljene postavke,
potrebno je oznaciti elemente na koje se zeli primijeniti te postavke
(elementi mogu biti oznaceni i prije poCetka upisa u ovaj dijaloski okvir) i
pritisnuti na dugme Arrange. Elementi ¢e se poredati po kriterijima koji
su zadani, kao $to je i prikazano na donjoj slici.

Zanimljivosti i napomene

Boja pozadine moze se
izraditi na dva nacina.

Prvi nacin je odabir boje
pozadine pod opcijom
Background color do koje
je moguce doci preko
izbornika File = Document
Properties = Display,
klikom na ikonicu Page.
Drugi nacin je crtanje
pravokutnog oblika Zeljene
boje, istih dimenzija kao $to
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2.3.4. Grupiranje elemenata

U grupu se moZe staviti bilo koja skupina elemenata. Jednom kada su
elementi smjeSteni u grupu, s njima se moze manipulirati kao da se radi
o jednome elementu. Tako im se moze mijenjati dimenzija koja ¢e se
jednako promijeniti na svim elementima u grupi, boja, mogu se rotirati,
iskriviti te se mogu primijeniti mnoge druge opcije, koje se mogu
primijeniti i na zasebne elemente.

Za postavljanje elemenata u grupu, potrebno je prvo oznaditi one koji se
Zele staviti u odredenu grupu. Kada se Zeljeni elementi oznace, odabere
se naredba Object > Group. Sada se elementi nalaze u grupi i ako se
oznaci bilo koji element iz grupe, oznacit ¢e se cijela grupa. Ako se
elementi Zzele razgrupirati tj. maknuti iz grupe, to se moze napraviti
odabirom naredbe Object - Ungroup. Na dolje prikazanoj slici nalaze
se dvije grupe, a svaka od njih je iskrivljena na svoju stranu.

OO0

Alternativna metoda za razgrupiranje ili grupiranje elemenata je pritisak
desne tipke miSa na oznacene elemente i odabir odgovarajuc¢e naredbe
iz kontekstnoga izbornika — Group za grupiranje ili Ungroup za
razgrupiranje.

Najc¢e&ce koristena, ujedno i najbrza metoda grupiranja i razgrupiranja je
preko tipkovnoga preaca. Za grupiranje elemenata koristi se tipkovna
kratica [Ctrl] + [G], dok se za razgrupiranje koristi kratica [Ctrl] + [Shift] +
[G].

U grupu elemenata ulazi se dvostrukim klikom lijeve tipke miSa, a izlazi
na odabir bilo kojega elementa ili podrucja izvan grupe. Ulaziti se moze i
preko tipkovnice pritiskom na kombinaciju tipki [Ctrl] + [Enter], a izaéi se
moze kombinacijom tipki [Ctrl] + [Backspace].

Za dodavanje vec¢ postojecega elementa u postojecu grupu, potrebno je
odrezati element (Edit > Cut), uci u Zeljenu grupu i zalijepiti na istu
poziciju element (Edit > Paste - In Place) te ¢e element postati dijelom
te grupe.

2.4. Koristenje boja

Boja se moze primijeniti na element uporabom naredbi Fill ili Stroke.
Fill se odnosi na podrucje unutar elementa, dok se Stroke odnosi na
rub elementa.

Mnogo je nacina za promjenu boje elemenata, a neki od njih su preko
dijaloSkoga okvira Fill and Stroke (Object - Fill and Stroke), preko
izbornika Palette (na dnu programa, paleta s bojama) ili preko izbornika
Swatches (View - Swatches).
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2.4.1. Dijaloski okvir Fill and Stroke

U ovome dijaloskom okviru moguée je promijeniti boju unutar elementa
ili rub elementa tek nakon $to se nacrta neki element (za razliku od
mogucnosti predefiniranja boje u izborniku Palette). Za primjenu boje
unutar elementa ili postavljanje obruba potrebno je prethodno oznaditi
element. Na dolje prikazanoj slici nalazi se dijalo$ki okvir Fill and Stroke
do kojega se moze doci preko izbornika Object ili otvaranjem istoga u
skupini Dialogs, s desne strane programa (nalazi se tamo samo ako je
ve¢ prethodno otvoren taj dijaloski okvir).

<@
[ Fill and Stroke ~
Fill [ Strokepaint = Stroke style
xO0O0HEO? ov
Flat color &rcs -
Vi RGBA: ffE600FF
Blend mode: Mormal hd
Blur (%) 0,0 +

DijaloSki okvir ima tri kartice: prva kartica je Fill i odnosi se na boju
unutar elementa, druga kartica Stroke paint odnosi se na boju obruba
elementa, a tre¢a kartica Stroke style odnosi se na stil elementa.

Na kartici Fill moguce je prvo odabrati jednu od Sest ponudenih opcija
koje se odnose na vrstu prikaza boje unutar elementa. Tako se moze
odabrati:

¢ X (No paint) — oznaCava da nece biti boje unutar elementa

¢ Flat color — Sto znadi koristenje bilo koje pojedinaéne boje na
elementu

e Linear gradient — izraduje se linearni prijelaz boje minimalno
izmedu dvije boje

o Radial gradient — oznacava kruzni prijelaz izmedu minimalno
dvije boje

o Pattern — moze se obojiti element u neki uzorak

e Swatch — automatski se Cuvaju posljednje odabrane boje ili
spremljene boje.

Sama boja se mozZe odabrati iz paleta boja kao $to su RGB, HSL ili
CMYK jednostavnim upisom kéda boje za svaku pojedinu boju posebno,
drugim sustavima HSV, HSLuv i CMS ili upisom jedinstvenoga
heksadecimalnog kéda boje u podru¢je RGBA na dnu svake kartice.

@ srce 7



Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Na kartici Stroke paint moguce je takoder odabrati jednu od Sest
ponudenih opcija, koje su identi€ne kao i kod gore opisane Fill kartice,
ali se te opcije odnose na obrub elementa, tj. boju obruba.

Posljednja kartica Stroke style koristi se za odabir stila obruba. Tako se
moze odabrati Sirina obruba, vrsta spoja, izgled zavrSetka linije, oblik
linije (crtice, tockice, puna linija itd.) i markeri na kraju linije poput
strelice, kruga, romba, kvadrata i drugo.

Na dnu dijaloSkoga okvira moguce je koristiti jo$ i opcije Blur i Opacity.
Opcijom Blur moze se zamagliti neki element. Predefinirana postavka je
0% S&to znaci da element nije uopée zamagljen, dok 100% oznacCava
potpuno zamagljenje elementa. Postotak se moZe mijenjati upisom
konkretne vrijednosti u okvir Blur, povlacenjem klizaca ili okretnim
dugmetom. Druga opcija je Opacity, $to oznaCava neprozirnost
elementa, a predefinirana vrijednost je 100% Sto znaci da je element
potpuno neproziran, a 0% da je potpuno proziran. Postotak se takoder
moze mijenjati upisom vrijednosti, okretnim dugmetom ili klizacem.

2.4.2. Dijaloski okvir Swatches

U ovome dijaloSkom okviru, do kojega se dolazi preko izbornika View -
Swatches, moguce je odabrati neke predefinirane ili nedavno koristene
boje. Za odabir neke predefinirane palete boja u dijaloSkome okviru
Swatches klikne se na ikonicu oznacenu crvenim okvirom na dolje
prikazanoj slici.

@ Swatches - Boje.svg x
E;,! Swatches X L

X

Kada se odabere neka predefinirana paleta boja (Android icon palette,
Gold, Reds, Ubuntu ili neka druga) pojavit ¢e se sve boje iz te palete.
Element na koji se zeli primijeniti boja prethodno mora biti oznacen te se
liievom tipkom misa klikne na Zeljenu boju koja se primjenjuje na ispunu
elementa. Za odabir boje obruba potrebno je kliknuti desnom tipkom
misa na boju i odabrati opciju Set stroke. Moguce je i podesiti prikaz
boja pomocu raznih opcija koje se nude pritiskom na gore ozna¢enu
ikonicu i opciju Configure..., ispod popisa paleta.
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2.4.3. lzbornik Palette

Preko izbornika Palette moguce je na najbrzi nacin promijeniti boju
nekoga elementa. Nalazi se na dnu prozora, a uz njega su vezane i
opcije Fill i Stroke oznacene crvenim okvirom na donjoj slici. Pokraj tih
opcija nalazi se i brza opcija s oznakom ,0" §to ozna¢ava Opacity, t;.
koli€inu neprozirnosti elementa koja je opisana u poglavlju 2.4.1.

AV —
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L METE s — 4 R 0000 — +

o 100 — | sbstract infogra.. % A Rectangle in layer abstract infographic. & oo
. 229,
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Boja se moze odabrati i prije nego se krene crtati neki element, a moze
se i primijeniti na neki oznaceni element tako da se lijevom tipkom misa
klikne na zeljenu boju. Boja obruba moze se na brz nacin promijeniti
kombinacijom tipke [Shift] + lijeva tipka miSa na Zeljenu boju.

Boja se moze i prenijeti metodom ,povuci i ispusti“ (engl. Drag and
drop), tako da se lijevom tipkom miSa uhvati Zeljena boja na paleti boja
te se odvuCe do elementa na kojemu se Zeli primijeniti. Isti je postupak
ako se Zeli primijeniti i na obrub elementa, samo $to se boja odvuce do
obruba elementa.

Kada je neki element oznacen moguce je promijeniti i nijansu boje
takozvanom gestikulacijom mi8a. Pritisne se i drzi lijeva tipka miSa na
podruéju Fill, ispod palete boje, te se krece miSem u lijevu ili desnu
stranu za promjenu boje. Na selektiranome elementu moguce je vidjeti
kako se mijenja boja ovisno o povla¢enju miSa. Za mijenjanje boje
obruba, potrebno je na isti nacin pritisnuti i drzati lijevu tipku miSa na
podrucju Stroke. Ako se uz ovaj postupak pritisne i drzi tipka [Shift]
mijenja se zasicenje, a tipkom [Ctrl] svjetlina.

2.4.4. Stvaranje i uredivanje gradijenata

Gradijenti su blagi prijelazi iz jedne boje u drugu, a mogu biti linearni
(prikazan na donjoj slici, lijevo) ili radijalni (prikazan na donjoj slici,
desno). Postoji nekoliko nacina kako se gradijenti mogu postaviti na
element, a neki osnovni su stavljanje gradijenta na Zeljeni element preko
izbornika Fill and Stroke, stavljanje na element pomocu alata Gradient,
uredivanje tzv. stop to€aka koje sluze za dodavanje viSe boja,
podeSavanje orijentacije gradijenta i drugi.

Najlak$i nacin za postavljanje gradijenta na neki element je preko
izbornika Fill and Stroke. Za postavljanje je potrebno samo oznaditi
Zeljeni element i kliknuti na dugme Linear gradient ili Radial gradient,
ovisno o potrebi, oznaceno crvenim okvirom na dolje prikazanoj slici.
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Nakon klika na jednu od opcija, stvorit e se automatski gradijent s dvije
stop tocke. Prva stop tocka je izradena tako da je uzeta prethodno
koriStena boja koja se nalazi u opciji Fill sa 100% zasi¢enjem, dok je
druga ista ta boja ali 100% transparentna.

Za promjenu smjera gradijenta, dodavanje novih boja, koli¢ine gradijenta
ili neke druge modifikacije na gradijentnome elementu, potrebno je

odabrati alat Gradient Tool koji se nalazi u Toolboxu, a koji je
takoder moguce odabrati i preko tipkovnoga precaca [Ctrl] + [F1] ili [G].
Nakon toga, potrebno je kliknuti lijevom tipkom misa na element kojemu
se Zeli promijeniti gradijent. Na dolje prikazanoj slici moze se vidjeti kako
izgleda gradijentni element s tri razliCite boje.

Kvadrat, romb i krug predstavljaju poCetnu, srednju i zavrdnu stop tocku.
Gradijent od dvije boje sastoji se samo od kvadrata i kruga koji
oznacavaju pocetnu i stop toCku na kojima se mogu raditi preinake.

Stop to¢ke mogu se dodati izmedu pocetne i zavrSne toCke, kada je
odabran alat Gradient, preko izbornika Tool Controls Bar pritiskom na
dugme Insert new stop ili dvostrukim klikom lijeve tipke miSa na
gradijentnu liniju. Za brisanje je potrebno oznaditi Zeljenu stop tocku na
gradijentnoj liniji i pritisnuti na tipkovnici tipku [Delete] ili u Tool Controls
Baru odabrati naredbu Delete stop.

Stop to¢ke mogu se oznaciti alatom Gradient, tako da se pritisne
lijevom tipkom miSa na jednu od njih. Kada je stop to¢ka ozna¢ena, ona
se moze modificirati u smislu pomicanja, mijenjanja boje i prozirnosti.
Samo se na pocetnoj i zavrSnoj tocki moze mijenjati smjer gradijenta. Za
oznacCavanje viSe stop toCaka, potrebno je pritisnuti i drzati tipku [Shift]
na tipkovnici i ljevom tipkom miSa oznacavati Zeljene stop tocke. Za
oznacCavanje svih stop toCaka potrebno je odabrati kombinaciju tipki
[Ctrl] + [A] na tipkovnici.
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2.4.5. Uzimanje boje alatom Dropper

Boja ispune elementa i njegova obruba mogu biti promijenjeni tako da se
uzme neka vec¢ postojeca boja na crtezu, koriStenjem alata Dropper

Tool /' koji se nalazi u Toolboxu ili preko tipkovnoga precaca,
pritiskom na tipku [F7] ili [D]. Pomoc¢u ovoga alata mogucée je uzeti
prosjecnu boju nekoga elementa pomoéu oznacenoga kruznog
podrucja, invertirati uzetu boju ili spremiti boju u meduspremnik za
kasniju upotrebu.

Ako se Zeli samo uzeti boja od nekoga veé nacrtanoga elementa u

dokumentu, potrebno je uzeti alat Dropper Tool n‘/ i lijevom tipkom
miSa kliknuti na Zeljenu boju. Nakon toga, boja se postavlja u opciju Fill.
Boju je moguce postaviti i u opciju Stroke tako da se pritisne i drzi tipka
[Shift] na tipkovnici i lijevom tipkom miSa se odabere Zeljena boja. Nakon
postavljanja, svaki ¢e sliede¢i novo nacrtani element imati postavljene te
boje, tako dugo dok se one ne zamijene u opcijama Fill i Stroke nekom
drugom bojom.

Kada se nekomu elementu Zeli promijeniti boja pomocu ovoga alata,
potrebno je prvo oznaditi taj element. Nakon toga se odabere alat

Dropper Tool n/ te se za ispunu elementa (Fill) pritisne lijevom
tipkom miSa na Zeljenu boju u dokumentu, a ako se Zeli boja primijeniti
na obrub (Stroke), pritisne se i drzi tipka [Shift] i odabere boja lijevom
tipkom miSa. Nakon pritiska, boja se odmah primjenjuje na oznaceni
element.

Za uzimanje srednje vrijednosti boje, pritisne se i drZi lijeva tipka miSa uz
povlagenje miSa u bilo kojem smjeru. Stvara se krug koji oznacava
podrucje koje ¢e se uzeti u obzir za uzimanje srednje vrijednosti boje.

Za kopiranje boje, potrebno je kliknuti ljevom tipkom misa na zZeljenu

boju alatom Dropper Tool / te pritisnuti kombinaciju tipki [Ctrl] +
[C] za kopiranje heksadecimalnoga koéda boje. Boja se lijepi tako da se
selektira element na koji se Zeli primijeniti kopirana boja te se u podrucje
RGBA, u dijaloskome okviru Fill and Stroke, kombinacijom tipki [Ctrl] +
[V] zalijepi heksadecimalan kéd boje.
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Zanimljivosti i napomene

Boja pozadine moze se
izraditi na dva nacina.

Prvi nacin je odabir boje
pozadine pod opcijom
Background color do koje
je moguce doéi preko
izbornika File = Document
Properties = Display,
klikom na ikonicu Page.
Drugi nacin je crtanje
pravokutnog oblika Zeljene
boje, istih dimenzija kao $to
je i pozadina.

Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

2.5.

Vjezba: lzrada crteza

1.

Izradite crtez inspiriran popularnom starom igrom
.,Pacman®, koji je prikazan na donjoj slici. Boja pozadine
je ,000000ff, u heksadecimalnom obliku, a dimenzija
pozadine je 1100x760 px.

Zuti krug koji izgleda kao glava s otvorenim ustima
(Pacman), dimenzije je 170x170 px. Zuti krugovi su
dimenzije 55 px i ,ffffOOff* boje u heksadecimalnome
obliku.

Plave prepreke visine su 50 px, ,,0000ffff ,, boje u
heksadecimalnome obliku, a Sirina proizvoljna, sto sli¢nija
donjoj slici.

Postavite zute krugove tako da su svi jednako odmaknuti

jedan od drugoga, a da je razmak izmedu njih 120 px po
vodoravnoj i okomitoj osi.

Spremite crtez pod nazivom Pac-man.svg.
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3. Rad s putanjama i tekstom -

Po zavrsetku ovoga poglavija moci Cete: Trajanj_e.
poglavija:
e Koristiti i uredivati putanje
50 min

e dodati tekst na crtez
e yredivati tekst.

U ovome poglavlju govorit ¢e se o stvaranju novih elemenata pomocu
dva ili viSe postojecih te kako se dodaje i ureduje tekst.

3.1. Putanje i njihovo uredivanje

U programu Inkscape moguce je uporabom vide naredbi izraditi novi
element iz jednoga ili viSe postojecih elemenata. Kod ovoga nacina jako
je bitan takozvani Z poredak elemenata (objasnjen u poglavlju 2.3.3.). U
gotovo svim slu¢ajevima (iznimka je samo naredba Cut Path), Fill i
Stroke novoga elementa se nasljeduje, tj. kopira od donjega elementa,
tj. elementa koji je nize rangiran po Z poretku. Postoje neke iznimke
koje ¢e biti objasnjene kod konkretnih naredbi.

Svim naredbama ove vrste pristupa se preko izbornika Path, a
prethodno je potrebno osigurati svim objektima da postanu putanje. Sve
osnovne graficke objekte koji se mogu izraditi u Inkscapeu, kao i tekst,
potrebno je pretvoriti u putanje. Objekti se pretvaraju u putanje preko
izbornika Path > Object to path ili Path > Stroke to path.

Union

Za spajanje, tj. uniju dva ili viSe elemenata potrebno je oznaditi elemente
i odabrati naredbu Path - Union ili preko tipkovnoga precaca [Ctrl] +
[+]. Novi element sadrzi sva podrucja izvornih elemenata, osim spojeva
izmedu elemenata, koji su izbrisani i pretvoreni u jedan element kao Sto
je i prikazano na donjoj slici. Na lijevoj strani slike nalaze se zasebni
elementi, dok je na desnoj strani novostvoreni element plave boje zbog
toga Sto je element koji je najnize rangiran po Z poretku takoder plave
boje.

—»

Difference

Ako je potrebno obrisati donji element pomocu gornjega, ali samo
razlikom, tj. onim podru¢jem gdje se dva elementa preklapaju, koristi se
naredba Path - Difference, a do nje se moze doci i pomocu tipkovnoga
pre€aca [Ctrl] + [-]. Kod ove naredbe moguce je oznaciti samo dva
elementa istovremeno i nakon toga primijeniti naredbu. Na donjoj slici
prikazan je rezultat ove naredbe.
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- u

Intersection

Ako se zeli izraditi presjek izmedu dva ili viSe elemenata koristi se
naredba Intersection. Potrebno je oznaditi elemente i primijeniti
naredbu. Novi element koji se dobije ovom naredbom nastaje od
preklapajucega tj. zajedni¢koga podrudja izvornih elemenata. Do
naredbe se dolazi preko izbornika Path ili pomocu tipkovne kratice [Ctrl]
+ [*]. Na dolje prikazanoj slici prikazano je preklapanje dvaju elemenata.

e - «

Exclusion

Ako se zeli iskljuciti dva ili vise elemenata u njihovim preklapanjima,
koristi se naredba Path - Exclusion na nacin da se oznace elementi na
koje se ta naredba Zeli primijeniti i odabere se naredba iz izbornika. Na
dolje prikazanoj slici moze se vidjeti rezultat primjene ove naredbe
izmedu tri elemenata.

0 - )

Division

Kada se neki element Zeli podijeliti koristi se naredba Path - Division
do koje se moze doci i kombinacijom tipki [Ctrl] + [/] na tipkovnici.
Naredba radi tako da je niZe rangirani element po Z poretku odrezan
viSe rangiranim elementom. Moguce je oznaditi samo dva elementa
istovremeno za primjenu ove naredbe. Na donjoj slici moze se vidjeti
primjer naredbe — desna strana je malo odmaknuta tako da se bolje vidi
rezultat ove naredbe.

0 - me
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Cut Path

Ako se zeli odrezati neki element po obrubu, koristi se naredba Cut
Path koju je moguce odabrati u izborniku Path ili preko tipkovnoga
preCaca [Ctrl] + [Alt] + [/]. NiZe rangirani element je odrezan viSe
rangiranim elementom. Moguce je oznaciti samo dva elementa za
primjenu ove naredbe. Novonastali elementi nemaju nikakvu ispunu iako
su je mozda imali prije koriStenja ove naredbe. Na donjoj slici moze se
vidjeti rezultat naredbe. Desni dio slike pomaknut je tako da se
novonastali odrezani elementi vide jasnije.

Osim tih osnovnih vrsta putanja, korisne su jo$ dvije naredbe na
izborniku Path: Combine i Break Apart.

Naredba Combine kombinira viSe oznaenih elemenata u jedan sloZeni
element kojim se moZe manipulirati kao i obi¢nim elementom. Prednost
ovoga nacina jest da se nakon zavrSene manipulacije tim slozenim
elementom on moze opet razdvoijiti na pojedinacne elemente naredbom
Path - Break Apart.

3.2. Dodavanje i uredivanje teksta

Dvije su osnovne vrste tekstnih objekata u Inkscapeu, regularan, tj.
obi¢an i tekst koji uklju€uje pravokutni okvir. Tekst se kreira alatom Text

Tool AI koji se nalazi u Toolboxu, a do njega se moze doci i preko
tipkovnoga prec€aca [F8] ili [T].

Kada se Zeli dodati tekst prvim, ,obi¢nim“ na¢inom na neki crtez

potrebno je uzeti alat Text Tool AI u Toolboxu i kliknuti misem na
podruéje u dokumentu gdje se Zeli dodati tekst. Kako se tekst upisuje
tako se i tekstni okvir prilagodava tekstu. Prijelomi u retku moraju se
ruéno dodavati u ovome nacinu upisa. Na donjoj slici prikazan je upis
obi¢noga teksta.

Drugi na€in dodavanja teksta jest upis u precizno odreden kvadratni
tekstni okvir. Kod ovoga nacina upisa, potrebno je uzeti alat Text Tool

AI iz Toolboxa te izraditi tekstni okvir tako da se pritisne i drZi lijeva
tipka miSa na podrucju gdje se Zeli izraditi kvadratni tekstni okvir te se
povlaci u Zeljenome smjeru. Nakon zadovoljavajuée veli€ine tekstnoga
okvira pusti se lijeva tipka mida. Buduéi da se tekst upisuje unutar
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tekstnoga okvira, nije potrebno stavljati prijelome redaka ve¢ se oni
automatski stvaraju. Tekstni okvir moze se i naknadno pode$avati tako

da se alatom Text Tool @I klikne na zeljeni sadrzaj te se pritisne i drzi
lijeva tipka miSa na donji desni kut (romb) tekstnoga okvira i pomice u
zeljenome smjeru. Kada je novi oblik zadovoljavajuéi, pusti se lijeva
tipka miSa. Na donjoj slici prikazan je upis teksta u tekstni okvir.

Ovo je tekst upisan u tekstni

Za uredivanje teksta, potrebno je uzeti alat Text Tool AI i kliknuti
miSem u podrucje teksta koji se zeli promijeniti. Tekst ce se oznaditi i
pokaziva¢ misa ¢e biti postavljen izmedu onih slova gdje se kliknulo.

Dodatne mogucénosti za uredivanje teksta, otvaraju se u Tool Controls
Baru koji je prikazan na donjoj slici, a na kojemu je moguce, osim
osnovnih izmjena poput promjene fonta, veliCine ili pozicije teksta,
podesiti i neke naprednije mogucénosti. Tako je moguce postaviti razmak
izmedu linija, slova, rijeci, vodoravan ili okomiti pomak slova, rotiranje
slova i drugo. Neke od navedenih opcija dostupne su klikom na ikonicu
Spacing oznaceno crvenim okvirom na dolje prikazanoj slici.

A C s @] ¥ | Normal > | vy Roe — ey = X va B~ E-~
- S | . ER [ E TP Ey e R 4
Y i (000 — 4+ 8000 — 4 Kgl000 —+
™ 1

Osim brzih podeSavanja u Tool Controls Baru, osnovne postavke
teksta je moguce i promijeniti u dijaloSkome okviru Text and Font do
kojega se dolazi preko izbornika Text. DijaloSki okvir sastoji se od tri
kartice. Na prvoj kartici Font moguce je promijeniti font, veli€inu i stil.
Bitno je napomenuti da je poslije svake promjene u dijaloSkome okviru
potrebno pritisnuti dugme Apply za primjenu zadanih postavki. U drugoj
kartici Features moguce je dodatno podesiti opcije odabranog fonta
poput dijeljenja rijeci, pozicije, upotrebe verzalnih slova itd. U treéu
karticu Text moguce je zalijepiti tekst iz nekoga drugog programa koji ¢e
se nakon toga prikazati u trenutno odabranome tekstnom okviru.
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4 Text and Font - Putanje.svg
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Set as default Apply

Osim standardnih postavki za oblikovanje teksta, u Inkscapeu je moguce
i postaviti tekst na neki element, pravilan ili nepravilan. Za tu moguc¢nost
potrebno je prvo izraditi neku putanju, element i upisati neki tekst. Nakon
toga je potrebno oznaciti tekst i element te odabrati naredbu Put on
Path koja se nalazi na izborniku Text. Ako se tekst Zeli ukloniti, {j.
obrisati s putanje ili elementa potrebno je odabrati naredbu Remove
from Path koja se nalazi na istome izborniku. Na donjoj slici moze se
vidjeti kako izgleda neki tekst smjeSten na razliCite elemente.

g /ape .‘k‘\

/& Qi
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Tekst se moZe rotirati i dodatno oblikovati preko standardnih naredbi
koje se koriste u oblikovanju teksta. Element se moze maknuti, tj. sakriti
tako da se ne vidi na kakvome je elementu taj tekst napisan. Potrebno je
oznaciti element i odabrati u dijaloSkome okviru ili na paleti boja da
element nema obruba. Nakon toga element viSe nije vidljiv kako je i
prikazano na donjoj slici.
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Za vracanje elementa, potrebno je prvo oznaciti tekst te odabrati
naredbu Edit > Clone - Select Original. Nakon toga pojavit ¢e se
selekcija na jos uvijek nevidljiv element na koji je potrebno postaviti
obrub da postane vidljiv. Nakon postavljanja obruba, element i tekst ¢e
se prikazat kao i na poCetku.
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3.3.

Vjezba: lzrada posjetnice

1.

Izradite posjetnicu dimenzije 90 x 55 mm dizajna kao na
donjoj slici.

. Zeleni krugovi kre¢u se od najtamnijega prema

najsvjetlijemu u ovim bojama:

¢ najtamniji krug, tj. najvise rangiran ima
heksadecimalni kdd boje ,2ca02cff,

o srednji krug ima heksadecimalni kéd boje
,87de87ff",

¢ najsvjetliji krug, tj. najnize rangiran ima
heksadecimalni kéd boje ,d7f4d7ff".

Radi boljeg dojma izrezite krugove pomocu naredbe
Difference, tako da izgledaju Sto sli¢nije donjoj slici.

Kompletan tekst koji se nalazi na posjetnici ima font Arial
i zelene je boje heksadecimalnoga kbéda ,2ca02cff*.
Veli¢ina slova za ,Ime Prezime® je 14 pt i podebljano,
.Ime sektora“ je 6 pt i crne boje, heksadecimalnoga
koda ,000000ff“, a svi ostali podaci koji se nalaze na
posjetnici su veli€ine 9 pt.

. Tri glavne linije su crne boje, irine 140 px i debljine 1 px,

a prva manja linija je Sirine 120 px, debljine 0,7 px, boje
heksadecimalnoga koda ,999999ff“.

Spremite crtez pod nazivom Posjetnica.pdf.

Ime Prezime

Ime sektora

Miroslava Krleze 22a,
10 000 Zagreb

Mob.: 098/ 322 75 87
Tel.: 01/ 487 622

ime.prezime@ustanova.hr

Ako ste zavrsili prethodne zadatke prije predvidenog vremena, pokusajte
rijesSiti i sljedecCa dva zadatka:

1.

2.

Tri glavne linije su crne boje i kre¢u od 165 px po X osi.
Odmaknute su jedna od druge 35 px, Sirine 140 px i
debljine 1 px, a prva manja linija je Sirine 120 px, debljine
0,7 px i boje heksadecimalnoga kdda ,999999ff,
odmaknuta od prve crne linije 13 px.

Adresa, mobitel i telefon te e-mail odmaknuti su od gornje
linije 8 px, dok je ,lme i prezime“ odmaknuto od donje
linije 10 px. Sav navedeni tekst krece od 170 px po X osi,
dok ,Ime sektora“ kre¢e od pocetka linije.
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4. Slojevi i uredivanje putanja

Po zavrSetku ovoga poglavija moci cete:
e jzraditi samostalno slojeve
e preurediti cvorove i efekte na putanjama.

4.1. Uporaba slojeva

Svaki sloj (engl. layer) moze sadrzavati jedan ili viSe elemenata.
Konacan crtez je izraden od svih elemenata spojenih i vidljivih slojeva.
Slojevi se mogu postaviti tako da budu vidljivi ili nevidljivi, mozZe im se
postaviti prozirnost, pomicati ih na viSe razine ili na manje ovisno o
drugim slojevima, zakljuavati ih, brisati i preimenovati.

Slojevima se moze manipulirati preko dijaloskog okvira Layers,
prikazanoga na donjoj slici, koji se nalazi u izborniku Layer, a isti se
moze dobiti i tipkovnim pre€acem [Shift] + [Ctrl] + [L].

(=t Layers (Shift+Ctrl+L) = @

w @ Layer 3

W @ Layer1

+ = T+IE
Blend mode: | Mormal IZI
Opacity (%) 100,0| -

Dijaloski okvir Layers prikazuje sve slojeve koji se trenutacno nalaze u
dokumentu, a trenutacno oznaceni sloj je osvijetlien plavom bojom
(Layer 2 na gornjoj slici). Kada se oznaCavaju elementi na crteZu koji su
rasporedeni po razli¢itim slojevima, oznacit ¢e se to¢no taj sloj u kojemu
se nalazi oznaceni element. Samo jedan sloj moze biti oznagen u
jednom trenutku.

Ispred imena sloja nalaze se dvije ikonice, od kojih prva oznacava je li
sloj vidljiv ili ne (ikonica oka), a drugom se moze odredeni sloj zakljucati
ili otkljuc€ati (ikonica lokota). Elementi koji su sakriveni ili zaklju¢ani ne
mogu biti ozna&eni ili modificirani.

Ako se pritisne desnom tipkom miSa na bilo koji sloj, pojavit ¢e se mali
skocni izbornik u kojem je moguce preimenovati sloj, duplicirati ga,
obrisati, staviti ga na viSu ili nizu razinu i dodati razne funkcije tomu
sloju.

Tipke koje se nalaze ispod liste slojeva mogu se takoder Koristiti za brzo
dodavanje (+) ili brisanje (-) slojeva, kao i za pomicanje slojeva na visu ili
nizu razinu (strelica gore ili dolje).

Izbornik Blend mode sluzi za dodavanje raznih filtera samo na odabrani
sloj. Moguce je odabrati vise od desetak opcija u ovom izborniku.
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Na kraju je opcija Opacity koja oznaCava neprozirnost oznacenoga
sloja. Po¢etna vrijednost je 100 %, Sto je potpuno neprozirno, dok je 0 %
potpuno prozirno. Neprozirnost se moze mijenjati izravnim upisom
vrijednosti u podrucje Opacity, povlatenjem pokazivaca misa ili
okretnim dugmetom.

Sve mogucnosti koje se nalaze u dijaloSkom okviru Layers i joS neke
dodatne mogucnosti vezane za slojeve moguce je naéi i na glavhom
izborniku Layer.

4.2. Uredivanje ¢vorova na putanjama

Pod pojmom uredivanje évorova na putanjama smatra se izmjena

jednog ili vise ¢vorova (to¢aka) putanje koristenjem alata Node Tool N .
Ovaj fleksibilan alat omoguéuje dodavanje, brisanje i pomicanje ¢vorova
na putanjama, a odabire se klikom na ikonu alata Node Tool u Too/
Boxu ili tipkovnim preCacem [F2] ili [n]. Nakon odabira alata klikne se na
putanju koja se zeli urediti. Na putanji ¢e se prikazati svi Evorovi
oznacene putanje koji se mogu uredivati pojedinacno ili u grupama
ovisno o tome koliko ih se selektira. Za selekciju viSe vorova pritisne se
i drzi tipka Shift + klik s lijevom tipkom misa.

Kad se alatom Node Tool prelazi preko neke putanje, nakratko ¢e se
prikazati obrub putanje. Trajanje i boja ovog obruba moze se promijeniti
u izborniku Preferences > Node, do kojeg se najlakse moze doci
dvostrukim klikom na alat Node Tool. U dodatnim opcijama ovog
izbornika moguce je onemoguciti prikazivanje obrisa putanje i podesiti
ostale korisne opcije.

4.2.1. Selektiranje €vorova

Da bi se mogli uredivati, Evorovi se moraju prvo selektirati. Moguce je
odabrati jedan ili viSe €vorova na istoj putanji ili kombinaciju ¢vorova s
viSe razli¢itih putanja, a jedini je uvjet da su putanje, u kojima se odabiru
évorovi, istovremeno selektirane.

Cvorovi se mogu selektirati za uredivanje na vise nagina:

o pritiskom lijeve tipke miSa na ¢&vor, nakon ¢ega ¢vor mijenja boju
u crvenu, §to znaci da je oznacen. Nakon toga pritisne se i drZi
lijeva tipka miSa ako se Zeli Evor pomicati

e pritiskom i drzanjem lijeve tipke miSa na putanji odabrat ¢e se
najblizi Evor ovisno o strani na kojoj se kliknulo

e drzanjem lijeve tipke miSa i povlaCenjem preko ¢vorova, odabrat
Ce se svi ¢vorovi unutar okvira za oznaCavanje.

Vise ¢vorova moze se oznacavati i drzanjem tipke [Shift] te pritiscima
lijeve tipke miSa po zeljenim &vorovima.

Cvorovi se takoder mogu dodati ili ukloniti iz odabira pomoéu kotaciéa
misa. Dovoljno se samo pozicionirati na neki od ¢vorova i okretati
kotaci¢ mida prema gore za dodavanje ¢vorova ili prema dolje za
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

uklanjanje &vorova iz odabira. Na donjoj desnoj slici nalazi se primjer na
kojem su oznaceni svi Evorovi na desnoj strani i proporcionalno
smanjeni tako da se dobije efekt perspektive.

4.2.2. Koristenje Node Tool trake alata

Node Tool pruza jednostavan nacin pristupa mnogim metodama
uredivanja ¢vorova.

£ - 2 12X U8RI VWl |/ | G| ol v [modmEl 5 5 o

t Insert new nodes into selected segments — umetanje novih
¢vorova na odabranu putanju. Osim ovog nacina, ¢vorovi se mogu
ubaciti i dvostrukim klikom lijeve tipke miSa na putanju. Za rad ove
naredbe potrebno je oznaciti najmanje dvije tocke izmedu kojih ¢ée se
dodati nova tocka.

- Delete selected nodes — brisanje odabranih ¢vorova. Odabrani
¢vorovi mogu se obrisati i pritiskom na tipku Backspace, Delete ili
kombinacijom tipki Ctrl + Alt + lijeva tipka misa.

¢+ Join selected nodes — pridruzivanje, tj. spajanje odabranih
krajnjih Evorova. Obi¢no se spojeni ¢vor nalazi na sredini izmedu
krajeva ¢vorova.

Break path at selected nodes — prekid putanje na selektiranom
¢voru. Svaki odabrani ¢vor pretvara se u dva krajnja ¢vora.

Join selected endnodes with a new segment — pridruzivanje
odabranih krajnjih ¢vorova. Ako se odabere viSe od dvaju zavrdnih
¢vorova, parovi krajnjih &vorova ¢e biti spojena sa novim segmentom.

*
oo

= Delete segmet between two non-endpoint nodes — brisanje
segmenta izmedu dvaju ¢vorista bez krajnje tocke.

Make selected nodes corner — stvaranje kutova na odabranim
¢vorovima.

Make selected nodes smooth — stvaranje odabranih &vorova
glatkima.

Make selected nodes symmetric — stvaranje odabranih &vorova
simetricnim.
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Make selected nodes auto-smooth — automatsko stvaranje
odabranih ¢vorova glatkima.

= Make selected segments lines — od odabranih évorova izrade se
ravne linije.

= Make selected segments curves — odabrani se segmenti
pretvaraju u krivulje.

» Convert selected object to path — konvertiraju se odabrani
objekti u putanje.

& Convert selected object's stroke to path — pretvaraju se
odabrani obrubi u putanje.

x 477235 v 22080z om ~|  — OKVIF za unos x i y koordinata odabranih ¢vorova.

Show clipping path(s) of selected objects — prikaz putanje
isjeCaka selektiranog objekta.

Show mask(s) of selected object(s) — prikaz maske selektiranog
objekta.

=

P Show next editable path effect parameter — prikaz parametara
efekata za sljede¢u raspoloZivu putanju za uredivanje.

T Show transformation handles for selected nodes — prikaz
okvira za transformaciju oznac¢enih ¢vorova.

¥ Show Bezier handles of selected nodes — prikaz Bezierovih linija
selektiranih ¢vorova.

= Show path outline — prikaz obruba putanja bez primjene efekta.

4.2.3. Poravnavanje ¢vorova

Dijaloski okvir Align and Distribute (Object - Align and Distribute)

ima posebne naredbe za uredivanje ¢vorova kada se koristi alat Node
Tool. Na donjoj slici prikazan je dijaloSki okvir koji se pojavljuje samo u
slu¢aju kada je alat Node Tool aktivan, tj. odabran.

E> Align and Distribute

[Ep Align B8 Grid & Circular

Align Nodes
Relative to: | First selected -
3
Distribute Nodes

A

Naredbe koje su dostupne u dijaloSkom okviru Align and Distribute:

e 7 poravnanje odabranih &vorova na zajedni¢ku vodoravnu liniju

. § poravnanje odabranih ¢vorova na zajednic¢ku okomitu liniju
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171} . -
o vodoravno rasporedivanje odabranih ¢vorova

o = okomito rasporedivanje odabranih &vorova.

Naredbe omogucuju poravnavanje i ravnomjerno distribuiranje
odabranih ¢vorova kao $to je prikazano na donjoj slici.

A | | S S S M. S N S A . . S| S M M

4.2.4. PodeSavanje ¢vorova i markeri

Moguce je podesiti i viSe ¢vorova u isto vrijeme pomocu alata Node
Tool. Osnovni princip je da se odabere grupa ¢vorova i nakon toga se
oznaci samo jedan ¢vor pritiskom lijeve tipke miSa. Drzanjem lijeve tipke
miSa te pritiskom i drzanjem tipke [Alt] mogu se pomicati &vorovi.
Moguénosti ovakve manipulacije nad putanjama najbolje su prikazane
na donjoj slici.

T

Markeri su objekti kao Sto su glave strelica postavljene na neku putanju.
U Inkscapeu se mogu odrediti razli€iti markeri za razli¢ita podrucja.
Razli¢iti markeri mogu se postaviti na pocetak putanje, na sredinu i na
kraj bilo koje putanje. Srednji markeri su smjeSteni na svakom &voru koji
nije prvi ili zadnji.

KX

Na gornjoj slici su prikazana tri razli¢ita markera, prednji, sredniji i zadnji,
koji se mogu proizvoljno nacrtati i postaviti kao marker ili uzeti iz ve¢
pripremljene biblioteke markera.

Ako se zeli koristiti neki nacrtani objekt koji ¢e postati marker, potrebno
je crtez pretvoriti u putanju, ako ve¢ nije pretvoren od prije (Path >
Object to Path).
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Nakon toga, potrebno je selektirati nacrtani objekt i odabrati naredbu
Object > Objects to Marker. Objekt ¢e nestati jer se spremio u
biblioteku markera. Za koristenje markera potrebno je prvo nacrtati
putanju na kojoj se zele koristiti markeri. Potrebno je i dodati zeljeni broj
¢vorova na putanju jer se markeri postavljaju samo tamo gdje se nalaze
¢vorovi. Selektira se putanja s alatom Node Tool i odabere se u
dijaloS8kom okviru Fill and Stroke kartica Stroke style. Pod opcijom
Markers moguce je odabrati tri mogucnosti preko padajucih izbornika.
Prvi izbornik je Start markers koji ozna€ava pocetni marker, drugi je Mid
markers i zadnji je End markers. U svakom padajuc¢em izborniku
moguce je odabrati prethodno nacrtani objekt koji smo postavili za
marker. Nakon odabira, markeri ¢e se pojaviti na oznacenoj putanji.

[Z#Fill and Stroke (Shift+Ctrl+F) F®
Fill [ Stroke paint =* Stroke style

Width: | 0,265 mm |~

Dashes: ~ 10,00

Markers: |— ~ | |— — v
Joim: (I: (I_' ; :
Cap: m :

Order:@ Q &«
1R
-

Blur (%) 00

Opacity (%)

4.3. Efekti na putanjama

Live Path Effect ili skraceno LPE je sustav za primjenu efekata na
odabranu putanju. Za koriStenje LPE-a potrebno je oznaditi putanju
(kostur putanje, ne ¢vor), ukljuciti dijaloski okvir Path Effect Editor (Path
- Path Effect Editor) i u njemu odabrati zeljeni efekt pomoc¢u dugmeta
Add. Nakon odabira potrebno je samo pritisnuti na dugme Add path
effect. ViSe efekata moze biti povezano zajedno. Redoslijed kojim se
svaki efekt primjenjuje na putanju, moze se promijeniti klikom na
odgovarajucu strelicu (gore ili dolje). Svaki efekt moze se privremeno
iskljuciti klikom na ikonu ,oka“ pored efekta.
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¥ Path Effects (Shift+Ctrl+7) = ®
4 Bend
4 Bounding Box
+ = @+ I
Construct grid
Size o |5 =
SizeY: |5 =

Kada se odabere objekt pomocu alata Node Tool koji ima neki LPE,
izvorni ¢vorovi putanje su prikazani. Sama izvorna putanja moze biti
prikazana crvenom bojom, a vidljivost putanje kontrolira se ikonom
koja se nalazi u opcijama za upravljanje ¢vorova.

Bend efekt poprima postojecu putanju i dopusta joj da se "savije" na
dobro definiran nacin putem kontrolne putanje. Kontrolna putanja se
automatski kreira kada se postavi Bend efekt. Putanjom se moze
manipulirati na sve nacine kao i s regularnom putanjom, uklju€ujudéi i
dodavanje novih ¢vorova i povlaenje putanje. Na donjoj slici prikazan je
primjer koristenja Bend efekta na tekstu.

¥, ]
')4_@ (,0'5‘
R o
Dg je besplatan p"

Ruler efekt pretvara bilo koju putanju u ravnalo. Ovaj efekt moguce je
postaviti na brojne putanje, potrebno je prvo izraditi putanju i nakon toga
primijeniti efekt Ruler na tu putanju. U postavkama ovog efekta moguce
je mijenjati velik broj opcija koje se nude. Tako je moguce odrediti u
kojem smjeru Ce biti okrenuto ravnalo (gore, dolje ili u oba smjera),
oznake obruba na pocetku, na kraju ili na po€etku i kraju, u kojim
jedinicama ¢&e biti ravnalo (px, mm, cm, in...) itd. Putanju je moguce
svinuti, a samim time i ravnalo koje se nalazi na toj putanji kao Sto je i
prikazano na donjoj slici.
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Efekt Knot pretvara bilo koju putanju u évor. To se radi na taj nacin da
se na svakoj to¢ki gdje se putanje isprepli¢u stvara razmak i pojavljuje
tzv. prekidac. Prekidac je vidljiv kada je aktivan alat Node Tool, a sastoji
se od kruzne strelice centrirane oko tocke prijelaza. Klikom na
,<dijamant®, ¢vor na tocci prijelaza se mijenja u tri stanja. Na donjoj slici
mogu se vidjeti sva tri stanja prekidaca.

SN /D\ /Q
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4.4. Vjezba: lzrada vizuala

1. Otvorite novi dokument formata A4 i izradite vizual kao na
slici iza posljednjeg zadataka.

2. Zaizradu Skara najprije izradite jednu stranu koju Cete
kasnije duplicirati, zrcalno okrenuti i spojiti u oblik Skare.

boja za sve objekte u ovom zadatku je ffcc00ff u
heksadecimalnom obliku,

nacrtajte pravokutnik Sirine 100 mm i visine 10 mm te
ga pretvorite u putanju (Path > Object to Path). Pomocu
alata Node napravite dva zaobljenja ruba i to tako da
gornju stranu zaoblite s lijeve strane, a donju s desne kao
Sto je prikazano na donjoj slici ovoga zadatka,

nacrtajte jos jedan maniji pravokutnik Sirine 50 mm i
visine 5 mm te ga zalijepite na prethodni objekt,

nacrtajte elipsu Sirine 45 mm, visine 30 mm, Sirine
obruba 5 mm i zalijepite ju na prethodne objekte tako da
dobijete tri spojena objekta kao na donjoj slici,

nakon $to ste uspjedno odradili gornji dio zadatka,
potrebno je sve objekte selektirati i grupirati (Object >
Group). Kada su grupirani, potrebno je grupu duplicirati
(Edit > Duplicate) i vertikalno zrcaliti (Object - Flip
Vertical), tako da se dobiju dva dijela Skara,

na kraju je potrebno svaki objekt rotirati za 20 stupnjeva i
na sredini spojiti tako da tvore oblik Skara.

3. Zaizradu ikone lista:

nacrtajte pravokutnik Sirine 160 mm i visine 210 mm,
koji ima crni obrub debljine 2 mm, bez ispune,

u gornjem desnom kutu, prvo napravite kvadrat Sirine i
visine 45 mm te ga namjestite tako da mu se samo lijeva
i donja stranica dodiruju s donjim objektom, kao $to je
prikazano na donjoj slici

oznacite gornji kvadrat, drzite tipku [Shift] i oznacite i donji
pravokutnik. Nakon toga odaberite naredbu Path - Cut
Path koja ¢e odrezati na tom mjestu obrub donjega
pravokutnika,

oznacite odrezani gornji desni kut pravokutnika i rotirajte
ga za 180 stupnjeva te pomocu alata Pen spojite rubove
tako da Cine trokut (za ljepsi spoj linija, potrebno je
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odabrati na kartici Stroke style, pod opcijom Join,
naredbu Round join i pod opcijom Cap, naredbu Round
cap).
Priblizno na sredini stranice, pomoc¢u alata Pen nacrtajte liniju
od desnog do lijevog ruba ikone lista i na kartici Stroke style,
izbornika Fill and Stroke promijenite oblik u isprekidanu liniju
(opcija Dashes) debljine 0,8 mm.
Postavljanje nacrtanih Skara u marker:
- duplicirajte Skare te jedne od njih proporcionalno
smanjite na $irinu 9 mm i visinu 5 mm,
- smanjene Skare postavite da budu marker, tako

da ih oznadite i odaberete naredbu Object >
Objects to Marker.

Na isprekidanoj liniji dodajte 3 évora alatom Node, opcijom
Insert new nodes into selected segments, u dodatnim
opcijama alata.

Na isprekidanu liniju dodajte po&etni, sredniji i zavrdni marker
nacrtanih Skara u izborniku Fill and Stroke, na kartici Stroke
style > Markers.

Spremite crtez pod nazivom lzrezivanje.svg.

58
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5. Precrtavanje slika i dodatna dorada

grafike

Po zavrSetku ovoga poglavija moci cete:

e precrtati sliku u vektore

e preurediti sliku koristedi filtre.

5.1. Precrtavanje slika

Inkscape ima mogucnost konvertiranja rasterskih slika u krivulje, tj.
elemente. Taj se postupak naziva precrtavanje ili tracing (vektorizacija).
Precrtavanje slika nije nimalo lagan zadatak i moze proc¢i dosta
vremena, pokusaja i promasaja do nekoga iskoristivog crteza u

vektorskome formatu.

Za precrtavanje neke slike potrebno je prvo uvesti sliku koja se Zeli
precrtati u Inkscape. Nakon toga se otvara dijaloski okvir Trace Bitmap
koji se nalazi na izborniku Path, a do kojega se moze dodi i preko
tipkovnoga prec€aca [Shift] + [Alt] + [B]. Na dolje prikazanoj slici moze se
vidjeti dijaloski okvir Trace Bitmap s resetiranim postavkama.

@ Trace Bitmap - Karlovac_znak.png

@ Trace Bitmap
Singlescan  Multicolor  Pixel art
Detection mode:

Brightness cutoff
Threshold —

Invert image

Details:

+| Speckles
+ Smooth corners  ee—

+/| Optimize

User-assisted trace

Preview:

X

~

Karlovac p|

i 500 m

1.0 — 4

0.200 — 4

+/ Live updates

Update preview

Apply

Dijaloski okvir sastoji se od tri kartice, na prvoj kartici Single scan
odabire se nacin precrtavanja slike, na drugoj i tre€oj kartici Multicolor i
Pixel art moguce je podesiti razne dodatne moguénosti.

Na desnoj strani nalazi se prozor za pretpregled u kojemu je moguce na
brz nacin vidjeti kako Ce izgledati konacan rezultat. Opcija Update
Preview sluZi za pretpregled kona¢noga rezultata ovisno o odabranim
opcijama, a dugme Update Preview sluZi za osvjeZavanje prikaza u
pretpregledu suklju¢enom opcijom Live updates.

Svakoj slici treba pristupiti individualno i isprobati mogucnosti koje ¢e
dati najbolji rezultat za upravo tu sliku. Prvo je potrebno odabrati, tj.
selektirati Zzeljenu sliku koja se zeli pretvoriti u vektorski crtez. Nakon
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odabira Zeljenih opcija potrebno je pritisnuti na dugme Apply kako bi se
kreirao vektorski crtez iz slike.

Po zavrSetku precrtavanja, izradena vektorska slika je postavljena na
isto mjesto kao i izvorna slika, odnosno na njezin vrh. Nije potrebno
zatvarati dijaloski okvir da bi se oznacila i odvukla nova vektorska slika
na neko drugo mjesto u dokumentu. Nova slika je obi¢no grupirana i
sastavljena od viSe elemenata pa je prvi korak razgrupiranje slike
(Object > Ungroup). Ako nova slika i dalje ostaje u jednome komadu i
nije mogucée dohvatiti svaki element posebno, potrebno je sliku rastaviti
pomocu druge naredbe, Path - Break Apart. Nakon ove naredbe slika
se rastavila na zasebne elemente koje je potrebno urediti, postaviti
Zeljenu boju na njih, veli€inu i drugo.

Na lijevoj strani donje slike prikazan je izvorni prometni znak, u PNG
formatu. Nakon uvoza te slike u Inkscape i precrtavanjem slike pomocu
naredbe Trace Bitmap, izradena je slika u vektorskome formatu kojoj je
moguce promijeniti svaki element poput boje ili veli€ine slova, boje
strelice, pozadine i mnoge druge stvari (kao $to je vidljivo na desnoj
strani donje slike). Za dobivanje konacne slike u vektorskome formatu
koristila se opcija Colors (Detection mode) na kartici Multicolor. Pod
opcijom Scans odaberemo broj 2 te uklju¢imo opcije Smooth i Stack.
Kako bismo dobili okvir sa zaobljenim rubovima, koristeci opciju
oznacavanja (Seletor Tool) drze¢i dugme Alt ozna¢imo dva pravokutnika
sa zaobljenim rubovima (prethodno odznacivsi pozadinski pravokutnik) i
upotrijebimo naredbu Path — Combine.

Nakon razgrupiranja elementi su se obqjili u proizvoljne boje koje su
prikazane na donjoj desnoj slici.

Karlovac Karlovac
500 m z 500 m z
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5.2. Uporaba filtara

Filtri omogucuju promjenu elementa dodavanjem neke odredene
teksture na ispunu elementa ili njegov obrub. Tako se moze postaviti
zamucenje na neki element, sjena, modifikacija boje elementa, tekstura i
drugo. Inkscape nudi viSe od stotinu ve¢ unaprijed pripremljenih filtara
koji se mogu primijeniti na element preko izbornika Filters. Mnogi filtri
imaju jo§ dodatni dijaloski okvir u kojemu se mogu podesiti razni
parametri prije primjene.

S tolikom koli¢inom unaprijed pripremljenih filtra, traZzenje ispravnoga
nije lako, ali su od velike pomoci kategorije koje omogucuju lakse
snalazenje.

Za primjenu nekoga filtra na odredeni element, potrebno je prvo oznaditi
Zeljeni element i nakon toga odabrati Zeljeni filtar.

Na donjoj slici prikazan je poCetni crtez na koji ¢e se primijeniti razni filtri.

@ Inkscape g

Jedan zanimljiv filtar naziva Fat Oil nalazi se odmah u prvoj skupini
Filters &> Bevels na izborniku. Uporabom ovoga filtra, elementi ¢e
izgledati kao da su sacinjeni od masnoga ulja (kao na donjoj slici).

Inkscagpe *ﬁg

Za poniStavanje bilo kojega filtra primijenjenoga na element, potrebno je
oznaciti element koji na sebi ima neki filtar i odabrati naredbu Filters >
Remove Filters. Nakon toga, element se vraca u svoje izvorno stanje.

Ako se Zeli zamutiti neki element, moguce je u izborniku Filters > Blurs
odabrati jednu od viSe naredbi za zamucéenje, a neke od njih imaju
dodatan dijaloski okvir u kojemu je mogucée podeSavati dodatne
parametre zamucenja. Odabirom naredbe Blur otvara se dijaloSki okvir
prikazan na donjoj slici u kojemu je moguce podesiti okomito i
vodoravno zamucenje, a ako se oznaci kvacicom opcija Live preview,
sve promjene se vide u realnome vremenu.

@ EBlur e
niorizontal blur R
'dertical blur 200 —+

Blur content only

Live preview

Close Apply
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Nakon $to se podese opcije na zeljene vrijednosti potrebno je pritisnuti
dugme Apply za primjenu te naredbe na oznacene elemente. Na donjoj
slici prikazani su elementi nakon koriStenja naredbe Blur.

&) Inkscape %
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5.3. Vjezba: Redizajn logotipa

1. lzradite redizajn logotipa u vektorskome obliku koji ¢e
izgledati kao na donjoj slici. Sadasnja verzija logotipa
postoji samo kao slika, Logotip.png.

Izradite novu stranicu dimenzije 2200 x 1600 px.

3. Uvezite sliku Logotip.png te ju precrtajte pomocu
naredbe Trace Bitmap.

4. Potrebno je obrisati tekst ,Designed by Mia.Designs -
Freepik.com® s logotipa.

5. U redizajnu se koriste tri nove boje:

- Plava ima heksadecimalni kdd boje
007eacff

- Svijetlo naran€asta ima heksadecimalni
kdd boje ffb380ff

- Siva ima heksadecimalni kéd boje
8c8c8cff

6. Spremite logotip pod nazivom Logotip_konacan.pdf

MEN &

CLOTHES WE WEAR
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6. Upoznavanje radnoga prostora
programa GIMP

Po zavrSetku ovoga poglavija moci cete:
e instalirati i pokrenuti program GIMP
e prepoznati dijelove sucelja programa
e podesiti parametre pri stvaranju novoga dokumenta

e otvoriti postojecu datoteku te pregledati i objasniti njena
svojstva
e zumirati, koristiti ravnalo i pomicne linije

o prilagoditi suéelje vlastitim potrebama.

6.1. Pokretanje i upoznavanje sucelja GIMP-a

6.1.1. Sustavi na kojima je dostupan GIMP i instalacija
programa

GIMP je najpopularnija besplatna aplikacija otvorenoga kéda za
stvaranje i obradu rasterske grafike. Koristi se za retuSiranje, crtanje,
uredivanje slika, pretvaranje slika u razliCite formate te za jo$ niz korisnih
amaterskih i profesionalnih zadataka.

GIMP je dostupan za korisnike operacijskih sustava Windows, Mac i
GNU/Linux.

Proces instalacije programa GIMP na sustavima Windows prili€no je
jednostavan.

Potrebno je preuzeti instalacijsku datoteku programa sa stranice
http://www.gimp.org/downloads/. Najlak$e je preuzeti instalacijsku
datoteku odabirom bilo kojeg od dva dolje navedenih linkova.

Download GIMP 3.0.2

via BifTorrent

Nakon odabira, potrebno je instalacijsku datoteku.exe spremiti na
racunalo i pokrenuti. Proces same instalacije slijed je nekoliko osnovnih
opcija koje je potrebno procitati i odabrati one koje odgovaraju
zahtjevima (primjerice odabir jezika).

6.1.2. Pokretanje GIMP-a

Za pokretanje programa u sustavu Windows, odabere se Start > Svi
programi - GIMP. Prilikom prvog pokretanja program ¢e se sporije
otvarati jer podeSava razne opcije, ali ve¢ drugi i svaki sljedeci put
pokretanje ¢e biti puno brze.

Trajanje
poglavija:

45 min

Zanimljivosti i napomene

Najpoznatiji sustavi za koje
je dostupan program GIMP:
Windows 8, Windows 7,
Windows Vista, Windows
XP, Snow Leopard 10.6X,
Leopard 10.5X, Tiger
10.4X, Debian, Fedora,
Gentoo Portage, Slackware,
OpenSUSE, Ubuntu...
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Za pokretanje na sustavima Mac, potrebno je odabrati mapu
Applications te potom GIMP.

Za pokretanje GIMP-a na Linux sustavima, klikne se na Applications >
Graphics > GIMP.

6.1.3. Upoznavanje sa suceljem

Kada se pokrene GIMP otvaraju se tri prozora, od ¢ega su lijevi i desni
namijenjeni raznim alatima, dok se u srediSnjem, radnom prozoru,
ureduje slika i pristupa izbornicima.

Osim navedenog nacina rada, postoji i drugi nacin, tzv. Single-Window
Mode, koji omogucéava rad u samo jednom prozoru, $to znaci da se tri
prethodna prozora spajaju u jedan veliki prozor. Za promjenu prikaza iz
tri odvojena prozora u jedan veliki prozor, odabere se u srediSnjem
prozoru izbornik Windows - Single-Window Mode. Ovakav nacin rada
karakteristiCan je i za druge grafiCke alate te je puno prakti¢niji od
uporabe zasebnih prozora. Prozori su ujedno i prilagodljive veli€ine, §to
znaci da se mogu uhvatiti za rub i povecati ili smanijiti, ovisno o potrebi.

1. Toolbox (Kutija s alatima) — prozor koji se nalazi s lijeve strane,
podijeljen na dva dijela. U gornjoj polovici Toolboxa nalaze se
alati kojima se obavljaju razli¢ite radnje u programu, a u donjoj
polovici opcije vezane za trenutno odabrani alat.

2. Sredisnji prozor je radni prozor i u hjemu se odvijaju sve radnje
na otvorenoj slici.
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3. Desni prozor sluzi za organiziranje slojeva (engl. Layers),
povijesti (engl. History), palete boja (engl. Color pallete) te sadrzi
razne dodatne opcije koje se ne nalaze u Toolboxu.

6.2. lzZrada novog dokumenta

Prije poCetka rada u GIMP-u vazno je znati kako izraditi i otvoriti neku
sliku. Prazna slika koristi se kada se zeli crtati i bojati, a poCetnicima je
korisna za istrazivanje novih alata i svih moguc¢nosti koje nudi Toolbox.

6.2.1. Otvaranje prazne slike

Ako se zeli otvoriti prazna slika, odabere se izbornik File > New nakon
kojeg se otvara prozor Create a New Image.

«d Create a New Image X
Template: v
Image Size

Width: | 1024 -+

Height: | 768 - + px ~

E | = 1024 x 768 pixels
300 ppi, RGB color

» Advanced Options

Help Reset OK Cancel

U ovom izborniku moZe se odabrati veli¢ina prazne slike koja je u gore
navedenom sluc¢aju 1024 x 768 px (piksela). Veli€ina se moze upisati
ruéno, gdje se posebno upisuje Sirina i posebno visina ili se moze
odabrati pomocu okretnog dugmeta.

Osim veli€ine slike, pritiskom na oznaku jedinice odabire se i jedinica
koja se zeli koristiti, a koja ovisi o0 namjeni slike na kojoj se radi. Tako se
mogu odabrati pikseli, in€i, milimetri, centimetri, metri ili neke druge od
ponudenih jedinica. Nakon odabira jedinice, odabire se okomito ili
vodoravno usmjerenje slike.
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«isf Create a New Image X
Template: >
Image Size
Width: 1024 - +
Height: 768 - 1 | pixels v
[§ | [ 1024 x 768 jnches
300 ppi, RGB
millimeters
¥ Advanced Options
points
Help Rese picas Cancel
| centimeters |
meters
feet
yards

typogr. points
typogr. picas

Kada se zavr$i s osnovnim podeSavanjima nove slike, moguce je
odabrati i napredne opcije pritiskom na naredbu Advanced Options ili
na oznaku ,+“ nakon ¢ega se otvara dodatni izbornik.

& Create a New Image X
Template: et
Image Size
Width: 1024 wic|
Height: 768 - + | px T
¥ [ 1024 x 768 pixels
T2 ppi, RGE color

* Advanced Options

X resolution: 72,000 -+ |1

¥ resolution: 72,000 = || i’ pixels/in =~
Color space: RGB color .
Precision: 8-bit integer >
Gamma: Non-Linear v
Color profile: Built-in RGB (GIMP built-in sRGB) ~
Soft-proofing color profile: MNone -

Help Reset oK Cancel

U dodatnom izborniku moze se odabrati X i Y rezolucija slike, koja za
tisak mora biti minimalno 300 ppi (pixels per inch). U gore navedenom
primjeru je 72 ppi.

U izborniku Color space odabrano je RGB color, $to znaci da ¢e novi
radni prostor biti u boji, to¢nije u RGB modelu boja (vise 0 modelima
boja u poglavlju 2.3. Priprema slike za tisak i web, str. 19). Nudi se jo$
opcija Grayscale, odabirom koje radni prostor postaje crno-bijeli.

Izbornik Precision nije postojao u starijim verzijama GIMP-a, a sada,
pomocu ove moguénosti, moze se raditi s mnogo vise informacija o boji i
detaljima na slikama, $to znaci da ova podrska daje moguénost
stvaranja super glatkih prijelaza boja na slici.
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U izborniku Gamma moguce je odabrati izmedu dva ugradena ICC
profila koji se automatski dodjeljuju slici, dok se u izborniku Color
profile moze dodijeliti novi ICC profil na sliku koji je prethodno spremljen
na ra¢unalu.

Jos jedna priliéno vazna opcija u dodatnom izborniku je i izbornik Fill
with gdje se odabire kakva ¢e biti pozadina slike, u boiji ili prozirna.

U komentar se mogu napisati neki op¢i podaci o slici, ali za stvaranje
slike to nije nuzno.

Nakon podes$enih svih postavki, odabere se dugme OK.

6.2.2. Otvaranje fotografije ili slike

Osim stvaranju nove slike, program GIMP namijenjen je i obradi neke
postojece slike ili fotografije. Otvaranje se radi, kao i kod vecine drugih
programa, odabirom izbornika File > Open.

«id GNU Image Manipulation Program

File Edit Select View Image Layer Colors Tools Filters Windows Help
New... Ctrl+N

Create 4
Open... Ctrl+0
Open as Layers... Ctrl+Alt+0

Open Location...

Open Recent 4

Pojavljuje se skocni prozor Open Image u kojem se prikazuje struktura
mapa i podmapa na ra¢unalu. Kada se pronade Zeljena fotografija ili
slika, odabere se i pritisne dugme Open.

] Open bmage o
© Recent 4 Sditipkc WDeskiop Polamik  RAOY_datoteks | Primjer *
= Home N . ' Modif
= ook S — T —
% Documents * Bubamasa i $89kB 1 Hetype 117 .‘
B Downlosds * Buketjpg I524K8  IPEGImage a7 ‘
* Djvoka PG 2BMB  IPEG Image a7 L]
= Music
S Dvosacjpg 1.0M8 IPEG Image 17 Balonl PG
ctures n 5 \ :

Hipater PG 958ILE  IPEG Image "7 seivn
= Videos ~ labukaprg BS6E KB PNG Image 17 4000 = $000 pinia
& Tash " KonjJPG 95BTLB  IPEG Image nar AR 1 e

. i dord % ; i
Shovem I Nepotrebai_balonipng ISTERE  PNGImage 17
* Paajpg 15MB  IPEG Image A7
Podsd (D)  Plarinajpg 16MB  IPEG Image 117
 PlicalPG 41068  JPEG Image a7
+ Other Locations Prica_u letu joog ISMB  IPEG Image nar
* Rezoluciajpg 1IMB  JPEG image 17
Slojeviisct 165768 xel Hletype "
" Sumajpg 19M8 IPEG Image "7
= Zwoteajpg SITALE  IPEG Image 1ar
* Zubijpg I65EE  IPEG Image A7

Show All Fles

» Select Fie Type (Automatically Detected)

Help Open Cancel

Nakon toga prikazuje se odabrana fotografija ili slika u srediSnjem,
radnom prostoru.

Zanimljivosti i napomene

Odabranu sliku moguce je
otvoriti i dvostrukim
pritiskom lijeve tipke miSa
na sliku. Mogucée je i
oznaditi viSe slika odjednom
i sve ih otvoriti istovremeno
pritiskom na dugme Open.
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Zanimljivosti i napomene

Priblizavanje ili udaljavanje,
bilo koriStenjem povecala
koje se nalazi u alatima s
lijeve strane ili upisivanjem
postotka na dnu programa,
ne utjee na veliinu slike.
To je samo prikaz slike na
ekranu.

¢ [

" D = 300005 pe = | 20% | = Esknen 221 e [ - @

U programu GIMP moguce je istovremeno otvoriti viSe slika pa se one
nakon otvaranja nalaze svaka u svojoj kartici, kako je i oznaceno
crvenim okvirom na dolje prikazanoj slici. Odabrana kartica razlikuje se
od ostalih po tome $to je izbo&ena kao drugi po redu na dolje prikazanoj
slici.

< [Baloni] (imported)-3.0 (RGB color 8-bit non-linear integer, GIMP built-in sRGB, 1 layer) 4000x6000 — GIMP

File Edit Select View Image_Llayer Colors Tools Filters Windows Help

o=@ S0 ok

o
& o L T ® . 2000, v i v 00D,
WA EABY -

Slika, tj. kartica koja je oznaCena, moze se zatvoriti pritiskom na dugme
x pokraj svake kartice ili preko izbornika File > Close View.

Ako se Zele zatvoriti sve kartice odjednom, a i dalje ostati u programu
GIMP, odabere se naredba File > Close all.

6.3. Pregled informacija o slici

Kada je slika otvorena u GIMP-u, velik broj informacija o samoj slici
prikazuje se u zaglavlju programa, bez potrebe za odabirom neke
posebne naredbe. Informacije koje se odmah nude su:

1. Naziv otvorene slike nalazi se odmah na poc€etku naslovne
trake. U ovom sluCaju naziv slike je Buket.

2. Odmah pored naziva slike nalazi se tzv. Color Mode, koiji je u
ovom slu¢aju RGB.

3. Takoder, jedna korisna informacija je i broj slojeva na slici. Slika
Buket ima 1 sloj.
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4. Dimenzija otvorene slike nalazi se na posljednjem mjestu. Slika
Buket je dimenzije 2592 x 1944 piksela.

°1°

(96

File Edit Select View Image layer Colors Tools Filters Windows Help

Tool Toggle (Shift)
O Pick a layer or guide
Move the selected layers

Mmoo 1,

Sy
vt

e

750 leo,

el B B

oL T R EIM‘O‘:\I‘I i 150 e 500,
A EABY -

B=EA B s 2|

£ ahN@® e a|-

e o« i AT

S AR -

‘?m i om 8 -

Move 7

Move: @ & 0

o [su#eu (imported)-5.0 (RGB coldf 8-bit non-finear nteger, GIMP builin sl\GB‘h ayer) 2592x1944 -,GIMP

s h2so

L1500,y (175000, [2000,

Osim tih osnovnih informacija o slici koje su odmah dostupne i vidljive,
program GIMP nudi i dodatna svojstva o otvorengj slici koja se nalaze
na izborniku Image - Image Properties.

U tom izborniku vidi se kolika je
maksimalna dimenzija slike, ako
se ona ispisuje (Print size).
Takoder je vidljiva i rezolucija
slike (Resolution), koja je u ovom
sluc¢aju 300 x 300 ppi. Minimalna
rezolucija slike za tisak je 300
ppi. Korisne informacije su jos

< Image Properties

@ Image Properties

[Buket] (imported)-5

Properties

Size in pixels:
Print size:
Resolution:

Color space:

Color Profile

X

3]
(6]

Comment

2592 x 1944 pixels

219,46 = 164,59 millimeters
300 = 300 ppi

RGB color: GIMP built-in sRGB

informacije o veligini (File Size) i Precision: 8-bit non-linear integer
formatu slike (Flle Type) File Name: C\Users\dstipi...mjeri\Buket.jpg
File Size: 352,4 kB
Dodatan izbornik Image File Type: JPEG image
Properties zatvara se pritiskom Size in memory: 47.0 M8
CI Undo steps: None
na dugme ose. Redo steps: None
Number of pixels: 5038848
Number of layers: 1
Number of channels: 0
Number of paths: 0
Help Close
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6.3.1. Prilagodba programa

Postavke programa moguce je prilagoditi na vrlo jednostavan nacin,
preko izbornika Edit > Preferences. Otvara se skoCni prozor
Preferences u kojem korisnik moze promijeniti gotovo sve postavke.

U prvom izborniku, Environment, postoji moguc¢nost promijene
minimalnoga broja poniStavanja, tj. Povijesti preko opcije Minimal
number of undo levels. Tu opciju najbolje je postaviti na 30 ili vise. Ispod
te opcije nalazi se opcija Maximum undo memory koju se takoder
preporucuje postaviti na vise od 150 MB. Na dolje prikazano;j slici te
dvije opcije oznacene su crvenim okvirom.

Ako se Zeli promijeniti zadana postavka veli€ine prazne slike prilikom
njenog stvaranja, odabere se izbornik Default Image. Ovaj izbornik jako
sliCi izborniku koji se pojavljuje kada se stvara nova slika, a upravo je i to
cilj, da se postave nove zadane postavke za veli€inu slike, rezoluciju,
boju pozadine itd.

Kada se &esto koristi neka opcija ili alat u GIMP-u, radi ustede vremena
koriste se tipkovni precaci, bilo za odabir nekog alata ili neke akcije.
Tako je, primjerice, za kopiranje odredenog elementa na slici tipkovni
prec€ac [Ctrl]+C, Sto Stedi vrijeme u odnosu na odabir te iste naredbe
preko izbornika Edit >Copy. Upravo takve skracenice za pojedinu
akciju moguce je mijenjati preko izbornika Interface. Potrebno je
pritisnuti na dugme Configure Keyboard Shortcuts nakon kojeg se
pojavljuje sko&ni prozor u kojem je moguce dodijeliti gotovo svim
akcijama u GIMP-u odgovarajuci tipkovni pre€ac, ako ve¢ ne postoji.

& preferences X

H System Resources
u Color Management
T Image Import & Export
Tool Options

= @ Default Image

System Resources

Resource Consumption

Minimal number of undo levels: 5

Default Grid Maximum unde memory: 1014 Megabytes |~
= E Interface Tile cache size: 4155622 : Kilobytes ~
ﬁ_l Theme Maximum new image size: 128 = Megabytes |~
lcon Theme MNumber of threads to use: 4 =
Toolbox Hardware Acceleration
;;;' Dialeg Defaults [] Use OpencL
=
@ Help System Image Thumbnails
7] Display Size of thumbnails: Normal (128:128) v
Window Management Maximum filesize for thumbnailing: |4 > Megabytes
= Image Windows
EI Document History
El Appearance _ X
— Keep record of used files in the Recent Documents list
Title & Status
Snapping

=] ﬁ’] Input Devices

Ll Crmbeallare

Help Reset QK Cancel
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6.4. Uporaba zumiranja, ravnala i pomicne linije

U ovom poglavlju obrazlozit ée se ¢emu sluzi zumiranje u programu,
kako se koristi te ¢e se navesti tipkovni pre€aci koji se mogu koristiti.
Pojasnit ¢e se i uporaba ravnala i pomicne linije koje se koriste za to¢no
poravnavanje elemenata po dokumentu.

6.4.1. Zumiranje

Kada se slika otvara u programu GIMP, prikaz se podeSava tako da
slika stane u slobodan prostor u radnom prozoru. Prilikom rada na slici,
Cesto je potrebno zumirati i vidjeti izgled slike, fotografije na 100 % ili
viSe, a takoder je potrebno i vidjeti kompletnu sliku na ekranu, za Sto se
potrebno udaljiti od originalne veliCine.

Neki od nacina za udaljavanije i priblizavanje slike su:
1. Uporaba alata za zumiranje koji se nalazi u Toolboxu.

2. Odabir dugmeta za prilagodbu slike veli€ini prozora — nalazi se u
gornjem desnom kutu radnog prozora. Tipkovni pre€ac za
uporabu ove naredbe je [Shift]+[Ctrl]+J.

3. Odabir ili upis Zeljenog postotka zumiranja s padajuceg izbornika
na dnu radnog prozora te potvrda tipkom [Enter].
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Jos jedan nacin zumiranja slike je pritisak miSem na sliku u radnom
prostoru, nakon ¢ega se pritisne i drzi tipka [Ctrl] te se kotaCicem misa
priblizava ili udaljava slika.

Najlaksi nacin za zumiranje slike je odabir brojeva na tipkovnici:
1 =100 %, 2 = 200 %, 3 =300 %, itd. Osim tih preCaca, korisne su jos i
tipke [+] za priblizavanje i [-] za udaljavanje.

Zumirati se moze i preko izbornika View > Zoom.

6.4.2. Ravnala

Ravnala su korisna za:
e odredivanje to¢ne lokacije miSa na slici
e kreiranje pomicnih linija prema odredenoj lokaciji miSa na ravnalu
e kreiranje Sample Pointsa koji se stvaraju tako da se drzi
pritisnuta tipka [Ctrl] i pomicu pomi&ne linije.

Ravnala se prikazuju samo kada se otvori neka slika ili kada se stvori
nova slika, tj. samo kada se nesto nalazi u radnom prozoru. Smjestena
su na gornjoj i na lijevoj strani slike u radnom prozoru.

« [Buket] (imported)-5.0 (RGB color 8-bit non-linear integer, GIMP built-in sSRGB, 1 layer) 2592x1944 — GIMP
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Ravnala se mogu prikazati ili sakriti na izborniku View - Show Rulers
ili pomocu tipkovnog pre€aca [Shift]+[Ctrl]+[R].

U podnozju dokumenta moze se promijeniti mjerna jedinica za prikaz
ravnala te vidjeti joS neke dodatne informacije:

1. Dva broja odvojena zarezom prikazuju koordinate miSa na
otvorenoj slici. Gornji lijevi kut slike su koordinate ,0, 0“ dok su
donji desni kut koordinate ukupne veli€ine slike. Kako se pomice
mi$ po slici, tako se i mijenjaju brojevi te se moze iScCitati toCna
koordinata. Jedinica u kojoj se prikazuju koordinate jednaka je
jedinici u kojoj se prikazuje ravnalo.

2. Zadana vrijednost ravnala je u pikselima (skracenica ,px“), a ako
se Zeli prikaz ravnala promijeniti u neku drugu jedinicu, odabere
se padajuci izbornik i iz njega Zeljena jedinica.
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

3. Osim u zaglavlju, ime otvorene slike nalazi se i u radnom
prozoru, dok se u zagradi pokraj imena nalazi informacija o tome
koliko sistemske memorije ta slika zauzima.

g [Buket] (imported)-5.0 (RGB color B-bit non-linear integer, GIMP built-in SRGB, 1 layer) 2592x1944 - GIMP
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6.4.3. Pomicne linije

©

Pomicne linije ili Guides su linije koje se mogu pomicati i postaviti
vodoravno ili okomito preko otvorene slike u radnom prozoru. Sluze za
toéno poravnavanje objekata na slici.

Pomicna linija postavlja se tako da se miSem dode do ravnala, bilo
okomitog ili vodoravnog, pritisne i drzi lijeva tipka miSa te se miSem
pomice na Zeljenu poziciju. Nakon uspjesno izvedene akcije, prikazat ¢e
se linija na slici u radnom prozoru. Linija se moze i dalje pomicati kada je
u radnom prostoru, a kada viSe nije potrebna, odabere se alat Move
Tool (koji se nalazi na izborniku Tools > Transform Tools > Move) i
miSem se odvuce natrag na ravnalo.

Pomicne linije su plave isprekidane linije, dok je oznaéena pomicna linija
prikazana crvenom bojom, kako je oznaceno crvenim okvirom dolje na
slici.
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Osim dodavanja pomicnih linija miSem, moguce je i preko izbornika
pozicionirati pomi¢nu liniju na to¢no odredeno mjesto na slici, vodoravno
ili okomito. Odabere se naredba na izborniku Image > Guides > New
Guide. U novootvorenom sko&nom prozoru odabere se smijer,
vodoravan ili okomit te vrijednost na koju se Zeli postaviti pomicna linija.
Nakon odabira, pritisne se dugme OK.

U izborniku Image > Guides moze se jo$ dodati pomicna linija po
postotku, moze se postaviti ovisno od selekcije i mogu se obrisati sve

pomiéne linije od jednom odabirom naredbe Remove All Guides u
Zanimljivosti i napomene izborniku Image > Guides.

Skocni prozor New Guide
obiéno se otvara u pozadini, “ New Guide X
tj. iza glavnog prozora

programa pa ga je potrebno
odabrati s programske Direction Horizontal b
trake.

Position 160 - +|

Save Settings

Help OK Reset v Cancel

6.5. Vjezba: Upoznavanje radnog prostora

1. Stvorite novu sliku dimenzije 1000 x 700 px, 300 ppi X i Y rezolucije,
prozirne pozadine.

2. Spremite sliku pod nazivom Prozirna_pozadina.xcf sa svim
ponudenim opcijama.

3. Stvorite novu sliku dimenzije 700 x 800 px, 150 ppi X i Y rezolucije,
bijele pozadine.

Novootvorenu sliku bijele pozadine zumirajte na 70 %.
Postavite pomicne linije na 200 px i 400 px vodoravno.

Postavite okomite pomicne linije na 70 % i 80 % slike.

R L

Provjerite komentar na slici i koliko slika ima ukupno piksela.

Ukupan broj piksela:

8. Zatvorite sliku Prozirna_pozadina.xcf.
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7. Rad s rasterskom grafikom -

Po zavrsetku ovoga poglavija moci Cete: Trajanje
e navesti najvaznije formate slika i objasniti njihove razlike poglavlja:
e (definirati pojam rezolucije 55 min

e podesiti rezoluciju slike

e jzabrati odgovarajucu rezoluciju slike za objavu na web-
stranicama i za tiskanje

e jzvestii spremiti gotov uradak.

Digitalne slike pojavljuju se u reklamama, novinama, na Internetu,
televiziji i dr. Relativno niska cijena digitalne slike potaknula je mnoge
ljude da istrazuju svoju kreativnost kroz razne programe za obradu slika.
GIMP nudi mogucénost odabira veli€ine slike, oblika, kontrolu ekspozicije,
omogucuje dodavanije teksta, slike na sliku, dijelove slika na neku sliku i
drugo. To se naziva obrada rasterske grafike jer je slika na zaslonu
sacinjena od niza tockica rasporedenih u kvadratnu mrezu, a te tockice
nazivaju se pikselima. Kvadratna mreza naziva se raster pa od tuda
naziv rasterska grafika.

Osim rasterske grafike postoji i vektorska grafika kod koje se za opis
slike upotrebljavaju matematicke formule, tj. uz pomoc¢ Bézierove krivulje
i geometrijskih oblika stvaraju se slike. Tako se primjerice za nacrtanu
neku duZinu upotrebljavaju koordinate njezinih krajnjih toCaka pa je ta
duzina odredena kao skup koordinata i linija, a upravo to Cuva kvalitetu
slike pri promjeni veliCine. Tako je vektorsku grafiku moguce povecéavati i
smanjivati bez gubitka kvalitete, a to je €ini idealnom za logotipe,
geografske karte i druge objekte kojima je Eesto potrebno mijenjati
veli¢inu. Upravo zbog takvog, ,matemati¢kog“ nacina pohranjivanja
informacija o slici, vektorska grafika zauzima bitno manje prostora od
rasterske grafike.

7.1. Znacajke pojedinog formata za slike

Odabir pravilnog formata slike jako je vazan jer se na taj nacin osigurava
ispravan prikaz slike u najboljoj mogucoj kvaliteti. GIMP radi s velikim
brojem razlicitih slikovnih formata, a za pocetnike je najbolje spremati
slike u XCF formatu, koji je ujedno i GIMP-ov izvorni format. Ako se Zeli
slika prikazati u nekom drugom formatu, vidljivom na ostalim racunalima,
moze s izvesti u neki od poznatih formata kao sto su JPG, PNG, TIFF...

@ srce 7



Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Format JPG

Skracéenica JPEG (JPG) je kratica engl. Joint Photographic Experts
Group, §to je naziv udruge koja je donijela normu za taj format zapisa.

Format koristi sazimanje podataka uz gubitak kvalitete slike. Moze
sadrzavati slike koje imaju od 2 do 16 milijuna boja (ili nijansi sive boje).
Prvenstveno se koristi za pohranjivanje fotografija, riede za
pohranjivanje crteza ili slika s relativno malo boja.

Najveca prednost formata u odnosu na druge formate je u bitno manjem
zauzecu memorije.

Nedostatak ovog formata su dosta izrazene nepravilnosti slike, posebno
rubne nepravilnosti i Sum, koje se na Stetu ostrine slike tj. bogatstva
nijansi i finih detalja mogu umanijiti zamucivanjem ili primjenom raznih
filtara.

JPG je vrlo popularan format i koristi se za spremanje slika u vecini
fotoaparata, mobitela, tableta i drugih uredaja.

Preporuca se izrada kopija JPG slike prije poCetka obrade u programu
jer se svakim spremanjem slike gubi na kvaliteti slike i taj gubitak je
trajan.

Format JPG prikladan je za koriStenje na Internetu jer ima moguénost
znatnog smanjivanja veli€ine slike, a manje slike €ine web-stranice
brzima za ucitavanje.

To je format koji ne podrzava prozirnost i animaciju, ali je prikladan za
arhiviranje.

Format GIF

GIF (engl. Graphic Interchange Format) je 8-bitni graficki format koji
koristi paletu od maksimalno 256 boja te se zbog toga najcesc¢e koristi
na webu. Pretvaranjem izvornih bitmapa (BMP, JPG, TIFF, PNG idr.) u
GIF drasti¢no se smanjuje broj nijansi kojima se interpretira sadrzaj, sto
rezultira stepenicastim prijelazima pri pretapanju boja i gubitkom finijih
detalja, a najéesce i prejakim kontrastom boja.

Iz navedenih razloga GIF je prikladniji za razne dijagrame i slicne
grafiCke sadrzaje nego za fotografije.

Format PNG

PNG (engl. Portable Network Graphics) je otvoreni graficki format
namijenjen pohrani ili streamingu nepokretnih slika bez gubitaka, a
nastao je kao zamjena za GIF.

Sazimanje podataka bez gubitaka naziv je za proces uklanjanja zalihosti
bez gubitaka informacija. Za razliku od sazimanja podataka s gubitcima,

kod postupka saZimanja bez gubitaka dobiva se slika €iji je prikaz
jednako vrijedan izvornom.
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To znaci da su postupci koji spadaju u ovu kategoriju reverzibilni,
odnosno svakome pripada odreden obratan postupak, koji iz sazete
poruke moZe ponovno stvoriti izvornu.

PNG format je zamisljen kao grafi¢ki format za razmjenu preko
Interneta, tako da ne koristi neke druge sheme boja (kao sto je CMYK).

PNG datoteke u pravilu uvijek imaju ekstenziju PNG ili png.

Format PSD

GIMP moze otvarati i spremati izvornu datoteku programa Photoshop —
PSD (Photoshop document). U GIMP-u je moguce uredivati svaki sloj
posebno, spremiti datoteku kao PSD i nakon toga je otvoriti u
Photoshopu.

Datoteke PSD otvorene u GIMP-u koje imaju posebna podeSavanja po
slojevima napravljena u Photoshopu, neée se dobro prikazivati u
GIMP-u.

Datoteke PSD koje su izradene u GIMP-u mogu se bez ikakvih
problema otvoriti i uredivati u Photoshopu.

Format RAW

Format RAW je format zapisa slikovnih datoteka u kojemu nema gubitka
informacija, odnosno, to je izvorni oblik slikovne datoteke dobiven
snimanjem nekog motiva. RAW zapis sadrzi sve informacije koje
prilikom fotografiranja aparat zabiljezi bez ikakvih obrada odnosno
kompresije. Slikovna datoteka u RAW formatu sadrzi minimalno
obradene podatke iz senzora digitalnog fotoaparata, skenera ili film
skenera.

RAW format pokazao se kao idealan format u odnosu na druge formate
jer pruza mogucnost da se proces generiranja fotografije u potpunosti
preseli iz fotoaparata na raCunalo. S druge strane, s obzirom na
koli¢inu informacija koje sprema, RAW zapis je znatno veci od ostalih
formata, ¢ak i do nekoliko desetaka megabaijta, Sto ga €ini nezgodnim za
spremanije, slanje i sli¢no.

Jednom kad se datoteka RAW otvori u GIMP-u, ne mozZe se ponovno
spremiti u formatu RAW, nego se moZe izvesti kao JPG ako je potrebna
slabija kvaliteta ili TIFF, ako se slika priprema za ispis.

Format TIFF

TIFF (Tagged Image File Format) je format za pohranu slikovnih
datoteka, iznimno popularan format medu grafiCarima, izdavackoj
industriji te amaterskim i profesionalnim fotografima. Format je objavljen
1986., a od 2009. godine njime upravlja tvrtka ,Adobe Systems*.

Zanimljivosti i napomene

U GIMP-u se za korisnike
Mac raéunala RAW
datoteke otvaraju s veé
unaprijed instaliranim
UFRaw dodatkom, dok ¢e
korisnici Windowsa morati
instalirati dodatak za GIMP
pod nazivom UFRaw ili
pretvoriti Raw datoteku u
TIFF.
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Zanimljivosti i napomene

Za pocCetnike se
preporucuje spremanije slika
u XCF format tako da se
kasnije, prilikom ponovnog
otvaranja, mogu vidjeti svi
podaci o slici.

Format TIFF je Siroko podrzan u aplikacijama za obradivanje fotografija,
izgleda stranice, skeniranje, faksiranje, obradu teksta, optickih znakova
za prepoznavanje i drugih aplikacija.

Format podrzava sazimanje podataka bez gubitaka, ali moze
pohranjivati i nesazete podatke. Moze sadrzavati slike koje imaju od 2
do 16777216 boja (ili nijansi sive boje). Samo neki (poluprofesionalni i
profesionalni) fotoaparati mogu snimati direktno u TIFF-u, ali vrijeme
spremanija slike na memorijsku karticu aparata moze se produziti na
desetak sekundi pa i do pola minute.

TIFF je memorijski vrlo zahtjevan slikovni format za profesionalnu
uporabu, postere, izlozbene i Jumbo plakate, tehnicke fotografije s
najfinijim razlaganjem detalja. Odlikuje se manje izrazenim
nepravilnostima slike, koristi se za sve namjene, od pohrane crteza i
jednostavnijih slika, do fotografija gdje izvrsno ocrtava sitne detalje.

Prednost opisanog formata u odnosu na format JPEG je kvaliteta slike.

Format XCF

XCF je GIMP-ov izvorni format. U taj format se spremaju svi podaci koji
su napravljeni na slici kao $to su slojevi, putanje, prozirnost i drugo.
Preporuca se koristenje ovog formata kada se slika ureduje u vise
navrata.

XFC format koristi samo GIMP, no kada se zavrsi s uredivanjem slike,
zavrsni korak je izvoz slike u neki drugi format. RjeSenje za to je
spremanje slika u viSe faza tijekom uredivanja tako da se kasnije moze
vratiti na neku od tih faza ako je potrebno.

7.2. Rezolucija slike

Rezolucija kod digitalne fotografije i grafike je ukupni broj piksela nekog
uredaja ili medija (fotoaparata, monitora, fotografije...) kao i broj piksela
po jedinici povrdine. Broj piksela po jedinici povrSine izraZzava se
“pikselima po in¢u” ili PPI (engl. pixels per inch).

DPI je skracenica od dots per inch (engl.), tj. “broj to€aka po in¢u” i
odnosi se na broj to¢aka po in¢u kod ispisnih uredaja. Da bi se dobila
neka boja, pisa¢ mijesa tinte razlicite boje i za jedan piksel mora ispisati
odredeni broj toCkica. Broj to¢kica ovisi o razlu€ivosti pisaca.

Vedi broj DPI-a ne moze povecati PPI. PPl se odnosi na raspolozive
piksele po in€u koji grade fotografiju, a DPI na to koliko ¢e tockica tinte
pisac ispisati da bi ispisao piksele na jednom in¢u papirne plohe. Manji
broj DPI-a moze zamaskirati nedostatak PPI.
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Vide ukupnih piksela na nekoj slici znacgi vecu rezoluciju slike i samim
time kvalitetniju sliku, a manje piksela manju rezoluciju tj. loSiju sliku.
Kada se ureduje neka slika u GIMP-u, ureduju se zapravo pikseli na toj
slici. Piksel je najmaniji graficki element neke slike koji u sebi sprema
varijaciju svjetline i boje.

™ 5 U programu GIMP rezolucija slike provjerava se
= preko izbornika Image - Image Properties.

7.3. Priprema slike za tisak i web

Priprema slika za web i tisak razlikuje se prvenstveno u kvaliteti same
slike, 8to podrazumijeva rezoluciju slike, broj to¢aka po in€u i modelu
boja. Za tisak je potrebno imati sliku viSe kvalitete u CMYK modelu boja,
dok je za web dovoljna i slika slabije kvalitete u RGB modelu boja.

RGB je skracenica za engleski pojam Red (crvena), Green (zelena),
Blue (plava). RGB je aditivni model boja kod kojeg se sabiranjem
oshovnih boja dobije bijela boja. Jedna boja opisuje se kroz tri
vrijednosti: dio crvene, dio zelene i dio plave boje. Svaki dio boje varira
izmedu 0 % i 100 %, odnosno izmedu 0 i 255.

CMYK je suptraktivan model mijeSanja boja koji se primarno koristi u
tiskarstvu. Skrac¢enica je oznaka boja u engleskom jeziku: cyan (cijan,
tirkizna), magenta (purpurna), yellow, (zuta) i key (crna). lako se
kombinacijom prve tri boje teoretski dobije crna boja, u tiskarstvu se crna
koristi kao zasebna (Cetvrta) boja, radi bolje reprodukcije tamnih boja.

7.3.1. Slike za tisak

Preporu€ena rezolucija slika koridtenih u pripremi za tisak je 300 ppi za
fotografije i 600 ppi za jednobojne ilustracije. Ako se kompletna priprema
radi kao bitmapa (npr. u GIMP-u) potrebno je prije poCetka rada na
pripremi odrediti $to viSu rezoluciju (barem 300 ppi, preporuka 600 ppi
ako priprema ukljucuje vecu koli€inu teksta ili tekst manji od 12 to¢aka).

Sve boje koriStene u pripremi za tisak moraju biti u CMYK-u (fontovi,
slike i vektorski elementi). Boje u dokumentu koje nisu CMYK nego
RGB, bit ¢e konvertirane u CMYK, prilikom ¢ega su moguci manji ili vedi
odmaci u vjernosti reprodukcije boja.

Kada se smanjuje rezolucija slike, treba uzeti u obzir da smanjivanje
rezolucije slike povecéava Sirinu i visinu slike, dok povecavanje rezolucije
slike smanijuje Sirinu i visinu slike. To je bitno zapamtiti jer se prilikom
promijene rezolucije slike mijenja samo broj piksela koji ¢e se prikazivati
po in¢u doti¢ne slike, a ne koliko piksela €ini tu sliku.
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Za promjenu rezolucije slike odabere se Image - Print Size... U
sko¢nom prozoru Set Image Print Resolution moze se mijenjati
rezolucija slike.

4 Set Image Print Resolution X

& Set Image Print Resolution Ex
[Buket] (imported)-2

Print Size

width: | EEER

|
+

I
4=
=
=l
1

Height: 164,59

X resolution: 300,000

|
+

ITI
1]
1 pixelsfin ¥

|
+

Y resolution:; 300,000

Help Reset oK Cancel

Sliku je najbolje snimiti u TIFF formatu, ali moze se odabrati i JPG
format, no tada je potrebno odabrati visoku kvalitetu (u GIMP-u pod
Quality: 90-High ili 100-Maximum).

7.3.2. Slike za web

Slike za web ne trebaju biti vrhunske kvalitete poput slika za tisak pa je
naj¢esca radnja koja se koristi u GIMP-u za prikazivanje slika na webu,
smanjivanje slike na zadovoljavajucu rezoluciju.

Za promjenu rezolucije slike odabere se na izborniku Image naredba
Scale Image. Kao duljinu najdulje stranice preporuca se unijeti 700 px.
To je standardna veli€ina slike za web s obzirom na to da je normalno
vidljiva na ekranu rezolucije 1024 x 768. Nakon unesenih vrijednosti
potrebno je kliknuti na dugme Scale.

¥ Scale Image X

=_Scale Image B

[Buket] (imported)-2
Image Size

Width: 700 - +

BE -

Height: 525 -+
700 x 525 pixels

—_
o
-
4

X resolution: 72,000 - +

pixels/in  ~

— =5

Y resolution: | 72,000 -+

Quality

Interpolation:  Cubic v

Help Reset Scale Cancel
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U nazivima slika ne preporuca se koristiti dijakriticke znakove, ve¢ samo
slova engleske abecede. Takoder, u nazivima se ne preporucuju
razmaci, a ako se naziv slike sastoji od viSe rije€i, povezuje ih se crticom
ili donjom crticom. Nazivi slika mogu sadrzavati velika i mala slova.

7.4. lzvoz i spremanje slika

Nekako je intuitivho da se kod spremanja slike u neki odredeni format
odabere naredba iz izbornika File > Save ili File > Save As..., aliu
grafickim alatima kao $to je GIMP, naredbe Save ili Save As... koriste
se za spremanje u GIMP-ov izvorni format XCF. Nakon §to se odabere
jedna od tih naredaba, upiSe se Zeljeni naziv slike te se pritisne na
dugme Save.

Ako se zeli spremiti slika u nekom drugom formatu, kao sto je JPG,
TIFF, PNG, PSD, GIF PDF, BMP ili neki drugi, potrebno je to uCiniti
preko izbornika File > Export As.

U prozoru Export Image potrebno je upisati naziv slike koja ¢e se
spremiti, odabrati mjesto spremanja i format.

Naziv slike upisuje se u polje Name na vrhu izbornika, oznaeno
crvenim okvirom na donjoj slici.

U sredini izbornika odabire se mjesto spremanja slike. Nakon odabira
Zeljenog mjesta, moguce je i izraditi novu mapu pritiskom na dugme
Create Folder.

Na kraju se odabire format u koji Ce se slika spremiti. Moguce je upisati
direktno format pokraj naziva slike (koji se piSe u obliku
Ime_slike.format_slike) ili pritisnuti na oznaku + koja se nalazi pored
teksta Select File Type (By Extension) za prikaz svih ponudenih formata.

«“d Export Image X

Name: | Buket.png I

Home < Midanst ™ Desktop = Polaznik > (o
Desktop

Downloads

Music

Pictures
Pictures
Folder

Videos

L Local Disk (C:)

Show All Files
v Select File Type (PNG image)

PGM image pgm
Photoshop image psd
image pnm
Portable Document Format pdf
Help Export Cancel

Svi ponudeni formati mogu se pregledati pomocu klizac¢a na desnoj
strani te pritiskom na zeljeni i odabrati. Nakon odabira pritisne se na

Zanimljivosti i napomene

Sliku spremljenu u XCF
format moguce je otvoriti na
drugom ra¢unalu samo ako
i to drugo racunalo ima
instaliran program GIMP.
Ako se slika Zeli otvoriti na
drugom rac¢unalu, potrebno
ju je izvesti u neki drugi
standardni format.
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Zanimljivosti i napomene

Prije poCetka rada na
uredivanju slike u GIMP-u,
preporudljivo je izraditi
kopiju originalne slike.

Ako se ne izradi kopija
originalne slike, moze se
dogoditi sliedece:

ako se napravi neka
greska na slici, unistit
¢e se jedina kopija te
slike

ako se slika umaniji za
prikaz na web-stanici,
moze se dogoditi da
nam ostane samo
primjerak koji je
neupotrebljiv za tisak
zbog veli¢ine i kvalitete

visekratnim
otvaranjem,
uredivanjem i
spremanjem slike u
JPG formatu smanjuje
se razina kvalitete JPG
slike pa je zato uvijek
dobro raditi s TIF ili

XCF datotekom.

dugme Export. Na gornjoj slici odabran je format PNG u dodatnom
otvorenom izborniku za izbor formata slike i oznacen crvenim okvirom.

Ponekad je potrebno smanijiti veliCinu JPG slike na Stetu kvalitete slike.
Kada se na izborniku Export Image odabere format JPG i pritisne na
dugme Export, pojavi se prozor Export Image as JPEG u kojem je
pomocu klizaca, prikazanog crvenim okvirom na donjoj slici, moguce
povecavati ili smanjivati kvalitetu slike od 0 do 100, a samim time i
konacénu veli€inu slike na racunalu. Pravilo je da §to je veca kvaliteta
slike, slika zauzima viSe prostora, a §to je manja kvaliteta, slika zauzima
i manje prostora na racunalu.

[ vt Export Image as PNG X

Pixel format | Automatic v

Interlacing (Adam7)

| Metadata [(edit)

Save IPTC
Save thumbnail

Save Exif Save XMP

Save color profile

Save background color Save layer offset Save resolution

Save creation time

Save comment |

CREATOR: gd-jpeg v1.0 (using G JPEG v80), default quality

I Save Settings

Help Export Reset v Cancel

7.5. Vjezba: Rezolucija

1. Otvorite dva puta istu sliku Ptica_u_letu.jpg, tako da imate
dvije otvorene kartice s istom slikom (File > Open).

2. Na prvoj kartici smanjite neproporcijalno rezoluciju slike
(Image - Scale Image) na 300 x 500 px.

3. Na drugoj kartici smanjite proporcionalno sliku na 1500 x 1000
px i postavite prikaz slike na 100 % (View - Zoom - 100 %).

4. Vratite se opet na prvu karticu i povecaijte sliku na istu
rezoluciju kao i na drugoj kartici, 1500 x 1000 px te postavite
prikaz slike na 100 %.

5. PremjesStajte se iz jedne kartice na drugu i napiSite na kojoj
kartici je slika kvalitetnija.

Kvalitetnija slika je na:

6. lzvezite sliku manje kvalitete pod nazivom Ptica_LQ.png i
sliku vece kvalitete pod nazivom Ptica_HQ.png.
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

8. Osnovni alati za rad s rasterskom
grafikom

Po zavrSetku ovoga poglavija moci cete:
e objasniti ulogu slojeva u obradi slika
e dodati, ukloniti i duplicirati sloj te podesiti prozirnost sloja
e upotrijebiti razli¢ite alate za oznaCavanje dijelova slike

e obrezati sliku, promijeniti joj veliCinu, rotirati je, zrcaliti,
pomaknuti ili skalirati

e upotrijebiti alate za crtanje

e podesiti boje na slici

e dodati tekst na sliku

e preurediti sliku koristeci filtre.

Za uspjesno bavljenje obradom grafike u GIMP-u te obavljanje radniji
poput uklanjanja nepotrebnih dijelova, crtanja novih dijelova, rotiranja
slike, izrezivanja, povecavanja i smanjivanja, potrebno je dobro
poznavati osnovne alate.

8.1. Uporaba slojeva i alata za ozna¢avanje

Za obradu bilo kakve grafike, jednostavnije ili slozene, nuzno je shvatiti
¢emu sluZe slojevi i kako se koriste. Jednako tako, upoznavanje s
alatima kojima se oznacCava neki dio slike da bi se kasnije s oznaCenim
djelom nesto radilo, vazno je kako za poCetnike, tako i za naprednije
korisnike.

8.1.1. Slojevi

Slojevi (engl. layers) sluze za spajanje dvije ili vise slika u jednu. Slojevi
su neke zasebne slike poredane jedna iznad druge, a mogu biti prozirni
tako da se vidi cijela ili samo neki dio slike ispod ili iznad toga sloja.

@ srce ®
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Zanimljivosti i napomene

Dobra je praksa svakom
sloju promijeniti naziv radi
lakSeg snalazenja u kasnijoj
fazi obrade slike kada ima
puno slojeva na jednoj slici.

Na primjeru crteza kuéice moze se vidjeti da su oblik kucice, prozori i
vrata zasebne slike, svaka u svojem sloju. Kada se spoje pravilnim
redoslijedom, dobiva se kompletna kucica. Pravilan redoslijed znaci da
¢e se u zadnjem sloju nalaziti oblik kuc¢e, na sloju iznad prozori te u
prvom sloju vrata. Kada se koriste slojevi, vrlo lako moZe doci do
izmjena slike u bilo kojem segmentu te slike, bez utjecaja na neke druge
dijelove na slici, jer se radi samo na tom odredenom sloju.

8.1.2. Dodavanje novog praznog sloja

Za dodavanje novog praznog sloja na otvorenoj slici potrebno je odabrati
naredbu New Layer... iz izbornika Layer.

<l New Layer X
= Create a New Layer
Slojevixcf-3 =

Layer name: | | Switches
Color tag: ® [ | = @ Visible

A I Lock pixels
Mode: Normal (1) v v

% [ Lock position and size
fl e ® | Lock visibility
Composite space: a | ILock alpha

Composite mode:

Opacity: 1000 -

Width: 800 -+
Height: 600 - +|px ¥
Offset X: 0 -+
Offset Y: 0 - + px -
Fill with: Transparency v
Help OK Cancel

Pojavljuje se skocni prozor New Layer gdje se nudi moguénost upisa
naziva sloja, promjena veli€ine sloja, odabir ispune sloja i jo$ neke druge
opcije koje nisu u ovom trenutku toliko vazne. Nakon zavrSetka pritisne
se na dugme OK.

Novi sloj pojavljuje se u desnom dijelu programa i oznacen je plavom
bojom. Za promjenu imena sloja odabere se dvostrukim klikom lijeve
tipke miSa sloj i upiSe novo ime.
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

5 al

Mode Normal () v <~

e ———r
@ | 0 F£x Q

@ (10 [EBoimnjak
- e

Prozori

DPozadina

G & 1 s B ®

Osim dodavanja novog sloja, u izborniku Layer moguce je i obrisati
oznaceni sloj pomo¢u naredbe Delete Layer, duplicirati sloj naredbom
Duplicate Layer te druge manje vazne naredbe za pocetnike.

Sve najceSc¢e koriStene naredbe vezane za slojeve nalaze se i na
odmah dostupnom desnom izborniku u skupini Layers, oznaCene
crvenim okvirom na gornjoj slici.

Kada se koristi viSe slojeva, mnogo puta je potrebno premjestati slojeve
tj. zamijeniti raspored slojeva. To se radi metodom Povuci i ispusti
(engl. Drag&Drop), to jest odabere se i drzi ljevom tipkom misa sloj koji
se zeli premijestiti i premjesti se na Zeljeno mjesto. Osim navedenog
nacina, moguce je oznaditi sloj i pritisnuti miSem na dugme zelenih
strelica za premjestanje tog sloja gore ili dolje. Strelice se nalaze na dnu
brzog desnog izbornika Layers, takoder oznacenog na gornjoj slici.

Na svakom sloju moguce je promijeniti i prozirnost toga sloja, tj. Opacity
u vrijednosti od 0 do 100, gdje je 0 potpuno prozirno, a 100 potpuno
neprozirno. Vrijednost je moguce upisati, pomicati pomocu kliza¢a ili
promijeniti pomoc¢u okretnog dugmeta. Na gornjoj slici je oznacen
crvenim okvirom sloj Oblak, s Opacity vrijedno3¢u 70.
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

8.1.3. Alati za ozna€avanje

Mnogo korisnika ne zna pravilno Koristiti alate za oznacavanje i tako si
otezavaju rad u GIMP-u. Alati za oznaCavanje nalaze se na vrhu
Toolboxa.

GIMP sadrzi sljedece alate za oznaCavanje u Toolboxu s lijeve strane:

1. Rectangle Select — je koristan alat za ozna¢avanje kvadratnih ili
pravokutnih oblika na slici.

2. Ellipse Select — koristi se ako se Zeli oznaciti neki kruzni oblik
na slici.

3. Free Select ili Lasso — omogucuje oznacavanje nekog
nepravilnog objekta tako da se oznacava lijevom tipkom misa
vanjski rub tog objekta pomocu toCaka. Ako se pogrijeSi, moze
se doci iznad toCke koja je krivo postavljena i pomaknuti je na
Zeljenu poziciju. Selekcija se zavrSava odabirom pocetne tocke.

4. Fuzzy Select ili Magic Wand — jako koristan alat koji oznaCava
samo ono podrucje koje je odabrano tim alatom.

5. Color Select — je koristan alat ako se zZeli oznaciti samo dio slike
izraden bojom koja je odabrana tim alatom.

6. Scissors Select — je odlican i jednostavan alat kojim se moze
odabrati neki objekt, ali za odabir je potrebno samo okvirno
kliknuti miSem oko objekta, a Skare ¢e same pronaci rubove. Za
zavrSetak selekcije, potrebno je odabrati pocetnu tocku.

7. Foreground Select — sluzi za ozna€avanje na slici u dva koraka.
Prvi je odabir Zeljenog djela slike, a drugi je dodatna korekcija.

Osim navedenih alata, korisne naredbe za ozna¢avanje nekog dijela
slike nalaze se jo$ i u izborniku Select, Ciji se opis moze pronaéi u
prilogu ovog priru€nika.

Obi¢no je najlakse i najbrze oznaCavati neke pravokutne ili kruzne
oblike, ali ako je potrebno napraviti selekciju na nekom nepravilnom
obliku tu je potrebna domisljatost i dobro poznavanje alata. Ponekad je
lakSe oznacCavati pozadinu objekta te nakon toga samo izokrenuti
selekciju tako da bude oznacen Zeljeni objekt, a nekad je pozadina toliko
razliita da je lakSe oznaciti objekt.
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Jedan jednostavan alat za selekciju nepravilnih oblika je Scissors
Select koji se joS naziva i Intelligent Scissors, ako se do njega pristupa
preko izbornika Tools > Selection Tools. Moze mu se pristupiti i preko
Toolboxa koji se nalazi s lijeve strane programa.

Moguce je u nekoliko koraka oznaditi neki nepravilan oblik:
1. Prvo se otvori sliku u GIMP-u.

2. Da bi se lakSe i toCnije mogao oznaciti zeljeni objekt na slici,
dobro je zumirati taj objekt na minimalno 200 %.

3. Sada je potrebno odabrati alat Scissors Select i oznaCavati
pomocu todaka granice objekta koji se Zeli oznagiti. Sto je vedi
broj to€aka, to ¢e biti preciznija konacna selekcija. Selekcija se
zatvara tako da se zatvori krug, tj. odabere se pocetna to¢ka.
Ako se pogrijesi s nekom to¢kom u selekciji, moguce je zadati
novu toCku te nakon toga odabrati onu koja je na pogreSnom
mjestu i premijestiti je na zeljenu poziciju ili odabrati neki drugi
alat u Toolboxu, pa opet na alat Scissors Select i krenuti iz
pocCetka. Nakon zavrSenog oznaCavanja, objekt bi trebao
izgledati kao na donjoj slici.

<4 [Ptica) (imported)-5.0 (RGB color 8-bit non-linear integer, GIMP built-in sRGB, 1 layer) 2033x1819 - GIMP
File Edit Select View Image Layer Colors Tools Filters Windows Help
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Scissors Select
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4. Nakon uspjesno oznacenog objekta, pritisne se tipka [Enter] tako
da se vidi oznaCeno podrucje.

5. Ako se Zeli izbrisati konacna selekcija, potrebno je na izborniku
Select odabrati naredbu None.

UspjeSno oznacen objekt mozZe se kopirati, rezati, bojati, premjestati te
se na njemu mogu raditi sve akcije kao na zasebnoj slici.
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Zanimljivosti i napomene

Ako se Zeli dodatno
popraviti oznaka, kada je
objekt oznac¢en odabere se
naredba Quick Mask, koja
se nalazi u donjem lijevom
kutu radnog prostora.
Nakon toga, odabere se
Paintbrush i popravi
oznaka.




Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

8.2. Alati za transformaciju

Mnogo puta je potrebno obrezati sliku, promijeniti veli€inu, rotirati,
zrcaliti, pomaknuti ili u€initi neke druge transformacije s otvorenom
slikom, a to se postize skupinom alata koji se nalaze u izborniku Tools
- Transform Tools.

Rotiranje slike

Ako se zeli izravnati neka slika ili rotirati, koristi se naredba Rotate:

1.
2.

Otvori se slika u GIMP-u koju je potrebno rotirati.

Za rotiranje slike odabire se naredba Rotate u izborniku Tools
- Transform Tools ili u Toolboxu s lijeve strane.

Kada se odabere bilo koji alat, pa tako i Rotate, pojavljuju se
dolje nize u Toolboxu dodatne opcije za taj alat, naziva Tool
Options. U tim je opcijama potrebno odabrati u padajuéem
izborniku pod Clipping, naredbu Crop to result, koja odmah
obreze sliku.

Pritisne se lijevom tipkom mi$a na sliku gdje se pojavljuje mreza
ispred slike i dodatni sko¢ni izbornik Rotate.

«d [Pisa] (imported)-2.0 (RGB color 8-bit non-linear integer, GIMP built-in sRGB, 1 layer) 2000x3008 - GIMP

File Edit Select View Image Llayer Colors Tools Fitters Windows Help
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

5. U sko€nom prozoru moguce je pomocu okretnog dugmeta
odabrati za koji kut ¢e se slika okrenuti, lijevo ili desno, moguce
je ru€no upisati vrijednost ili odabrati vrijednost pomocu klizaca.
Nakon odabira pritisne se na dugme Rotate.

sedl *[Pisa] (imported)-2.0 (RGB color 8-bit nan-linear intager, GIMP built-in sRGB, 1 layer) 20003008 - GIMP

File Edit Select View Image layer Colors Tools Filters Windows Help
Duplicate Ctri+D

+ 29 P Mode v .
v s TR ecdn ; oo bop 1000, coa hspoy oy foon, o
@ A B W B Color Management ’
B/ 7 2 & Teslom »
L @ W e & CavasSie
3 - Fit Canvas to Layers
¢ ® y
h Print Size.
fl e & =
— Scale Image...
Rotate
Transform:& & # B Da04i/8 Sat
Direction Crop to Content

O Normal (Forward] 5@ Using Guides
Zealous Crop
Merge Visible Layers..  CtrsM

Flatten Image

Corrective (Backw

Clipping Cropta
Align Visible Layers...

Guides r

Configure Grid...

@ Show image preview

Composited previe
Guides Number of fines < 1Mage Properties  Alt+ Retum
. Metadata '

15 degrees (Shift)

6. Slika je sada ispravno poravnata, ali ima prazan prostor oko
rubova. Najlaksi nacin za brisanje praznog prostora oko slike je
da se na izborniku Image odabere naredba Crop to Content,
kako je i oznaCeno crvenim okvirom na gornjoj slici.

Zrcaljenje slike

Kada se otvori slika koja je okrenuta naopako, vertikalno ili horizontalno,
moguce je vrlo lako sliku vratiti u ispravan polozaj. Postoje dva nacina;
da se slika zrcali preko izbornika ili preko Toolboxa.

Za zrcaljenje slike preko izbornika odabere se Image - Transform. U
tom izborniku moguce je odabrati naredbe Flip Horizontally za
zrcaljenje slike vodoravno, Flip Vertically za zrcaljenje slike okomito te
naredbe za brzo rotiranje slike po 90 stupnjeva.

Slika se moze zrcaliti i preko alata Flip Tool koji se nalazi u Toolboxu.
Nakon odabira alata, odabere se pod dodatnim opcijama alata naredba
Horizontal ili Vertical, ovisno o tome Zeli li se slika zrcaliti vodoravno ili
okomito. Pritiskom na sliku ona se zrcali na odabranu stranu.
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Na sljedeco;j slici crvenim okvirima oznacen je izbornik Transform i
dodatne opcije alata u Toolboxu.
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P2 Pk g
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4 [Baloni] (imported)-4.0 (RGB color 8-bit non-linear integer, GIMP built-in sSRGB, 1 layer) 4000x6000 — GIMP

File Edit Select View Image Layer Colors Tools Filters Windows Help
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Duplicate Ctrl+D
. Mode 4
= Encoding  F90 1 1500 1200900 2001 3000 R0 4
B B color Management » [ ‘
&3 Flip Horizontally 1
# A  Canvas Size.. Flip Vertically
& & Fit Canvas to Layers Rotate 90° clockwise
¢« 0 Rotate 90° counter-clockwise
X Print Size.. Rotate 180°
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Flatten Image

Clipping

Adjust v Align Visible Layers...

Guides 4
Configure Grid...

Image Properties Alt+Return
Metadata >

Obrezivanje slika

Obrezivanjem slika briSu se originalni rubovi ili dijelovi slike. Obrezivanje
slike korisno je kada se Zele obrisati neki dijelovi koji nepotrebno
odvlace paznju na slici, kada se Zeli bolje istaknuti motiv ili se
jednostavno neki dio slike Zeli odrezati. U programu GIMP obrezivanje
se izvodi alatom Crop Tool koji se nalazi u Toolboxu ili na izborniku
Tools - Transform Tools - Crop. Prije obrezivanja poZzeljno je napraviti
kopiju originalne slike za slucaj da se preveliki dio slike odreze.

Postupak obrezivanja slike je vrlo jednostavan:

1.
2.

Prvo je potrebno otvoriti sliku i odabrati alat Crop Tool.

Nakon toga potrebno je oznaditi sliku, a to se radi tako da se
pritisne i drzi lijeva tipka miSa na dijelu slike koji se zeli oznaditi,
zatim se povuce misem dijagonalno preko dijela slike koji se zeli
oznaciti. Oznaceni dio slike ¢e posvijetliti, a ostali dio potamnjeti.
Sav dio koji je potamnio bit ¢e odrezan, a samo ¢e ostati
posvijetlieni dio slike. Kada se oznadi slika, moguce je i korigirati
selekciju tako da se prode miSem iznad bilo kojeg ruba selekcije i
pomocu njega poveca ili smanji ukupna selekcija.

Za konac¢no obrezivanje slike, potrebno je pritisnuti tipku [Enter].
Primjer obrezivanja prikazan je na sljedec¢im slikama.
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

B S B

Selected layers only
Delete cropped pixels
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«ud| [Zivotinja] (imported)-5.0 (RGB color 8-bit non-linear integer, GIMP built-in sRGB, 1 layer) 3264x2448 - GIMP

File Edit Select View Image Layer Colors Tools Filters Windows Help
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Nakon obrezivanja slike i spremanja kao zasebne slike, rezultat je samo
motiv koji se zZelio istaknuti u centru slike.
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Zanimljivosti i napomene

Skaliranje ili promjena
veli¢ine slike je razli€ito od
zumiranja. Kada se slika
priblizava ili udaljava to
samo utjece na vrstu
pogleda na ekranu i ne
utje€e na veli€inu same
slike, dok skaliranje mijenja
trajno sliku na potpuno
drugadiju veli€inu.

Promjena velic¢ine slike

Promjena veli€ine slike tako da bude manja od originalne, obi¢no ne
utjeCe na kvalitetu slike, ali promjena veliCine slike na vise, tj. da slika
bude veca od originalne slike, moze utjecati na kvalitetu slike. Kao i kod
drugih alata, i kod ovoga je dobro napraviti kopiju originalne slike prije
nego se pocne mijenjati veli€ina slike.

Ako se zeli promijeniti veli¢ina neke slike, koristi se alat Scale Tool koji
se nalazi u Toolboxu ili na izborniku Tools - Transform Tools - Scale.
Promjena veli€ine slike moze se primijeniti u gotovo svim standardnim
jedinicama kao $to su pikseli, postotci, in€i, milimetri, centimetri, metri i
drugi.

Primjerice, ako se neka slika Zeli povecati, tj. skalirati za 250 %,
postupak je vrlo jednostavan:

1. Prvo je potrebno otvoriti sliku kojoj se Zeli promijeniti veliCina i
uzeti alat Scale Tool te kliknuti miSem na sliku u radnom
prostoru ili do¢i do naredbe preko izbornika Image - Scale
Image...

2. Pojavit ¢e se skoCni prozor Scale Image gdje se prvo odabire u
kojim jedinicama se zeli promijeniti veliina slike. Za primjer ¢e
se odabrati postoci, tj. znak %. U podrucje Image Size moze se
ruéno upisati ili pomocu okretnog dugmeta odabrati vrijednost na
koju ¢e se slika skalirati u odnosu na originalnu veli€inu slike. Na
dolje prikazanoj slici, slika se pove¢ava za 250 %, $to je
oznaceno crvenim okvirom.

« Scale Image X
Scale Image
n .
[Bubamara] (imported)-6
Image Size
Width: | 250 — é
Height: 250,00 -+ 7 % -
513 x 360 pixels
X resolution: 180,000 - + é
Y resolution: | 180,000 - + | ; pixels/in
Quality
Interpolation:  Cubic v
Help Reset Scale Cancel

3. Nakon odabira pritisne se dugme Scale.
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Izgled originalne slike prije povecavanja:

Izgled slike nakon

povecavanja za 250 %:

X

Na isti nacin se i smanjuje veliCina slike, samo Sto bi se u ovom slucaju
odabrao maniji broj od 100 %.

Pomicanje objekata

Za pomicanje bilo kakvih objekata, selekcija ili teksta na slici, koristi se
alat Move Tool u Toolboxu, a mozZe se do njega doci i preko izbornika
Tools > Transform Tools > Move. Odabere se alat i klikne se lijevom
tipkom misa na objekt koji se zZeli pomaknuti.

8.3. Alati za crtanje

Svi alati za crtanje nalaze se u izborniku Tools - Paint Tools. Vecina
tih alata koji su namijenjeni bas za crtanje prikladna je i za graficke
tablete, ali moguce ih je koristiti i pomoc¢u miSa. Tako su neki intuitivni
alati za crtanje poput olovke, Pencil Tool u Toolboxu koji sluZi za crtanje
linija s tvrdim rubovima, Paintbrush koji sluzi za crtanje mekih rubova,

E]
Paintbrush
Mode Normal ¥/ &~
[Opadity " 000] -
@ Brush

2. Hardness 050 |
[size) 36,00 |- |+/&H
[Aspect Ratio | 0,00 | =|+/&H
[Angle | 0,00 | =|+/&H
By 100 |-+ &

(SR 70 -+ O
0 -+ O
Enable dynamics
Apply Jitter
Smooth stroke
Lock brush to view
Incremental

Expand Layers

Eraser briSe linije ili dijelove crteza ili slika,
Airbrush sluzi za crtanje jako mekih linija, Ink
sluZi za pisanje ili crtanje kaligrafskim stilom,
Bucket Fill popunjava podrucja s odabranom
bojom, Blend popunjava gradijentnom bojom
odabrana podrucja.

Svaki od tih alata za crtanje sadrzi u dodatnim
opcijama Tool Options, puno parametara koji se
mogu podesiti. Tako se moZe birati veli¢ina, oblik,
kut pod kojim se Zeli crtati, boja, prozirnost te
mnoge druge mogucnosti koje mogu biti jako
korisne.
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Crtanje sa selekcijama

Selekcije, osim Sto sluze za oznaCavanje objekata, mogu se Koristiti i za
crtanje tako da ih se popunjava bojom ili se obrubljuju.

Za popunjavanje selekcija bojom prvo je potrebno odabrati alat za
oznacavanije i napraviti Zeljeni oblik selekcije. Kada se izradi oblik,
moguce je korigirati taj oblik po svakom rubu selekcije te nakon toga
pritisnuti tipku [Enter] tako da selekcije izgledaju kao na dolje prikazanoj
slici.

Zanimljivosti i napomene

Za dodavanje izvornoj
oznaci dodatnu oznaku,
potrebno je drzati tipku
[Shift] i bilo kojim alatom za
oznacavanje docrtati
oznaku. Za oduzimanje
oznake, potrebno je
pritisnuti tipku [Ctrl].

.

Kada se izradi selekcija, potrebno je samo uzeti alat Bucket Fill,
odabrati boju Foreground u Toolboxu i pritisnuti miSem unutar selekcije.
Selekcija je obojana u boju koja je odabrana na paleti boja, unutar opcije
Foreground.

Osim popunjavanja selekcija bojom, moguce je i bilo kojoj selekciji
dodati rub koji se kasnije boja s Bucket Fillom ili se odmah dodaje rub
obojan u boju Foreground boje. To je jako korisno ako se Zeli oznaditi
neki dio slike okvirom, obrubiti neka slika ili samo njezin dio.
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Za izradu ruba na selekciji kreCe se od same izrade selekcije, koju je
potrebno podesiti, te nakon to se izradi selekcija klikne se desnom
tipkom miSa na selekciju i iz izbornika Select odabere se naredba
Border.

«d Border Selection X

Border selection by

|10 - +|px v

Border style Smooth ¥

Selected areas continue outside the image

Help OK Cancel

U sko&nom prozoru Border Selection by potrebno je upisati debljinu ruba
u jedinicama koje se mogu birati, na gornjoj slici su to pikseli. Opcija
Selected areas continue outside the image, ako se ukljudi, j. stavi
kvacica, pruza njezan prijelaz boja na rubu. Nakon zavr$etka, pritisne se
na dugme OK.

Na kraju je potrebno uzeti Bucket Fill, odabrati Zeljenu Foreground boju
i pritisnuti unutar ruba da se on oboji.

Osim bojanja nakon dodavanja ruba, moguce je i odmah oboajiti rub bez
upotrebe alata Bucket Fill. Kada se izradi selekcija, pritisne se desnom
tipkom miSa na selekciju i u izborniku Edit odabere se naredba Stroke
Selection... U otvorenom skoénom prozoru Stroke Selection, koji je
prikazan na slici dolje, moze se upisati ili okretnim dugmetom odabrati
debljina ruba pod opcijom Line With:. Boja ruba bit ¢e jednaka boji koja
je odabrana u paleti boja Foreground.

«d Stroke Selection X
i Choose Stroke Style B
Selection Mask-15 ([Untitled])
Line Paint tool

O Foreground color
Background color

Pattern
& Antialiasing
Line width: | 6,0 - + px ¥
Cap style: m @ W
Join style: F &

Miter limit: ‘ 10,0 -+
Dash pattern: < [ 1 - I 1|11+ | >
Dash preset: = Custom —
Help Reset Stroke Cancel
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Nakon odabira debljine, potrebno je pritisnuti lijevom tipkom misa na
dugme Stroke. Dolje na slici prikazano je obrubljivanje pomoc¢u naredbe
Border... i Stroke Selection...

Dupliciranje ili kopiranje dijelova slika

Za dupliciranje dijela slike s iste ili neke druge slike koristi se alat Clone
Tool koji se nalazi u Toolboxu ili na izborniku Tools - Paint Tools >
Clone. Osim za dupliciranje, alat je odli¢an i za popravak ostecene slike
te uklanjanje nepotrebnih dijelova.

Za dupliciranje ili popravljanje slike potrebno je poduzeti sljedece
korake:

1. Otvori se slika te se zumira radi lakSe obrade.

2. Odabere se alat Clone Tool te se prije koriStenja podese
dodatne opcije alata. Bitno je da se podesi pravilna veli€ina alata,
tvrdoc¢a rubova i kakvo ¢e biti poravnanje (Size, Hardness i
Alignment). Veli€ina i tvrdo¢a rubova alata ovise o tome da li se
duplicira veliki dio slike pa je potrebna veca veli€ina ili se nesto
precizno radi pa je bolje da je veli€ina $to manja. Poravnanje se
moze odabrati s padajuceg izbornika, a ¢esto se koriste None i
Aligned. None uvijek kreCe od pocCetne toCke dok Aligned prati
kretanje ovisno o lokaciji na slici, $to ¢e se bolje razumijeti
prilikom koriStenja toga alata.

3. Clone Tool radi malo drugacije od dosadasnjih alata te ga je
potrebno prvo aktivirati. Aktivira se tako da se pronade na slici
dio koji se Zeli duplicirati ili kopirati te se pritisne na tipku
[CtrI]+lijeva tipka miSa. To je poCetna to¢ka od koje Ce se poceti
duplicirati ili kopirati taj dio slike.
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4. Nakon toga pomice se alat na podruéje gdje se Zeli postaviti
duplicirani dio i kre€u se raditi linije ili se tapka po tom podrucju
pritiskom na lijevu tipku misa. Uvijek se moze pritisnuti na
kombinaciju tipki [Ctrl]+[Z] ako se pogrijeSi te se krece iz poCetka.

Primjerice, pocetna ili originalna slika prikazuje balone koji lete. Ako se
neki baloni Zele ukloniti, a neki duplicirati, Clone Tool je odli¢an alat za
takve stvari

Nakon uspjesSnog koriStenja alata Clone Tool, uklonjena su tri balona, a
lijevi balon je dupliciran, to se mozZe vidjeti na donjoj slici.
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8.4. Alati za podeSavanje boja

Slike s previse svjetla ili tame, koje nisu ostre, koje su prebogate bojama
ili imaju neki drugi problem s bojama moguce je rijeSiti alatima koji se
nalaze u izborniku Colors.

Podesavanje svjetline i kontrasta

Ako se slika Zeli posvijetliti, potamniti ili se Zeli dodati kontrast, koristi se
opcija Brightness-Contrast... koja se nalazi u izborniku Colors, a moze
se Kkoristiti i ako se Zeli pomocu svjetline istaknuti neki objekt na slici.

Za podeSavanje svjetline potrebno je otvoriti sliku i u izborniku odabrati
opciju Brightness-Contrast....

44 Brightness-Contrast X

¢+ Adjust Brightness and Contrast ™

| Dvorac)pg-18 ([Dvorac] (imported))

Presets: v +E
b o |-+
Comst o |-+
= Edit these Settings as Levels

» Blending Options

Preview Merge filter Split view

Help Reset oK Cancel

Pojavljuje se sko¢ni prozor Brightness-Contrast u kojem je moguce
mijenjati svjetlinu i kontrast. Ako je slika previSe tamna, potrebno je u
redu Brightness pomicati kliza€ u desnu stranu ili odabrati okretno
dugme za povecanije vrijednosti svjetline, a ako je slika previse svijetla ili
eksponirana, potrebno je kliza¢ pomicati u lijevu stranu ili okretnim
dugmetom smanjivati vrijednost svjetline.

Gotovo uvijek kombiniraju se svjetlina i kontrast, tako da je kada se
promjeni svjetlina poZeljno mijenjati i kontrast. Kontrast se nalazi u redu
Contrast i vrijede ista pravila za kliza¢ i okretno dugme kao i kod
svjetline.

Dobro je taj sko&ni prozor pomaknuti tako da se vidi i slika koja se
obraduje u radnom prostoru, zato da se vide promjene u realnom
vremenu, §to znadi da se prilikom pomicanja kliza¢a odmah vidi rezultat
te promjene na slici. To je moguée samo ako je stavljena kvacica na
opciju Preview u lijevom kutu sko€nog prozora.

Nakon odabira Zeljene svjetline i kontrasta, pritisne se lijevom tipkom
misSa dugme OK.

Slika prikazuje gradevinu koju je potrebno viSe istaknuti jer je zbog
svjetline neba i oblaka ostala malo zasjenjena.
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Na Stetu oblaka i pozadine slike koji su sada preeksponirani, osvijetliena
je gradevina. Sama gradevina moze se izrezati i koristiti u nekom
buduc¢em kalendaru ili neem slicnom. Na dolje prikazanoj slici za
svjetlinu i kontrast koriStena je vrijednost 60.

Pretvaranje slike u sive tonove

Nekad se slika zbog umjetni¢kog dojma ili zbog nekog drugog razloga
Zeli postaviti u crno-bijelu boju, tj. samo u sive tonove. U programu
GIMP to se moze izvesti na viSe nacina. Jedan od njih je da se odabere
naredba u izborniku Image - Mode - Grayscale.

Drugi nacin je da se na izborniku Colors odabere Desaturate >
Desaturate... Kada se otvori skoCni prozor, moguce je odabrati izmedu
pet opcija: Luminance, Luma, Lightness (HSL), Average (HSI Intensity) i
Value. Najbolje je ukljuciti opciju Preview i isprobati svaku od tih opcija
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te nakon toga odluciti koja je najbolja. Nakon zeljenog odabira, potrebno

je lijevom tipkom misa odabrati dugme O

K.

« Desaturate

Desaturate
Buket.jpg-20 ([Buket] (imported))

Presets:

X

- +@

Luma
Lightness (HSL)
Average (HSI Intensity)

| Value (HSV)

Luminance

~

o

Primjer slike koja se zeli pretvoriti u sive tonove preko izbornika
Desaturate.

Za prikaz gornje slike u sivim tonovima, koristena je naredba

Luminosity
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PodesSavanje razina boja na slici

Pomocu izbornika Color Balance...(Colors - Color Balance) moguce je
podeSavati koli€inu tirkizne, purpurne ili zute boje na slici, kao i
dodavanje crvene, zelene ili plave boje.

Izbornik se sastoji od tri klizaCa pomocu kojih je moguce regulirati
koli€¢inu svake boje odvojeno. Osim toga, moguce je i odabrati izmedu tri
opcije na koje ¢e se odnositi to podeSavanje boja, a to su Shadows,
Midtones i Highlights. Kod ovog izbornika zanimljivo je da se kod svake
od opcija moze zasebno mijenjati koli¢ina boje, a sve zajedno se
primjenjuje na otvorenu sliku.

?"af Color Balance X
= Colqr Balance _ 5
Suma,jpg-22 ([Suma] (imported))
Presets: -+
Select Range to Adjust
Shadows
O Midtones
Highlights
Adjust Color Levels
cyan (D 0,0 — + Red
Magenta_ 0,0 |= +|Green
Yellow_ 0,0 | —|+ Blue

Reset Range
Preserve luminosity
» Blending Options
Preview Merge filter Split view

Help Reset oK Cancel

Dolje prikazana izvorna slika drveca nakon uporabe izbornika Color
Balance mozZze izgledati potpuno drugadije.
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Slika ima sada potpuno drugadiji, topliji ugodaj nakon korekcija boja te
Su joj pojaCane blage zelene nijanse.

Za jesensku varijantu izvorne slike, prethodna slika je odabrana i
nadogradena.
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8.5. Dodavanje teksta

Za dodavanije teksta na sliku potrebno je otvoriti sliku na koju se zeli
dodati tekst ili izraditi novu sliku na kojoj ¢e biti tekst. Odabere se alat
Text Tool koji se nalazi u Toolboxu ili na izborniku Tools > Text i
pritisne se lijevom tipkom mi$a na mjesto na slici gdje se zeli umetnuti
tekst.

U dodatnim opcijama alata Text Tool moguce je odabrati Font preko

iz 5| padajuceg izbornika i veli€inu fonta u viSe
frext ponudenih jedinica.
Font
. sans-serlt Takoder se odabire i boja teksta koja je po
S'Zz GZd.t ._d+ e standardnim postavkama jednaka boji
se edItor winaow v . M age
B Show oncanvas editor Foregrounda, a moZe se i zasebno promijeniti
B Antialiasing pod opcijom Color.
Hinting: _Medium hd . . . .
Color: Pod opcijom Justify moze se poravnavati
Style: | Filled *| tekst, a u opcijama ispod veli¢ina uvlake,
”“‘2:"0: == prored i razmak izmedu slova.
Eoo -+ Tekst se moze i upisati te naknadno mijenjati,
00 - samo ga prethodno treba oznaciti u cijelosti ili
f::;uagz_y”am"' djelomi¢no, ovisno o tome koji se dio Zeli
English promijeniti.

Osim navedenih opcija, kada se pocinje pisati tekst na slici, pojavljuje se
jo§ jedan skocni prozor u kojem je moguce na brzi nacin promijeniti font,
veli¢inu fonta, podebljanje, kurziv, podcrtati tekst ili ga precrtati. Takoder
je moguce promijeniti prored, razmak izmedu slova kao i boju teksta.

Sans-serif 29 -+ px ¥

€@agaa= 0,0 - +/00 —+l

Tekst napisan u programu Gimp|

Prilikom pisanja, tekst je obrubljen okvirom koji sluzi za prikaz teksta na
slici. To znaCi da se samo ono §to je unutar okvira i prikazuje, a ako se
okvir pomakne po bilo kojoj stranici, nakon toga je potrebno korigirati i
tekst. To je korisno ako se Zeli tekst prikazati u nekim granicama na slici
pa se samo postavi okvir u te granice i piSe tekst unutar okvira, nije
potrebno razmisljati je li se preslo izvan granica.

Za poniStavanje okvira s tekstom pritisne se tipka [Esc] ili se odabere
neki drugi alat u Toolboxu.

Za pomicanje teksta potrebno je odabrati alat Move Tool te nakon toga
to¢no oznaciti tekst i pomaknuti ga na Zeljenu poziciju.
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Zanimljivosti i napomene

Uvijek je dobro oznaditi
kvacicom polje Work on
copy kod svih filtara koji to
nude. Time se osigurava da
izvorna slika bude
nepromijenjena, tj. kao u
pocetnom stanju, a filtar se
primjenjuje automatski na
njenoj kopiji.

8.5.1. Tekst na prozirnoj pozadini

Tekst na prozirnoj pozadini koristan je za web-stranice ili ako se Zeli
postaviti tekst preko neke slike. To znaCi da ¢e se samo vidjeti slova,
bez ikakve pozadine, dok Ce se iza slova vidjeti web-stranica ili slika na
koju se postavio tekst.

Bitno je napomenuti da ne podrzavaju svi formati slike prozirnost, tako
da se prozirne slike najéesc¢e spremaju u PNG ili GIF datoteku.

Za izradu prozirnog teksta potrebno je prvo stvoriti prozirnu sliku, a to se
radi preko izbornika File > New... U sko¢nom prozoru Create a New
Image pritisne se lijevom tipkom miSa na oznaku + pokraj teksta
Advanced Options. U padajuc¢em izborniku Fill with potrebno je
odabrati Transparency. Nakon toga, ako vec nije odabrana, odabere se
Zeljena dimenzija, te se pritisne na dugme OK.

Nakon $to se upiSe Zeljeni tekst, ostatak slike moze se ru¢no obrezati ili
preko alata Autocrop Image, koji se nalazi u izborniku Image.

Tekst na transparentnoj pozadini.

Na kraju je potrebno sliku izvesti iz programa u neki format koji podrzava
prozirnost, u gornjem slucaju je to PNG. Tekst je na gornjoj slici
postavljen na tri pravokutnika razliCite boje te se moze vidjeti da, bez
obzira na boju pozadine, tekst ostaje proziran.

8.6. Uporaba filtara

Filtri sluze za promjenu izgleda neke slike, a program GIMP nudi preko
100 razli¢itih vrsta. Jako se jednostavno koriste. Otvori se slika i samo
se preko izbornika Filters primijeni neki od filtara.

S obzirom na to da se vraca u modu starinski izgled slika, najlaksi nacin
za pretvaranje obicne slike u sliku sa starinskim izgledom je pomocu
filtra Old Photo. Otvori se slika kojoj se Zeli dati starinski izgled i
odabere naredba iz izbornika Filters > Decor > Old Photo.

<4 Old Photo X

Defocus
Bordersize 20 -— +
Sepia
Mottle
£ Work on copy

Load Saved Settings Save Settings

Help oK Reset v Cancel

Pojavljuje se skocni prozor Old Photo u kojem je mogucée odabrati
dodatne opcije filtra. Preporuka je ako se prvi put koristi neki filtar, da se
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samo pritisne na dugme OK te se nakon toga moze vidjeti rezultat filtra
po standardnim postavkama. Uvijek se mozZe ponoviti postupak i
odabrati drugacije postavke u tom izborniku.

Na gornjoj slici nalazi se izvorna slika, a na donjoj se nalazi slika nakon
koriStenja filtra Old Photo.

Na isti nacin koriste se i ostali filtri u toj skupini, otvori se slika i primjeni
filtar. Dolje je naveden primjer koridtenja filtra Slide... u skupini Decor.
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Gore je prikazana izvorna slika koja se pomocu filtra pretvorila u ,sliku
na filmu®, tj. dodan joj je okvir filma.

A [j)

GII

% £ .

Filtri se mogu osim na kompletnim slikama koristiti i na dijelovima slika,
selekcijama, tekstu te ostalim grafickim objektima.

Za koristenje filtra na selekcijama, postupak je isti kao i kod cijele slike,
samo §to se prije toga treba oznaditi dio na koji se Zeli primijeniti neki
filtar.
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Na dolje prikazanoj izvornoj slici zeli se da pozadina slike izgleda kao
prasina. Prvo je potrebno oznaciti pozadinu slike te nakon toga
primijeniti na njoj odredeni filtar.

To se postize uz pomoc filtra koji se nalazi u izborniku Filters - Decor
- Fog. Potvrdene su standardne postavke pritiskom na dugme OK.

Cesto je potrebno i neki tekst malo obogatiti, da nije suhoparan, pa se
najCeSc¢e koristi neka vrsta sjene ili neki drugi proizvoljan efekt koji se
dodaje preko filtra.
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Zanimljivosti i napomene

Skocni prozor Drop Shadow
obi¢no se otvara u pozadini
1j. iza glavnog prozora
programa pa ga je potrebno
odabrati s programske
trake.

Prvo je potrebno napisati tekst te nakon upisa upotrijebiti filtar Drop
Shadow koji se nalazi na izborniku Filters - Light and Shadow.

« Drop Shadow X
— Drop Shadow -
= Tekst napisan u programu Gimp-28 ([Untitled])
Presets: >y +3
| booo)- i+
I 6000 | =+ 1
[0 10,00 | =+
Grow shape Circle
Growradus o -
color NN
Opacty 0,500 |=|+
Clipping Adjust ¥
» Blending Options
Preview Merge filter Split view
Help Reset OK Cancel

U sko€nom prozoru Drop Shadow moguce je promijeniti poziciju sjene,
radijus zamagljenja, boju sjene te neprozirnost. Nakon odabranih
vrijednosti, potrebno je pritisnuti dugme OK.

GIMP je besplatan graficki alat za
stvaranje | obradu rasterske grafike.

8.7.

Vjezba: KoriStenje osnovnih alata

Otvorite sliku Pas.png.

Promijenite sliku tako da samo pas na slici ostane u boji, a
ostali dio slike neka bude crno-bijeli, tj. u sivim tonovima.

Obrezite sliku na dimenziju 2000 x 2000 px, tako da pas i
dalje bude glavni motiv na slici.

Spremite sliku pod nazivom Moj_pas.xcf i izvezite ju u
JPEG format pod istim nazivom.

Otvorite sliku Bombonijera.png.

Kao $to i vidite, u kutiji nedostaju tri Cokoladice. Vas zadatak
je da ,stvorite“ jednu ¢okoladicu na bilo kojem praznom
mjestu u kutiji.

Spremite sliku pod nazivom Bombonijera_2_nedostaju.xcf.
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9. lzrada kompletnoga grafickog
rjeSenja koriStenjem rasterskog i -
vektorskog alata Sogiavia:

180 min
Po zavrSetku ovoga poglavija moci cete:

o retuSirati fotografiju u programu GIMP za neko graficko
rjeSenje

e jzraditi graficke elemente u Inkscapeu

e izraditi vizual u obliku postera u Inkscapeu u A3 formatu

e jzraditi diplomu za uspje$no zavr$en glazbeni teCaj u A4
formatu

e podesiti i prebaciti sve elemente iz postera A3 u poster A4
format.

U ovom poglavlju izradit ¢e se graficko rjeSenje za projekt pod nazivom
Glazbena Skola. Potrebno je izraditi plakat/poster u A3 formatu koji ¢e se
staviti na oglasnu plo¢u tako da se ljudi mogu prijaviti na te¢aj sviranja
nekoga glazbenog instrumenta. Nakon toga, potrebno je izraditi i
diplomu u A4 formatu koju ¢e primiti polaznici koji uspjesno zavrse tecaj.
Kao posljednji dodatni zadatak, izradit e se i manja verzija plakata, {j.
postojeéi A3 plakat ¢e se prebaciti u A4 format, tako da se moze
prikazivati i na manjim oglasnim plo€ama, autobusnim stajalistima,
rasvjetnim stupovima itd...

9.1. lzrada A3 postera za glazbenu skolu

1. lzradite A3 poster dimenzije 297 x 420 mm dizajna kao na
donijoj slici. Sve boje koje su navedene u zadacima su u
heksadecimalnom obliku.

2. Napravite pozadinu tako da nacrtate pravokutnik veli¢ine
stranice, promijenite mu boju ispune u ,e3fcffff‘ i promijenite
ime sloja u Pozadina. Zaklju€ajte sloj pomocu ikone lokota.

3. lzradite novi sloj Tekst i pozicionirajte se na njega.
Cjelokupni tekst treba biti poravnan po sredini stranice
(Object > Align and Distribute).Tekst:

e "GLAZBENA SKOLA" je veli¢ine 110 tocaka, fonta
Calibri bold, proreda 128 to¢aka i boje "4b1211ff",

e "upisi u tijeku" i datum "17.6. - 28.6.2019." je veliCine
36 tocaka, fonta Arial Rounded MT Bold i boje
"019482ff",

o "dostupni instrumenti” je veliCine 40 to¢aka, fonta
Verdana i boje "7a1f26ff",

e "flauta, truba, klavir, saksofon, gitara, harmonika" je
veli¢ine 35 to€aka, podebljano, fonta Verdana i boje
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Zanimljivosti i napomene

Uvijek je pozeljno kada se
radi neki veéi projekt kao
Sto je ovaj da se povremeno
spremi dokument zbog
neocekivanih prekida u
radu, blokiranja programa,
nestanka struje itd. Mozete
spremiti dokument pod

nazivom A3_poster.svg.

"7a1f26ff", izmedu njih je krug visine i Sirine 3 mm, iste
boje kao i natuknice,

e "www.glazbena-skola.hr" je veliCine 25 to€aka,
podebljano, fonta Calibri i boje "ff0000ff".

Izradite novi sloj Linije i pozicionirajte se na njega. |lzmedu
teksta "upisi u tijeku" i datuma nalazi se linija elipsastog
oblika koja se moze izraditi pomocu Bezierove krivulje.
Odabere se alat Pen, u dodatnim opcijama alata pod Mode
se odabere Create regular Bezier path, a pod Shape se
odabere Ellipse. Pritisne se lijeva tipka miSa (moze se i
drzati tipka [Ctrl] uz povlacenje, tako da linija bude ravna) i
povlaéi se u lijevu ili desnu stranu. Nakon toga, pritisne se
opet lijeva tipka misa, linija promijeni boju u zelenu te se za
iscrtavanje linije pritisne desna tipka miSa. Kada je linija
nacrtana, promijeni joj se dimenzija na 210 mm Sirine i 2,6
mm visine, crne boje.

U isti sloj Linije, potrebno je dodati i dvije linije s markerima,
koje se nalaze s lijeve i desne strane teksta "dostupni
instrumenti". Linije su Sirine 37 mm, debljine obruba 1,3
mm, boje "7a1f26ff". Za srednji marker (dijaloSki okvir Fill
and Stroke - Stroke style > Markers) odabrana je mala
strelica (tre¢a u padaju¢em izborniku iza nedavno
koriStenih).

Za crtanje dizajnerskoga prikaza tipki na dnu ekrana,
potrebno je prvo izraditi sloj Dizajnerski prikaz tipKi i
pozicionirati se na njega. Nakon toga nacrtajte 20
pravokutnika (tipke) Sirine 14,27 mm i visine 52,2 mm.
Napravite jednak razmak izmedu njih pomoéu izbornika
Object > Align and Distribute. Promijenite svakoj tipki
proizvoljno visinu pomocu alata Selector, tako da izgledaju
priblizno kao i na donjoj slici. Obojite tipke u Cetiri razli€ite
boje kao i na donjoj slici (s lijeva na desno): b28b2eff,
cfa341ff, b69631ff, d2b557ff, a nakon toga se nasumice
mijesaju te boje.

Crne manije tipke su Sirine 8 mm i maksimalne visine 25
mm. Poredajte ih i promijenite visinu priblizno kao i na donjoj
slici.

U zaglavlju slike nalazi se crtovlje i note u valovitom prikazu.
Potrebno je prvo izraditi novi sloj Crtovlje i note i
pozicionirati se na njega. Pomocu alata Pen (Bezierova
krivulja) potrebno je izraditi jednu valovitu liniju kao $to je
prikazano na donjoj slici. NajlakSe je dobiti takav oblik
krivulje tako da se pritisne lijevom tipkom misa na pocetak
krivulje (lijevi rub stranice), odvuce se linije do priblizno pola
stranice i tamo se pritisne i drZi lijeva tipka miSa gdje se
stvara prvi breZuljkasti dio krivulje. Nakon toga se pusti lijeva
tipka miSa i pokaziva¢ miSa se odvodi do desnog ruba
stranice. Kada je linija zadovoljavaju¢e dimenzije i oblika,
pritisne se lijeva tipka misa (linija promjeni boju u zeleno) te
nakon toga pritiskom na desnu tipku misa stvara se linija.
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10.

11.

12.

Promijeni se boja linije (Object > Fill and Stroke -> Stroke
paint) u ddaf22ff, debljine 0,3 mm. Potrebno je imati 5 linija
(kopiranjem ili dupliciranjem) i imati jednak razmak
izmedu njih pomoc¢u izbornika Align and Distribute.
Ubacite (File > Import) 3 slike nota u dokument
(Nota_1.png, Nota_2.png, Nota_3.png), prilagodite im
veli€inu i rasporedite ih priblizno kao na donjoj slici.

Postavite G klju€ u gornji desni dio vizuala. |zradite sloj G
klju¢ i pozicionirajte se u njega. Umetnite (File > Import)
dokument g_kljué€.svg. Postavite ga u crnu boju, zarotirajte
da izgleda priblizno kao na donjoj slici i postavite prozirnost
(engl. Opacity) na tom sloju na 40 %.

Izradite sloj Instrumenti. Umetnite (File > Import) dva
instrumenta iz datoteke Puhacki_instrumenti.svg,
promijenite im veli€inu i rotirajte ih tako da izgledaju kao na
konaénom vizualu.

Gitara, koju je potrebno ubaciti u sloj Instrumenti nije u
vektorskom obliku ve¢ u rasterskom i ima neku pozadinu.
Potrebno je otvoriti sliku u programu GIMP i obrisati
pozadinu. Pozadina se moze obrisati tako da se oznadi
gitara ili pozadina s nekim od alata za selektiranje (Tools >
Selection Tools) i nakon $to se selektira samo pozadina,
obriSe se pritiskom na tipku [Delete]. Takva slika bez
pozadine se izveze pod nazivom
Gitara_transparentna.png. Nakon toga se u programu
Inkscape odabere sloj Instrumenti, uveze se (File >
Import) slika Gitara_transparentna.png i prilagodi kao $to
je na donjoj slici.

Na kraju je potrebno jo§ samo poslagati 6 transparentnih
nota kao $to su na donjoj slici. Kako su note obojane i u
obliku slike, potrebno ih je najprije postavit u crnu boju da se
dobije isti efekt kao na donjoj slici. Otvori se Nota_1.png u
programu GIMP i pretvori se u Grayscale (Image > Mode
- Grayscale). Nakon toga je potrebno dobiti potpuno crnu
notu. Najlakse je to preko izbornika Colors - Levels. Pod
opcijom Input Levels povlaci se lijevi crni trokuti¢ prema
desnoj strani do zadovoljavajuée crne boje. Nakon potvrde,
izveze se slika pod nazivom Nota_1_CB.png. Ponovi se isti
postupak za ostale dvije note i izveze ih se u
Nota_2_CB.png i Nota_3_CB.png. Nakon zavrSetka uvezu
se nove, crno-bijele note u Inkscape, izradi se novi sloj Note
u pozadini i poreda ih se kao $to je prikazano na donjo;j slici.
Sloj Note u pozadini postavi se na 20 % Opacity tako da se
dobije prozirnost i siva boja kao na donjoj slici.

Spremite kona&an vizual pod nazivom A3_poster.svg i u
PDF format pod nazivom A3_poster.pdf. Otvorite i
pogledaijte vizual u PDF formatu.
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

9.2.

Izrada A4 diplome kombinacijom rasterskog i
vektorskog alata

1.

Izradite u programu Inkscape A4 diplomu, vodoravne
orijentacije, dimenzije 297 x 210 mm dizajna kao na donjoj
slici. Sve boje koje su navedene u zadacima su u
heksadecimalnom obliku.

U programu GIMP napravite pozadinu tako da otvorite novu
praznu sliku, bijele boje, A4 formata (300ppi), vodoravnog
usmjerenja. Nakon $to izradite sliku, primijenite filter Fog
(Filters > Decor - Fog) po standardnim postavkama za
dobivanje pozadine.

Standardne postavke filtera: Fog color f0b446, Turbulence
1.0, Opacity 100. lzvezite sliku po standardnim postavkama,
pod nazivom Pozadina.png.

U programu Inkscape promijenite ime sloja u Pozadina.
Umetnite sliku Pozadina.png i prilagodite ju stranici.

Izradite novi sloj naziva Crtovlje i note. Ubacite (File >
Import) sliku Crtovlje_s_notama.png u njega, prilagodite ju
i postavite na gornji dio diplome kao Sto je prikazano na
donjoj slici.

Izradite sloj Crtovlje i note (dolje) i nacrtajte u vektorskom
obliku doniji dio slike, crtovlje i note:

e 5 linija koje predstavljaju crtovlje su Sirine 297 mm
(Sirina stranice), debljine 0,3 mm (Fill and Stroke ->
Stroke style > Width), boje 554400ff. Razmak izmedu
njih je 20 px po Y osi (Object — Arrange),

e uvezite g klju¢ (File > Import) iz datoteke g_kljué.svg,
postavite ga u 554400ff boju i podesite veli¢inu prema
crtovlju,

e dvije Cetvorke koje se nalaze odmah na pocetku su
fonta Arial, veliCine 40 to€aka, 554400ff boje,

e nota se sastoji od elipse i tankoga pravokutnika. Elipsa
je Sirine 6,6 mm, visine 4,6 mm, 554400ff boje i
rotirana za 20 stupnjeva obrnuto kazaljke na satu
(Object > Transform - Rotate), a pravokutnik (desna
linija note) je Sirine 1 mm, visine 15,5 mm, 554400ff
boje,

e za dobivanje dviju nota zajedno, potrebno je duplicirati
note i postaviti gore na njih liniju (pravokutnik) Sirine 12
mm, visine 2,5 mm (note se postavljaju od ruba do
ruba gornje linije),

e za dobivanje Cetiriju nota zajedno, postavite gore na njih
liniju (pravokutnik) Sirine 34 mm, visine 2,5 mm gdje su
sve note jednako odmaknute jedna od druge,

e postavite note po crtovlju, kao na donjem crtezu,

Zanimljivosti i napomene

Uvijek je pozeljno kada se
radi neki veéi projekt kao
Sto je ovaj da se povremeno
spremi dokument zbog
neocekivanih prekida u
radu, blokiranja programa,
nestanka struje itd. Mozete
spremiti dokument pod
nazivom

A4_diploma.svg.

Zanimljivosti i napomene

Elemente mozZete grupirati
tako da mozete s njima
lakSe manevrirati.

Zanimljivosti i napomene

Za laksSi rad na dokumentu,
kada zavrSite s nekim
slojem, mozete taj sloj
zakljucati tako da si
slu¢ajno ne pomaknete
elemente u njemu.
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10.

e duvije linije koje se nalaze izmedu nota su visine crtovlja i
Sirine 0,465 mm, 554400ff boje.

Izradite sloj G kljué i crtovlje u koji ¢ete postaviti crveni g
klju€ na prikaz crtovlja, kao $to je prikazano na lijevoj strani
donje slike:

¢ 5linija koje predstavljaju crtovlje su Sirine 69 mm,
debljine 0,36 mm, crne boje. Razmaknute su jedna od
druge po Y osi 50 px (Object > Arrange),

¢ lijeva bo¢na linija koja spaja crtovlje je Sirine 0,36 mm,
visine 78 mm, crne boje,

o umetnite (File > Import) datoteku g_kljué.svg,
promijenite mu boju u aa0000ff, podesite ga na visinu
87 mm, Sirinu 33 mm i postavite na crtovlje,

e oznacite crtovlje i g kljuc i otvorite filter Blur (Filters -
Blurs - Blur). Upisite pod Horizontal blur 0.21,
Vertical blur 0,21 te pritisnite na dugme Apply za
potvrdu,

e rotirajte (Object > Transform - Rotate) oba objekta za
20 stupnjeva obrnuto kazaljke na satu i postavite ih
na diplomu kao $to je prikazano na donjoj slici.

Izradite sloj Pe€at i umetnite (File > Import) u njega sliku
pecat.png. Podesite sliku na $irinu 42,5 mm, visinu 55 mm
i pozicionirajte ga kao na donjo;j slici.

Izradite sloj Naslov. UpiSite tekst Diploma o zavrSenom
te€aju, fonta Monotype Corsiva, veliCine 45 toc¢aka,
800000ff boje. Pozicionirajte naslov kao na donjoj slici.

Izradite sloj Linije i tekst u koji Cete postaviti sve elemente
kao na donjoj slici:

e 3 dulje linije su Sirine 160 mm, debljine 0,5 mm, crne
boje, razmaknute jedna od druge po Y osi 80 px (Object
- Arrange),

e 2 krace linije su Sirine 90 mm, debljine 0,5 mm, crne
boje, razmaknute jedna od druge po Y osi 80 px (Object
- Arrange),

e tekstoviispod linija, odozgo prema dolje: Ime i prezime
kandidata, Ime i prezime profesora, Instrument za
koji se izdaje diploma, Naziv glazbene Skole i datum,
Potpis, su crne boje, veli¢ine 12 to€aka, fonta Arial,
poravnati na sredinu linije.

Spremite dokument pod nazivom Diploma.svg i
Diploma.pdf. Otvorite i pogledajte kona¢an vizual u PDF
formatu.
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9.3. Dodatni zadatak — prebacivanje plakata iz A3 u
A4 format

1.

Potrebno je napraviti kopiju dokumenta A3_poster.svg i
preimenovati ga u A4_poster.svg. Otvorite ga i promijenite
mu dimenziju stranice na A4, 210 x 297 mm.

Potrebno je sve slojeve otklju€ati, oznaditi sve elemente i
proporcionalno ih smanijiti tako da na dnu ostane 28 mm
praznine za dodatan tekst, kao Sto je prikazano na donjoj
slici.

Potrebno je dodati 2 donje tipke tako da se s njima popuni
sve do kraja stranice, proSiriti pozadinu i podesiti sve
elemente na pozadini da budu na sredini.

Napisite tekst Vise informacija i u drugi red broj mobitela
098/889-7367, crvene boje iz donje palete boja, fonta
Verdana, podebljano, veli¢ine 7 to¢aka i razmaka izmedu
redova 7,5 to€aka, poravnati sve po sredini.

Rotirajte tekst za 90 stupnjeva, duplicirajte tekst 22 puta i
napravite jednak razmak izmedu njih.

Nacrtajte okomitu isprekidanu liniju visine 28 mm, crvene
boje iz donje palete boja, debljine 0,1 mm i postavite na nju
srediSnja 3 évora. Umetnite horizontalno Skare iz datoteke
Skare.svg, podesite im veli¢inu te ih postavite kao marker
na srediSnja 3 ¢vora linije.

Duplicirajte liniju sa Skarama 23 puta i postavite ih sa svake
strane teksta u jednakom razmaku.

Spremite dokument pod nazivom A4_poster.pdf.
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Prilog 1. — Napredne mogucnosti dorade
grafike

Po zavrSetku ovog poglavlja polaznik ¢e moci:
e Koristiti opcije za lijepljenje objekata
e crtati 3D elemente

e Kkoristiti tweak alat

Postoje mnoge dodatne moguc¢nosti za doradu grafike u Inkscapeu,
neke od tih moguénosti mogu samo olak$ati i ubrzati rad dok druge
postavljaju konacan vizual na sasvim novu razinu. U ovom poglavlju
spomenut ¢e se samo neke napredne mogucnosti i kako se njima
koristiti.

1.1. Koristenje opcija za lijepljenje objekata (engl.
Snapping tool)

Snap Controls Bar uklju€uje niz ikona koje se mogu kliknuti i koje
ukljucuiju ili isklju€uju razne opcije lijepljenja na objektima, mrezi ili
pomicnim linijama. U prvoj sekciji se nalazi ikona kojom se moze
iskljuciti ili ukljuciti sva vrsta lijepljenja. Druga sekcija odnosi se na
lijeplienje do i od toCaka definiranih objekata. Treca sekcija obuhvaca
opcije za prebacivanje na ¢vorove i tekst. Posljednja sekcija ima ikone
za ukljucivanje i iskljuivanje prebacivanja na granicu neke stranice,
pomicne linije i mreze.

Ikone i objasnjenja pojedine opcije lijeplijenja Snap Controls Bar-a:

% Enable snnaping — omogucuije ili onemogucuije lijepljenije.

Snap to edges of a bounding box — naredba kojom se mogu
prilijepiti rubovi okvira objekta.

4 Snap bounding box corners — zakvacite se u kutove okvira
objekta.

— Snap midpoints of bounding box edges — prilijepite se od i do
srediSta rubova okvira objekta.

~ Snapping centers of bounding boxes — prilijepite se iz i do centra
okvira objekta.

v Snap to path — prilijepite Evorove ili rucke.

- Snap to path intersections —zakacite se za putanje.
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* Snap cusp nodes, incl. rectangle corners - lijepljienje na sjeciste
putanje.

. |

“ Snap smooth nodes, incl. quadrant points of ellipses —
pri¢vrs¢ivanje na vrhove &vorova.

o Snap midpoints of line segments — lijepljenje od i do sredisnjih
toCaka segmenta linije (to ukljuuje segmente ravnih linija na nekim
oblicima ili putanjama).

Snap centers of objects — lijepljenje iz ili u srediSte objekta.

Snap an item's rotation center — lijepljenje na os rotacije nekog
objekta.

A Snap text anchors and baselines — lijepljenje donje linije teksta.
L Snap to the page border — lijepljenje na rubove stranica.
i Snap to grids - lijepljenje na mrezu.

1/ Snap guides — lijepljenje na pomicne linije.

Kako bi se objekti mogli precizno smijestiti na platno, moguce ih je
dodatno podesiti tako da se prilagode svojem cilju. Cilj moze biti drugi
objekt, granica stranice, linija mreze ili linija pomicne linije. Lijepljenje se
dogada kada se odredena toc¢ka na objektu priblizi svojem cilju.

Lijeplienje se moze postaviti tako da se uvijek dogodi ili da se dogada
samo kada je toCka lijepljenja unutar zadane udaljenosti od cilja.
Postavljanje udaljenosti lijepljenja podeSava se preko kartice Snap u
dijaloSkom okviru Document Properties koji je prikazan na donjoj slici.
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4 Document Properties (Shift+Ctrl+D) - O =

'E Document Properties (Shift+Ctrl+D) @ =

Page Guides Grids Snap Color Scripting Metadata License

Snap to objects
O Always snap
(®) Snap only when gloserthan:é

Snap distance l 20

[] Snap to clip paths
[] Snap to mask paths

Snap to grids
®) Always snap
(O Snap only when closer than:

Snap distance l 50

Snap to guides
() Ahways snap
(®) Snap only when closer than:

Snap distance l 20

Miscellaneous

[ Snap perpendicularly
[] Snap tangentially

1.2. 3D elementi i njihova perspektiva

Alat 3D Box omogucuje crtanje 3D kutija koje se mogu uredivati u
Inkscapeu. Kako bi se nacrtala 3D kutija potrebno je odabrati alat 3D

Box [;:l (na alatnoj traci ima opis Create 3D boxes) i ljevom tipkom
miSa povlaciti po platnu. Nacrtat ¢e se 3D kutija i prikazati ovisno o
nacinu prikaza koji je odabran u gornjem dodatnom izborniku, Box Tool-
u. Na donjoj slici nalazi se prikaz dviju strana i koordinatni sustav. Kad je
odabran alat 3D Box prikazat ¢e se i opcije pomocu kojih se moze
mijenjati nacrtani 3D objekt.

X Z

Tako postoji osam to€aka na kutovima objekta kojima se moze
promijeniti veli¢ina 3D objekta ili dubina. Osim tih to€aka, na 3D objektu
nalaze se jos tri dodatne to¢ke s kojima je omoguéeno dodatno mijenjati
perspektivu objekta ili toCke nestajanja. Na donjoj slici prikazane su sve
toCke koje se mogu pojaviti kada je odabran objekt s alatom 3D Box.
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Desna tocka

Lijeva tocka nestajanja
nestajanja
- -
O

&

Totke za \ Kretanje po

promjenu veli¢ine -/ perspektivi

Prema pocetnim postavkama, 3D kutija je nacrtana s dvije to¢ke
nestajanja, lijevom i desnom. ToCke nestajanja su postavljene na rubove
stranica objekta, poravnate po sredini izmedu gornje i donje stranice
objekta. Sve 3D kutije dijele tocke nestajanja tako da kada se mijenja
to¢ka nestajanja na jednoj, mijenja se i na svim ostalima. Ako se Zeli
promijeniti toCka nestajanja samo selektirane 3D kutije, potrebno je
pritisnuti i drzati tipku [Shift] kada se mijenja tocka nestajanja.

Alat 3D Box moze crtati kutije sa 1, 2 i 3 toCke perspektive. Vrsta
perspektive se mijenja putem dodatnih opcija 3D Box alata u Tools
Controlsu. Svaka od tri toCke perspektive (x, y i z) se moze postaviti na
beskonacnost ili na odredenu to¢ku. Ako se Zeli postaviti ili ponistiti
toCka perspektive na beskonacnost, potrebno je pritisnuti dugme
"paralelne linije", oznacene crvenim okvirom na donjoj slici.

-

Angle ¥: [319,276 = I Angle¥: (90,000 SN Angle Z: [192,828 - I

Kada je postavljena na beskonacnost, smjer perspektivne tocke se
postavlja pomocéu parametra Angle. Kutovi se mogu mijenjati putem
polja za unos u Tools Controlsu ili pomocu tipkovnih pre¢aca x: [.1; y: (,);
i z: {,}. Ako se koriste tipkovni precaci, kutovi ¢e se promijeniti kutom
zakretanja od 15 stupnjeva, a ako se pritisne i drzi tipka [Alt] promjena
kuta bit ¢e 0,5 stupnjeva u Zeljenom smjeru. Npr. ako se zeli povecati Y
kut za 15 stupnjeva, pritisne se otvorena zagrada [Shift + 8], a ako se
Zeli smanijiti za 15 stupnjeva pritisne se zatvorena zagrada [Shift + 9].

Perspektiva 1 tocke

Za perspektivu jedne toc¢ke potrebno je XiY toCke nestajanja postaviti
na beskonacnost pomocéu dugmeta "paralelne linije" te postaviti kut X na
180 stupnjeva i kut Y na 90 stupnjeva. Dugme "paralelne linije" za Z
toCku treba biti iskljuéeno. Nakon toga se povuce toCka nestajanja do
Zeljene lokacije (obi¢no je to blizu sredista crteza). Kao 5to se moze i
vidjeti, moguce je pomicati samo jednu to¢ku nestajanja $to je i glavna
odlika ove perspektive.
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Za micanje neke od 6 ploha na kutiji, kao $to je prikazano na gornjoj
slici, potrebno je razgrupirati 3D kutiju [Shift+Ctrl+G], oznaditi Zeljenu
plohu, pa nakon toga premijestiti, obrisati ili ju izrezati [Ctrl+X]. Jednom
kada su plohe razgrupirane mogu se bojati, pomicati, moze im se
mijenjati veli€ina, odnosno moze se raditi sve kao i sa svakim drugim
objektom.

Perspektiva 2 tocke

Ova perspektiva je i unaprijed zadana perspektiva u programu. Postavlja
se Y toCka nestajanja na beskonacnost tako da se uklju¢i dugme
"paralelna linija" u Tools Controlsu. UpiSe se u kut Y 90 stupnjeva i
iskljuCuju se toCke X i Z. Nakon toga se povlace tocke X i Z do Zeljene
lokacije (obi€¢no su na poc¢etku na istoj razini, ali na suprotnim stranama
stranice).

Na gornjoj slici moguce je vidjeti dvije toCke nestajanja koje je moguce
pomicati (crvena i Zuta linija vode do njih).

Perspektiva 3 tocke

Uklju€uju se X, Y i Z toCke nestajanja tako da se isklju¢e sva dugmad
"paralelne linije" u Tools Controlsu. Povlace se X, Y i Z toCke nestajanja
na Zeljena mjesta. Uobicajeno je da su X i Z toCke nestajanja na istoj
razini samo na suprotnim stranama stranice, a Y se nalazi na suprotnoj
strani, ispod ili iznad objekta.
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Na gornjoj slici moze se vidjeti sve tri toCke nestajanja koje je moguce
pomicati u zeljenim smjerovima.

Izometrijska projekcija

Kutije se mogu iscrtati izometrijskom projekcijom tako da se ukljuci sva
dugmad "paralelne linije" u Tools Controlsu. Za izometrijsku projekciju X,
Y i Z kutovi se postavljaju na 150, 90 i 30 stupnjeva.

Na gornjoj slici moze se vidjeti da nema ni jedne toCke nestajanja koju je
moguce micati.

1.3. Koristenje tweak alata

Tweak Tool A se koristi za male izmjene objekata, putanja i boja. Alat
se moze odabrati direktno na Tool Boxu ili preko precice na tipkovnici,
odabirom slova W ili kombinacijom tipki [Shift] + [F2].

Tweak Tool radi kao €etkica koja pokriva kruzni dio zaslona, a podrucje
na kojem djeluje oznaceno je naran€astim krugom. Utjecaj alata je
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najjaci u sredini i glatko pada do ruba kruga. Dva parametra, koja su
smjestena u dodatnim opcijama alata u Tools Controlsu, utje€u na
ponasanje alata:

e With - odreduje veliinu alata. Ima raspon od 1 do 100, gdje 20
odgovara radijusu od 100 ekranskih piksela. Vrijednost se moze
mijenjati okretnim dugmetom ili strelicama na tipkovnici lijevo i
desno. Tipka [Home] postavlja Sirinu na 1, a tipka [End] na 100.

e Force - odreduje koliko snazno kretanje alata utjeCe na objekte

na zaslonu. Raspon je takoder od 1 do 100, gdje 1 oznaCava
jako slab pritisak, a 100 jako snazan. Na tipkovnici tipke gore i
dolje mogu smanijiti ili povecati vrijednost pritiska. Odmah pokraij,
nalazi se tipka Use Pressure, a kada je ukljuCena, moguce je
koristiti grafi¢ki tablet za crtanje i pisanje koji onda pretvara fizicki
pritisak na tabletu u odgovarajuéu silu u programu (najesce se
koristi u kaligrafiji).

Tweak Tool ima nekoliko nacina za uredivanje objekata, putanje i boje.

Opcije se odabiru klikom na odgovarajucu ikonu u Tools Controlsu pod

opcijom Mode ili pomocu tipkovnog precaca.

Objekti moraju biti selektirani ako ih se Zeli uredivati pomocu alata
Tweak Tool. Pomocu tipke [Space Bar] moguce se na brz nacin
prebacivati izmedu alata za selektiranje (Select Tool) i alata Tweak .
Ako ni jedan objekt nije selektiran prije koriStenja alata Tweak , poruka
upozorenja ¢e biti ispisana na Status Baru.

U dodatnim opcijama alata Tweak se odmah na pocetku odabire
veli€ina alata i sila, a nakon toga, pod opcijom Mode odabire se Zeljeni
nacin rada nad objektima.

Ima preko 10 nacina rada koji su podijeljeni u 3 skupine. Kada su objekti
selektirani, odabere se alat Tweak, klikne se na Zeljeni nacin rada i
pritisne se i drzi lijeva tipka miSa na objektima koje se Zeli izmijeniti. Kod
nekih nacina, moguce je pritisnuti i drzati tipku [Shift] kako bi taj nacin
radio u suprotnom smijeru ili suprotne stvari od uobi¢ajenih.

Prva skupina se odnosi na izmjenu samih objekata koji se mogu
pomicati na razne nacine, smanjivati i poveéavati, rotirati, duplicirati i

zamudivati.

Na gornjoj slici moguce je vidjeti na prvom mjestu neki pocetni objekt i
nakon njega u ostalim kvadrati¢ima utjecaj razliitih nacina rada na isti
objekt. Prednost Tweak alata je u jednostavnosti njegovog koristenja za
postizanje gore prikazanih rezultata. Potrebno je samo odabrati
odgovarajucu opciju i proéi tim alatom po objektima za razliku od nekog
drugog nacina kojim bi se moglo isto to posti¢i gdje bi se trebalo utrositi
mnogo viSe vremena da se postigne jednak ili slican kona¢an rezultat.
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Druga skupina se odnosi na izmjenu i podeSavanje putanja. Svi nacini
za izmjenu putanje dijele parametar Fidelity. Raspon parametra je od 1
do 100. Niska vrijednost daje grubo izobli¢enje koristenjem nekoliko
¢vorova (engl. nodes), dok visoka vrijednost daje glade izobli¢enje, ali s
vise ¢vorova. Potrebno je imati na umu da ¢e bilo kakvo izobli¢enje
putanja utjecati na cijelu putanju, ¢ak i na dijelove koji su daleko od
pokazivac€a. Alati u ovoj skupini imaju i nekoliko poznatih problema. Ako
se koriste na otvorenoj putanji, putanja ¢e se zatvoriti. Ovi alati ne rade
dobro na ravnim linijama ili linijjama sa samo dva &vora.

y ¢
D 4

+

Treéa skupina se odnosi na podeSavanje boja objekata. Tweak Tool se
moze Koristiti i za male promjene u boji objekata. Pritom se mijenja boja
Fill i/ili Stroke cijelog objekta. Za promjenu boje potrebno je u Fill and
Stroke dijaloskom okviru, na kartici Fill, odabrati Zeljenu boju. Moze se
koristiti za pode$avanije boje grupe objekata, pri Eemu se objekti koji su
najblizi pokazivacu, najvise mijenjaju.

: ®

Tweak Tool u nacinu rada u boji ima Cetiri opcije. Moze djelovati
neovisno o nijansi (Hue), zasi¢enosti (Saturation), svjetlini (Lightness) i
neprozirnosti boje (Opacity). Bilo koja od tih opcija se moze neovisno
prebacivati pomocu ikona H, S, L i O u dodatnim opcijama alata.

1.4. Vjezba: lzrada 3D prostora

1. Otvorite novi dokument formata A4 i izradite 3D prostor
kao na donjoj slici.

2. Nacrtajte kutiju u perspektivi 1 tocke (X 180, Y 90),
dimenzije 110 x 110 mm, izgleda pribliznog kao na donjoj
slici (zuta, desna tocka nestajanja treba se nalaziti unutar
kutije da se postigne dubina kao na slici).

3. Razgrupirajte kutiju ( [Ctrl] + [G]) i obriSite prednju plohu.
Boje kutije u heksadecimalnom obliku su:

- desniilijevi zid je deaa87ff, strazniji zid je
f4e3d7ff, strop je e9c6afff i pod je c87137ff.
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Prozor je Sirine 28 mm i visine 33 mm, s obrubom 2
mm. SrediSnji dio koji razdvaja prozore na dva djela
(pravokutnik) je Sirine 2 mm. Boja ruba je 803300ff, a
ispune d5f6ffff u heksadecimalnom obliku.

Desni ormar s policama, takoder je u perspektivi 1 tocke,
Sirine 27 mm i visine 53 mmm. Potrebno ga je
razgrupirati i duplicirati gornju plohu tako da se dobiju
dvije police. Boje u heksadecimalnom obliku koje se
koriste u ormaru su:

- gornja ploha je 916f6fff, desna bocna i lijeva
unutarnja ploha je ac9393ff, donja unutarnja ploha
je e3dbdbff, straznja ploha je b3b3b3ff i police su
boje c8b7b7ff.

Lijevi donji ormari¢ je isto u perspektivi 1 tocke, Sirine 26
mm i visine 26 mm. Kada se razgrupira, boje se mogu
uzeti alatom Dropper (kapaljka) iz desnog ormarica s
policama.

. Jedan od nacina za dobivanje slike na lijevom zidu je da

se lijeva ploha (lijevi zid) duplicira i proporcionalno smanii.
Boja obruba je 550000ff, a ispune 808000ff u
heksadecimalnom obliku. Debljina obruba je 1,5 mm.

Proporcionalno povecajte kompletan crtez do rubova
stranica i spremite pod nazivom 3D_prostor.svg.

Zanimljivosti i napomene

Pokus$ajte staviti sliku i oba
ormara u zasebne slojeve.
Tako ¢ete moc¢i pomoéu
skrivanja i otkrivanja
pojedinih slojeva vidjeti
kako izgleda soba sa ili bez
nekih dijelova.
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Prilog 2. — Opis izbornika — Inkscape

U nastavku su navedene najcescée koristene naredbe i naredbe koje su
se koristile u ovome priru¢niku.

Izbornik File sli¢an je i kod drugih programa, a najosnovnije naredbe za
pocetnike u njemu su:

New — naredba za stvaranje novoga crteza
Open — otvaranje datoteke u programu
Save — spremanje crteza

Save As — spremanje crteza u formatu SVG koji sluzi za kasnije
uredivanje crteza u programu Inkscape ili spremanje u neki drugi
poznati format kao $to je PDF, EPS ili neki drugi

Revert — postavlja crtez na zadnju pohranjenu verziju
Import — uvoz slika ili crteza u trenutno otvoreni dokument
Export PNG Image — sluzi za spremanije slike u PNG format

Document Properties — sluzi za podeSavanje stranice, mreze,
pomicnih linija i drugo

Close — zatvara trenutno otvoreni crtez

Quit - izlaz iz programa.

@ *Mew document 2 - Inkscap-e-_
File Edit View Layer Object Path Text Filters Extensions Help
New Crd+N L [0 @ @
Templates... Ctrl+Alt+M o :
ET | x|s09437 v
= Open... Ctrl+0
Open Recent o I o P A L
Revert
& Save Ctrl+5
[ Save As... Shift+Ctrl+5
Save a Copy... Shift+Ctrl+Alt+5
+ Import... Cirl+I
[3 Export PNGImage... Shift+Ctrl+E
= Import Clip Art...
= Print.. Ctrl+P
Za Clean up document
i1 Document Properties... Shift+ Ctrl+D
¥ Close Ctrl+W
el Quit Ctrl+Q)
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Izbornik Edit sadrZi sljedecée, Cesto koriStene naredbe:

Undo, naredba koja briSe zadnju akciju (skracenica za ovu
akciju je [Control] + [Z]) ili Undo History u kojem se Cuvaju
sve prijasnje radnje

Redo — vra¢a zadnju akciju

Cut ([Control] + [X]) — sluzi za izrezivanje
Copy ([Control] + [C]) — naredba za kopiranje
Paste ([Control] + [V]) — sluzi za lijepljenje

Paste In Place ([Control] + [Alt] + [V]) — sluzi za lijepljenje na
istu poziciju iz koje se kopiralo

Duplicate ([Control] + [D]) — sluzi za dupliciranje elementa

Preferences — dodatan izbornik u kojemu se nalaze postavke
za prilagodavanje platna te razna druga podeSavanja u
programu.

l@ *New document 2 - Inkscape _w

File Edit View Layer Object Path Text Filters Extensions Help
D Unde: Move jitter tweak Ctrl+Z @ @
— g Redo Shift+Ctrl+Z :
[E] | @ Undo History.. Shift+Cirl+H [ 309437 1
I
[E % Cut Cirl+ X :
pe | Copy Ctrl+C
Il_'l\ [] Paste Ctrl+V
B | B Pasteln Place Ctrl+ Alt+V
[ Paste Style Shift+Ctrl+V
Q Paste Size 4
% + Find/Replace... Ctrl+F
l:‘ U] Duplicate Ctrl+D
Clone 4
@ B Make a Bitmap Copy Alt+B
O 3 Delete Delete
(E}, B Select All Ctri+A
[l Select All in All Layers Ctrl+Alt+A
@ Select Same 4
Z@ Invert Selection !
i Deselect
‘ng’ Resize Page to Selection Shift+Ctrl+R
l_@' Create Guides Around the Page
AI Lock All Guides

Delete All Guides

uir
=
<

[ XML Editor... Shift+Ctrl+X

E Input Devices...
. Preferences... Shift+Ctrl+P

<
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Izbornik View ima mnoStvo korisnih moguénosti za pregled crteZza na
kojemu se radi. Neki od njih su:

Zoom — koristan za priblizavanje i smanjivanje kompletnoga
crteza ili nekoga njegova dijela

Display mode — koristan za pregled dokumenta u nekome
drugom pregledu

Page Grid — prekriva crtez na platnu mrezom koja sluzi za
poravnavanje elemenata na slici

Guides — prikazuje ili sakriva pomi¢ne linije

Show/Hide Dialogs — sakriva ili prikazuje dijaloSke okvire
Swatches — dijaloSki okvir s nekim predefiniranim paletama
boja

Default/Custom/Wide — nacini prikaza programa.

IQ *New document 2 - Inkscape “_

Eile Edit View Layer Object Path Text Filters Extensions Help

OBEE Zoom ‘R @ Q
Display mode » .
@ = Color display mode v 1809437 ¥
o
n Page Grid £ AP A
] Guides

Color-managed view

e
I
AR T
8- Show/Hide v
a
Q 1 | B Show/Hide Dialogs F12
% 1 ™ Swatches.. Shift+ Crl+ W
|:| | | B Messages..
@ T @ Previous Window Shift+Ctrl+Tab
1 | [EH Medt Window Ctrl+Tab
O ] Icon Preview...
@} —| | B Duplicate Window
5
@ 27 | % Fullscreen F11
Z@/ 1 |« Default
ig’ 4 Custom
g Wide
) Jad
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Izbornik Layer koristi se za dodatne opcije uredivanja slojeva. Korisne
naredbe su:

Add Layer — dodaje se novi prazni sloj na crteZz odmah iznad
aktivnoga sloja

Rename Layer — mijenja se ime sloja

Duplicate Current Layer — dodaje se novi sloj, kopija
aktivnoga sloja

Delete Current Layer — bride se aktivan sloj

Layers — otvara se dijaloSki okvir Layers u kojem je moguce
na brzi nacin dodavati, brisati, premjestati i duplicirati slojeve.

S —

Q *New document 2 - Inkscape

Eile Edit View Layer Object Path Text Filters Extensions Help
(1B & &| & AddLayer. Shift+Ctrl+N [
- ' 4. Rename Layer...
EREE e ]
Show/hide Current Layer
7 2

[E W Lock/Unlock Current Layer j
f-\:' 4 F Switch to Layer Above Ctrl+Page Up

R 1 = Switch to Layer Below Ctrl+Page Down
-

Q ; # Move Selection to Layer Above Shift+Page Up

i = Move Selection to Layer Below Shift+Page Down

% i I, Move Selection to Layer...

|:| 1 i® Raise Layer Shift+Ctrl+Page Up
@ 7 & Lower Layer Shift+ Ctrl+Page Down

1 ® Layerto Top Shift+ Ctrl+ Home

O i Layerto Bottom Shift+Ctrl+End
@}’ m = Duplicate Current Layer

@ i B Delete Current Layer

2@ | 2 Layers.. Shift+Ctrl+L

]
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Izbornik Object koristi se za manipulaciju objektima. Neke od brojnih
naredbi koje nudi su:

Fill and Stroke — otvara se dijaloski okvir u kojemu je moguce
mijenjati boju ispune i obruba

Group/Ungroup — grupiranje objekata ili razgrupiranje

Raise/Lower/Raise to Top/Lower to Bottom — premjestanje
objekata ispod ili iznad

Rotate — rotiranje za 90 stupnjeva u smjeru kazaljke na satu ili
obrnuto od smjera kazaljke na satu

Flip — vodoravno ili okomito zrcaljenje

Transform — dijaloSki okvir u kojemu se radi manipulacija
objektom u smislu rotiranja, zrcaljenja, iskrivljenja, povecanja,
smanjivanja i drugo

Align and Distribute — dijaloski okvir za poravnavanje
objekata

Arrange — dijalo3ki okvir za postrojavanje objekata.

ﬁ*NewdocumentZ-Inkscape - S —
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Izbornik Path koristi se za manipulaciju putanjama i objektima. Neke od
brojnih naredbi koje ovaj izbornik nudi su:

Object to Path — pretvara neki element u krivulje
Stroke to Path — pretvara odabrani obrub u krivulje

Trace Bitmap — naredba koja se koristi za precrtavanje
rasterskih slika u vektorske

Union/Difference/lntersection/Exclusion/Division/Cut Path
— naredbe koje sluze za lakSe stvaranje nekih novih objekata
ili uredivanje postojecih

Break Apart — razdvajanje objekata u zasebne segmente

Simplify— zagladivanje neke krivulje.

‘4@ “Mew document 2 - Inkscape T |
File Edit View Layer Object Path Text Filters Extensions Help
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Izbornik Text koristi se za uredivanje i manipulaciju tekstom. Korisne
naredbe su:

Text and Font — otvara se dijaloski okvir u kojemu se moze
dodatno oblikovati tekst

Put on Path — postavlja tekst na neku krivulju prateéi njen
oblik

Remove from Path — miCe tekst s krivulje

Q *New document 2 - Inkscape -—_—

Eile Edit View Layer Object Path Text Filters Extensions Help

T IextandFont. Shift+Ctrl+T
SVG Font Editor...
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

U izborniku Filters nalaze se mnogi filtri koji se mogu primijeniti na bilo
koji element ili crtez. Potrebno je samo oznaciti element ili crtez i
primijeniti filtar iz Zeljene skupine.

@ *New document 2 - Inkscape -
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

U izborniku Extensions nalaze se razni dodaci za program koji mogu
uvelike olakSati rad u programu /nkscape. Primjenjuju se na jednostavan
nacin, isto kao i filtri, odabere se iz Zeljene skupine naredba koja ¢e se
primijeniti na dokument ili element, ovisno o tome za $to je namijenjen
taj odabrani dodatak.

I@ *New document 2 - Inkscape “
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Izbornik Help nudi dodatne informacije i pomo¢ u vezi s programom
Inkscape. Naredbom FAQ otvara se web preglednik u kojemu su
obrazloZena Cesto postavljana pitanja. Pritiskom na naredbu About
Inkscape moZze se vidjeti koja verzija programa se koristi.

Q *New document 2 - Inkscape -1“

File Edit View Layer Object Path Text Filters Extensions Help

TEEHE B B ® Inkscape Manual J
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|
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Prilog 3. — Opis izbornika — GIMP

Program GIMP pruza velik broj mogucnosti, a do svih njih moze se doci
preko izbornika u srediSnjem radnom prozoru. Najée&c¢e koridtene
naredbe ili alati nalaze se na brzo dostupnim mjestima u Toolboxu ili u
desnom prozoru s dodatnim opcijama, dok je ostale potrebno odabrati
preko izbornika.

Izbornik File sli¢an je i kod drugih programa, a najosnovnije naredbe za
pocetnike u njemu su:

¢ New - naredba za stvaranje nove slike
o Open — otvaranje slike u programu
e Save - spremanje slike

o Save As - spremanije slike u formatu XCF koji sluzi za kasnije
editiranje slike u programu GIMP

o Revert — postavlja crtez na zadnju pohranjenu verziju

o Export — sluzi za spremanije slike u razli€itim datote¢nim
formatima kao &to su TIFF, JPG, PNG, GIF, PDF, BMP i drugi

e Close View — zatvara trenutno otvorenu sliku
e Quit — izlaz iz programa.

wd [Untitled]-34.0 (RGBE color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 1920x1080 -
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Izbornik Edit sadrzi jako korisne naredbe. Neke od njih su:

¢ Undo — naredba koja brise zadnju akciju (skraéenica za ovu
akciju je [Control] + [Z]) ili Undo History u kojem se Cuvaju sve
prijasnje radnje

e Redo - vrac¢a zadnju akciju

e Cut ([Control] + [X]) — sluzi za izrezivanje

e Copy ([Control] + [C]) — naredba za kopiranje
e Paste ([Control] + [V]) — sluzi za lijepljenje

e Preferences, u kojem se nalaze postavke za prilagodavanje
radnoga prostora te razna druga podeSavanja

e Clear ([Delete]) — briSe selektirani objekt

e Fill with FG Colour ([Ctrl + ,]) — ispunjava selekciju s bojom
podeSenom pod Foreground (boja prvoga plana)

e Fill with BG Colour ([Ctrl + .]) — ispunjava selekciju s bojom
podeSenom pod Background (boja pozadine).

“ [Untitled]-54.0 (RGE color 3-hit gamma integer, GIMP built-in sRGE, 1 layer) 1920x1080 -1
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Izbornik Select sluzi za dodatne opcije kod oznacenog dijela slike ili
kompletne slike. Neke od koristenijih opcija su:

All — sluzi za ozna¢avanije cijele slike

None — briSe selekciju sa slike

Invert — naredba koja radi obrnuto oznaCavanje od trenutno
oznacenoga djela, $to znaci da ¢e se sve $to je izvan selekcije
nakon odabira ove naredbe nalaziti unutar selekcije i obrnuto

Float — tzv. privremeni layer, u kojem se nalaze svi objekti prije
nego se po¢nu obradivati, dakle, kada se bilo koji element
zalijepi u program GIMP, on se nalazi u float layeru.

. [Untitled]-34.0 (RGB color 8-bit gamma integer, GIMP built-in sRGE, 1 layer) 1920x1080 -

File Edit = Select View |mage Layer Colors Teools Filkers Windows Help

b4

T i
%

o

¥
&
-

F S .

d
%
p4
6

Cl U S

-

All

None
Inwvert
Float

By Color
From Path

Selection Editor

Feather...

Sharpen

7 Shrink..

1| Tool Optiol

GEGL Operati:

Sample

Radius @

|

@

as Grow..

Baorder...
Remove Holes
Distort...

Rounded Rectangle...

Toggle Quick Mask
Save to Channel

To Path

Ctrl+A
Shift+ Ctrl+4
Ctrl+I
Shift+Ctrl+L
Shift+0
Shift+V

Shift+Q

.|'3.|.|.|.|.|15‘p

141



Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Izbornik View ima jako puno korisnih mogucénosti za pregled slike na
kojoj se radi. Neki od njih su:

Dot for Dot — uklju€uje se prilikom obrade slike za web i ako se
obraduju slike za ispis, potrebno je onemoguciti tu opciju tako da
se slika vidi u svojoj punoj veli€ini

Zoom — koristan za priblizavanje i smanjivanje kompletne slike ili
nekoga njezinog dijela

Show Grid — prekriva sliku u radnom prostoru mrezom koja sluzi
za poravnavanje elemenata na slici

Snap to Grid — pona$a se kao magnet te olakSava poravnavanje
elemenata po slici

Show Rulers — prikazuje ili sakriva ravnalo u programu.

. [Untitled]-534.0 (RGBE color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 19201080 - GIM
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Izbornik Image sluZi za promjene na slici kako bi se poboljSale boje,
veliCina, polozaj itd. Korisne naredbe su:

Duplicate — izraduje jednaku kopiju aktualne slike te obrada
kopije ne utjee na originalnu sliku

Mode — mijenja prikaz slike u RGB ili crno-bijelom modu
Transform — rotira ili zrcalno okrece sliku

Canvas Size — omogucuje kreiranje dodatnoga prostora izvan
slike koji je koristan ako se Zeli dodati okvir ili tekst van slike

Scale Image — mijenja broj piksela neke slike.

. [Untitled]-34.0 (RGE color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 1920x1080 - GIMP
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Izbornik Layer koristi se prilikom umetanja dodatnih slika na ve¢

postojanu sliku, kod umetanja teksta, crteza i ostalih elemenata. Korisne

naredbe su:

aktivnog layera

New Layer — dodaje se novi prazni layer na sliku odmah iznad

Duplicate Layer — dodaje se novi layer, potpuno jednaka kopija

Filters Windows

Shift+Ctrl+ N

Shift+Ctrl+ D
Ctrl+H

v v v v

Help

1 |25‘p' | I I

[}
aktivnog layera
o Delete Layer — briSe se aktivan layer.
. [Untitled]-54.0 (RGB color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 1920x1080 - GIMP
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Izbornik Colors sadrzi velik raspon alata za podeSavanje boja na nekoj
fotografiji, slici ili crtezu. Koriste se alati ovisno o potrebi, a neki od
naj¢esce koristenih su:

o Color Balance - sluzi za povecéanje ili smanjivanje koli¢ine
tirkizne, purpurne ili zute boje (cyan, magenta, yellow)

¢ Hue-Saturation — omogucava povecanije ili smanjivanje nijanse
neke boje, svjetline boje ili zasi¢enja

e Levels — kontrolira sjene, svjetlinu i Sumove na slici

o Curves — alat koji sluzi za promjenu boja, osvjetljenja i kontrasta
neke slike.

-, [Untitled]-534.0 (RGE color 8-bit gamma integer, GIMP built-in sRGE, 1 layer) 19201080 - GIMP
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Izbornik Tools takoder je dostupan u Toolbox Windowu s lijeve strane
programa u Single-Window Modu. Koriste se gotovo svi alati iz svake
skupine. Ovaj izbornik koristan je ako se zatvori Toolbox Window radi
dobivanja veéega prostora u programu.

- [Untitled]-54.0 (RGB color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 1920x1080 — GIMP
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Izbornik Filters sadrzi veliku koli€inu raznih filtara koji se koriste za
poboljSanje neke fotografije ili za stvaranje unikatne slike. Filtri u ovom
izborniku mogu se primijeniti na cijelu sliku, /ayer ili samo selekciju na
odredenoj slici.

- [Untitled]-534.0 (RGE color 8-bit garmma integer, GIMP built-in sRGE, 1 layer) 1920x1080 - GIMP
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Izbornik Windows pruZa pristup velikom broju dijaloga ili panela koji su
dostupni u podizborniku Dockable Dialogs. Velika novost u odnosu na
verziju GIMP-a 2.8. je Single-Window Mode koji spaja tri odvojena
panela u jedan. Za pocCetnike je preporucljivo da koriste Single-Window
Mode zbog lakSeg snalaZenja u programu.

“ [Untitled]-54.0 (RGB color &-bit gamma integer, GIMP built-in sRGB, 1 layer) 1920x1080 - GIMP
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Izbornik Help nudi dodatne informacije i pomo¢ programerima koji zele
razvijati program, kao i obi¢nim korisnicima.

e GIMP Online — podizbornik koji obi¢nim korisnicima i
programerima nudi pomo¢ i dokumentaciju u vezi s programom.
Takoder je moguce preuzeti sadrzaj Helpa na lokalno ra¢unalo i
pregledavati ga bez koristenja interneta.

e About — sadrzi informaciju o verziji GIMP-a instaliranoj na

racunalo.
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Osnove rada s alatima za grafi¢ki dizajn (Inkscape, GIMP) (M100)

Literatura

Tutorijali o uporabi Inkscapea, https://inkscape.org/en/learn/tutorials

Inkscape FAQ, https://inkscape.org/en/learn/faq

Inkscape - Guide to a Vector Drawing Program - 4th Edition, Tavmjong
Bah

GIMP tutoriali, http://www.gimp.org/tutorials

GIMP for Absolute Beginners, Jan Smith with Roman Joost
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